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Note: Because of continuous product improvement SVANTEK reserves the right to make 

changes to product specifications without notice. To download the most up to date user's 

manual please visit our web site at www.svantek.com. This user’s manual presents the 
software revision named 3.4.27.  

The succeeding software revisions (marked with the higher numbers) can change the 

view of some displays presented in the text of the manual. 

 

The software described in this manual is furnished under a license agreement and may be used only 

in accordance with the terms of that agreement. 

Copyright Notice 

Copyright © 2024 Svantek Sp. z o.o. 

All rights reserved. 

Reproduction without permission is prohibited. 

Trademarks 

Trademarks or registered marks in this manual belong to their respective manufacturers. 

Microsoft and Windows are registered trademarks of Microsoft Corporation. 

 

Disclaimer 

Information in this document is subject to change without notice and does not represent a 

commitment on the part of Svantek. 

Svantek provides this document “as is”, without warranty of any kind, either expressed or implied, 
including, but not limited to, its particular purpose. Svantek reserves the right to make improvements 

and/or changes to this manual, or to the products and/or the programs described in this manual, at 

any time. 

Information provided in this manual is intended to be accurate and reliable. However, Svantek 

assumes no responsibility for its use, or for any infringements on the rights of third parties that may 

result from its use. 

This product might include unintentional technical or typographical errors. Changes are periodically 

made to the information herein to correct such errors, and these changes are incorporated into new 

editions of the publication. 

 

Technical Support Contact Information: 

web:   www.svantek.com/contact 

  

 

http://www.svantek.com/
http://www.svantek.com/
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1 INTRODUCTION 

  

 

The SvanPC++ software is designed to work with all Svantek's recently manufactured instruments 

(SVAN 95x, SVAN 97x, SV97x and SV 10x series) and monitoring stations (SV 200x, SV 258, SV 27x and 

SV 30x series). It can also be used with the old SVAN 94x series with the latest firmware version. 

 

The SvanPC++ software is a sophisticated tool that extends the functionality of the above-mentioned 

instrument series. The basic SvanPC++ software is available to all users free of charge. Modules such 

as REMOTE COMMUNICATION, BUILDING ACOUSTICS, ENVIRONMENTAL MONITORING are optional 

and must be purchased. 

 

SvanPC++ works with all file types created by the above mentioned instruments with the 

corresponding extension, e.g: 

 

File name Extension 

Content 

SVAN 94x, SVAN 95x and SV 106 

instruments (except for 

SVAN 958AG) 

Other instruments 

Results .svn Main results, 1/1 & 1/3 octave 

results, statistics or logger results 

--- 

Logger .svl Time history results, event 

recordings, markers 

All Summary and Time history results 

(for some instruments also directivity 

and meteo/dust results), event 

recordings, markers 

Setup .svt  Settings 

Wave .wav Waveform records (except for 94x)  

Building Acoustics 

project 

.svz, .spr  SVAN 977A, SVAN 979, SV 971A, 

SV 973 

 

For more details, refer to your instrument's user manual and Chapter 3.5. 

 

 

1.1 MAIN FEATURES 
 

• Download measurement results from instruments to PC 

• Store and manage data files in project documents 

• Visualisation of data and instrument settings during measurements 

• Adjust the instrument settings (wizard and editor modes) 

• Easy direct data export to popular applications 

• Data post-processing (e.g. spectrum comparison, time-history and waveform recalculation)  

• Report generation 

• Supports all new Svantek instruments 

• Compatible with USB interfaces  

• Remote communication with instruments equipped with 3G/4G/LAN modems (with optional 

REMOTE COMMUNICATION module) 
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1.2 REQUIREMENTS 
 

• MS Windows 8.1 / 10 / 11 

 

 

1.3 ABOUT THIS MANUAL 
 

The structure of this manual is designed to show you how to use the software to: 

1. connect and configure Svantek instruments, 

2. download measurement data, 

3. visualise the data and play back the waveform signal, 

4. post-process and analyse data, 

5. export data for reporting. 

 

The latest version of this manual in PDF format can be downloaded from the Svantek website: 

www.svantek.com. 

 

Further information about the SvanPC++ program can be found in the HTML version of the help, 

which can be accessed by pressing the F1 key. The structure of the HTML help corresponds to the 

structure of the program, with detailed descriptions of particular elements of the SvanPC++ graphical 

user interface, such as menus, dialogue boxes etc. 

 

  

file:///C:/Users/Kuba/Documents/Svantek/SvanPC%20User%20Manual/www.svantek.com
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2 SOFTWARE INSTALLATION 

 

 

2.1 USB DRIVERS INSTALLATION 
 

The USB driver installation package can be downloaded from www.svantek.com (path: SUPPORT - 

DRIVERS / SOFTWARE - USB DRIVERS). Follow the installation instructions. To complete the USB driver 

installation, the user should connect the instrument after the system restart and select automatic 

USB driver installation. It may be necessary to repeat the last step for all USB ports. 

 

Important: USB driver Installation requires the user to have administrator privileges. 

 

 

2.2 SVAN PC++ INSTALLATION 
 

The SvanPC++ software can be installed by downloading the installation file from www.svantek.com 

(path: PRODUCTS / SOFTWARE / SvanPC++). Follow the installation instructions. 

 

 
Figure 2-1. SvanPC++ software installer. 

 

 

You will be asked if you want to install SvanPC++ for yourself or for everyone who uses this computer. 

This choice determines the area where SvanPC++ settings and shortcuts are stored, and thus their 

availability to users who share the workstation. 

 

file:///C:/Users/Kuba/Documents/Svantek/SvanPC%20User%20Manual/www.svantek.com
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3 CONFIGURING INSTRUMENTS AND DOWNLOADING DATA 

 

 

3.1 CONNECTION MODES 
 

SvanPC++ supports USB and RS232 interfaces for direct communication. The configuration of each 

interface is different. 

 

More remote communication modes are supported as an optional feature, available after purchasing 

the corresponding SvanPC++ module (REMOTE COMMUNICATION module ). 

 

3.1.1 USB CONNECTION 
 

Using the USB interface requires the installation of appropriate drivers (see Chapter 2.1: USB Drivers 

Installation). SvanPC++ will automatically detects devices connected via USB. 

 

3.1.2 RS232 CONNECTION 
 

The RS232 interface can be configured using theRS232 Settings command from the SVAN menu. This 

activates the RS232 Settings dialogue box. It allows to configure the connection parameters and 

options. 

Note: The Baud Rate must be the same in the SvanPC++ software and in the instrument. 

 

After setting the RS232 options, press OK to save changes, Cancel to discard changes or Default to 

set default values for each parameter. 

 

When you try to connect a Svattek instrument to your computer via Bluetooth, two new COM ports 

will appear. To successfully communicate with the instrument, you must select the output port. 

 

3.1.3 ADDITIONAL CONNECTION MODES 
 

To communicate with instruments via GPRS and Internet connection, you need to purchase the 

SvanPC++ Remote Communication (RC) module. This module provides multiple advanced tools for 

data acquisition. 

 

 
3.2 DATA TRANSFER 
 

3.2.1 DOWNLOADING FILES FROM THE INSTRUMENT 
 

To download data from a Svantek instrument using the SvanPC++ software, proceed as follows: 

1. Connect the instrument to the PC. 

2. Switch on the instrument. 

3. Start SvanPC++. 

4. Manage the file transfer using the SVAN Files dialogue box. 
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The SVAN Files dialogue box can be opened from the Instrument Wizard (see Chapter 3.4). You can 

also use the SVAN Files command in the SVAN menu or press the  button on the Toolbar. 

 

  

 
 

 

Figure 3-1. SVAN Files dialogue box. 

 

 

To download files in the SVAN Files dialogue box, do the following: 

• Select the device from which you want to download files (if more than one device is connected), 

as well as the memory type and sub catalogue used as the source (if more than one source is 

supported). 

Note: The left panel has an additional button  that switches the display of the contents of the 

device’s memory from the standard one, consisting of directories, to the non-standard, showing 

only files (see Figure 3-2). 

• Select the transfer destination (a local PC / LAN folder or an Svan Project file) and the local 

destination folder. 

• Select the download type: ASCII, Binary (e.g. as .svn files), CSV (Comma Separated Values), or 

Merge (if multiple files are selected, they will be copied as one merged multi-file). 

• Select the files you wish to download from the instrument and use the  button to copy them 

to the destination, or use the  button to copy only the new files. 

 
 

Files list (Device) Files list (Local) 

Destination selection Source selection 

Display filter buttons 
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Figure 3-2. Changing the view of the memory content of the SVAN 979 instrument. 

 

 

You can use the Results, Logger, Setup, Wave, CSV and Other buttons in the Display filter panel to 

select the file types to be displayed in the lists. 

 

The SVAN Files dialogue box is shown in Figure 3-1. More detailed information on how to use this 

dialogue box can be found in the SvanPC++ HTML help (path: Dialogue boxes and sub-windows / SVAN 

Files dialogue box). 

 

 

 

 

3.2.2 CSV EXPORT 
 

It is possible to convert files to CSV format before downloading. All the measurement information 

and numerical results are stored in the converted files, allowing for easy import into most data 

processing software packages. To do this, select the CSV option in the Download type panel using the 

 button. 

Note: This functionality works in the same way as the CSV Publishing tool available in Remote 

communication sessions (see Chapter 12.3). 

 

You can also convert files already stored on your PC to CSV format using the pull-down menu shown 

below. 
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Figure 3-3. Converting files stored on the PC memory into CSV format. 

 

 

3.2.3 SETTING REAL TIME CLOCK 
 

To set the Real Time Clock in the instrument, the user must click on the  button. The 

current date and time are transferred from the PC to the connected instrument. The message 

“RTC updated” appears on the screen.  

 

It is also possible to set the date and time manually. To do this, press the arrow button next to the 

Set RTC button and enter the date and time in the Customize RTC dialogue box. 

 

 

 
Figure 3-4. Customize RTC button and dialogue box. 

 

 

3.2.4 MERGING FILES  
 

Merging files is the process of creating a single file (a multifile) from several files. It is usually 

performed on the results of measurements taken at different times, resulting in a file containing a 

finite range of the time domain, analogous to a Logger results file.   

 

You can merge files when downloading them from an instrument in the SVAN Files dialogue box: 

• Select the files you want to merge from the device’s files list. 
• Press the Merge button in the Download type panel. 
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• Press the Download selected files button. 

 

 
 

Such merged files are automatically named Multifile (1), Multifile (2) etc. 

 

It is also possible to merge files that have already been downloaded: 

Open the files to be merged using the  button or the Open command from the File menu. 

If several files are selected for opening, the Multiple Selection dialogue box appears. To create a multi-

file, press Merge & Open. 

  

  
Figure 3-5. Merging previously downloaded files. 

 

The header information of the merged files can be browsed using the navigation buttons that appear 

in the toolbar of the Header Info view subwindow. 

 

 
*) These buttons are available for SVAN 94x, SVAN 95x and SV 106 instruments (except for SVAN 958AG) 

 

Figure 3-6. A Header info view created for a multifile, with specific navigation buttons.  

 
 

Merging files with different settings for SVAN 94x, SVAN 95x and SV 106 instruments 

(except for 958AG) (.svn files) 

 

If the settings in merged files do not match, a list of groups of merged files created according to the 

different settings will appear in the file list toolbar. 

 

Choose one of the files 

that have been merged *)  
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Figure 3-7. Files list toolbar containing groups of files in a multifile with different measurement settings. 

 

Note: Some parameters, including the integration period and calibration factors, can be ignored 

when files are grouped (i.e. files with different values for these parameters are placed in the same 

group). This can be configured in the Main Options dialogue box (path: Tools / Main Options / 

Multifiles). 

A multifile created from files with different settings can be viewed in two ways. 

The “Merged ...” views allow you to view only the data from the selected group, according to certain 

settings. 

The Mixed settings results view allows you to view all the merged data without taking the settings 

into account; the data available in all the merged files is displayed together, sorted only by channels 

and profiles. 

The latter can be useful if a minor change to the settings has been made in the middle of the 

measurement. 

 

 
 

 

Figure 3-8. The Merged results view contain only the results of measurement with the same settings, while 

the Mixed settings results view allow for displaying all the merged data regardless of the settings.  

 

Note: In the Mixed settings results view, the results are always displayed on a logarithmic scale (in 

decibels). 
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Merging logger files (.svl files) 

 

Logger files are merged in a different way to results files. If the files contain measurements made 

with the same settings, merging will create the .svl file with the combined data from all the files. Files 

are merged into one file by taking the earliest results and adding subsequent results up to the most 

recent. Pauses are included in the time domain fragments for which no results are defined in the 

merged files. Only the header of the first (earliest) file is retained. The headers of all other files will  

be removed. If some settings are different, SvanPC++ may create an .svu file with combined data, or 

if the settings are completely different or the results overlap in time, then you should use the project 

functions for merging logger files (see Chapter 10.6.1). 

 

List of parameters that must match to merge files: 

• instrument type (unit type) 

• channel modes (slm / vlm) 

• reference levels (ref level) 

• profile parameters: filter, peak filter, detector 

• spectrum parameters: filter, window, band (audio/full), averaging type (linear/exponential) 

• for FFT: number of bands, spectrum resolution 

• for 1/1 – 1/12 octaves: lower octave, number of octaves, number of total values 

• for spectrum histograms: number of bars, lower class, number of classes, class width 

• for histograms: lower class, number of classes, class width 

• selected levels of LN statistics 

• averaging type (Leq / RMS). 

 

 

 

3.2.5 CORRECTING DATE AND TIME 
 

It is possible to correct the date and time of the start of measurements in files downloaded from 

Svantek instruments. To export a file with a date and time other than that set by the instrument, 

open the file and use the Export » Export with corrected date & time... command from the File menu. 

In the dialogue box that appears, specify the desired date and time and press OK. You will then be 

able to specify a new location and name for the file with the corrected date and time. 
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Figure 3-9. Correcting the measurement date and time in downloaded files. 

 

 

3.3 SETUP FILE EDITOR 
 

The Setup file editor is a feature of SvanPC++ that gives users easy access to the current settings of 

Svantek instruments, allows them to configure instrument settings. This function is available for most 

Svantek instrument series: SV 10x, SV 20x, SV 30x, SV 97x, SVAN 958AG, SVAN 959, SVAN 97x. The 

clear visualisation, similar to the instrument setup menu, allows the user to configure the instrument 

settings quickly and efficiently. The configured settings can be saved in external .svt files for future 

reference. 

 

 

3.3.1 OPENING SETUP FILES 
 

The Setup file editor can be activated from the Instrument wizard or from the SVAN Files section. 

SvanPC++ uses setup files of the connected instrument. Before opening a setup file from the SVAN 

Files section, you should select the desired instrument if more than one instrument is connected to 

your PC.  

 

When you activate the Setup file editor from the Instrument wizard, the setup file is downloaded to 

the temporary catalogue on your PC and then opened. 
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The SVAN Files section gives you more options. You can open the setup file from the Instrument 

wizard, or the SVAN Files dialogue box. In the second case, you can download the setup file by 

yourself to the selected catalogue and then open it. You can save the edited file to the PC under a 

different name than the one used in the instrument to open it later. To edit a setup file, you must:  

1) select it in the file list of the SVAN Files dialogue box and double-click it or  

2) press the Setup file editor button located in the top right corner of the window, as shown in 

figure below (see also Chapter 3.2).  

You can also choose not to select a setup file, but just press the Setup file editor button. This action 

is the same as activating the Setup file editor from the Instrument wizard, and a temporary file first 

created on a PC, and then opened in the Setup file editor. 

 

 
Figure 3-10. Opening setup files (in the Svan Files window). 

 

The file format is automatically checked on opening. In case of incompatibility, an error will be 

reported. Otherwise, a new window will be opened, containing the SVAN instrument’s settings in a 
configuration similar to its internal menu structures. 

 

If you have previously downloaded a setup file from a Svantek instrument and saved it to your PC, 

you can open such a file in the Setup file editor by clicking on the  button, see the figure below. 

 

  
 

Figure 3-11. Opening a setup file stored on the PC. 

1 

2 
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3.3.2 EDITING INSTRUMENT SETTINGS 
 

The Setup Editor is available in two modes: Standard and Extended. 

 
Standard: 

 

 
 

Extended: 

  
 

Figure 3-12.  Setup Editor in Standard and Extended modes. 

 

 

The settings available in the Setup Editor correspond to those available via the SVAN instrument’s 
interface. For details on the meaning of the available settings, please refer to the manual of your 

Svantek instrument. 

 

 

 

 

Check to set 

Extended mode Available 

categories 

of settings 

Settings in 

the selected 

category 

Uncheck to set 

Standard mode 

All available 

settings 

Buttons for 

switching 

the view 

Controls related 
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to the selected 
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Standard mode 

 

The Setup Editor in Standard mode allows you to view the settings most likely to be changed, 

presented in a simple and intuitive way. Note that not all settings available in the connected 

instrument may be available in Standard mode. 

 

The settings are divided into several categories. You can select a category using the tabs at the top 

of the Setup Editor window (see figure above). The set of categories depends on the type of 

instrument with which the edited setup file is compatible.  

 

In Standard mode, settings can be easily edited using the following elements of the Setup Editor 

graphical user interface: 

• checkboxes – allowing to select some of several options, 

• list boxes – allowing to select one of several options, 

• text fields – allowing to enter a value using the keyboard, 

• binary buttons – allowing to enable or disable an option. 

 

 
 

a) check boxes 

 

 
 

b) list box 

 

 

 
 

c) text field 

 
 

 

d) binary button 

 

In some cases, the message ‘Settings currently not available’ may appear, indicating that all settings 

in a particular category are unavailable for modification. This happens when the particular category 

of settings is related to an option from another category in the same setup file. For example, the 

Spectrum settings will only be available if a spectral measurement function (e.g. 1/1 Octave) is 

selected in the Measurement category of settings. 

Note: Standard mode is not available on some types of Svantek instruments. 

 
Extended mode 

 

In Extended mode, all the settings available in the Svantek instrument are visible and available for 

editing. To change settings in Extended mode, use the controls that appear in the panel at the top 

right of the window (see figure below) after selecting an item from the list. The list of settings on the 

left of the window, can be displayed in a tree view, a list view or in the form of wizards. You can 

change the view using the buttons at the bottom of the window. 

 

 
 

Figure 3-13. Buttons for switching the mode in the Setup Editor in Extended mode. 

Click to switch on / off 



                                                                                     SvanPC++ User Manual   

 

20 

The default Tree View is shown in the figure below. It presents the settings in a tree form, similar to 

the structure of the settings in Svantek instruments. The nodes represent menus, while the leaves 

represent parameter settings.  

 

 
 

Figure 3-14. The Tree view of instrument settings in the Setup file editor in Extended mode. 

 

The List View is shown below. It displays the settings (and only the settings, not the menus) in the 

form of a list containing the names of the settings and their current values. You can choose to view 

the settings in alphabetical order – List (A-Z) or in the same order as in the instrument – List. 

 

 
 

Figure 3-15. Instrument settings presented in List View in the Setup file editor. 

 

The Wizards View contains a list of general areas of the instrument settings that can be customised, 

as shown in the figure below. It allows you to configure the instrument settings in a simplified 

manner. Double-click on a selected item to launch the wizard. 

Note: Wizards with a red cross indicate that some of the critical settings that are part of the 

functionality of the wizard are set in such a way that the functionality may not work as expected. 

 

The Cancel Wizard button allows you to exit the current wizard without saving the changes you have 

made. 

 

If you are using the Tree view or List view, these wizards will also appear in the Related Wizards panel 

at the bottom right of the window. 
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Figure 3-16. Instrument settings presented in Wizards View in the Setup file editor. 

 

Some settings are linked. This means that one of them is only available for editing only if the other is 

set to a certain value. For example, the Auto Save option is only available if the Integration Time value 

is equal to or greater than 10 seconds (unless the Repetition Cycles is equal to 1). Therefore, the Auto 

Save option cannot be modified if the Integration Time is set to 9 seconds or less. If there is a 

discrepancy, the Setup Editor will ask for confirmation. If the user chooses to proceed with 

the change, the relevant parameter will be set to a value that will not cause a mismatch (the default). 

In our example, after attempting to change the Integration Time to a value less than 10 seconds when 

Auto Save is enabled, the Setup Editor will prompt for confirmation. If the user continues, Auto Save 

will be switched off. 

 

 
Figure 3-17. Confirmation box – the user has selected Integration Time 

less than 10 seconds, while Auto Save is set to ON. 

 

 

3.3.3 UPLOADING AND MANAGING SETUP FILES 
 

The Setup filename field at the top of the window allows you to change the name of the original setup 

file. This is the file name that the instrument will see after the file is uploaded to its internal RAM or 

Flash memory. Changing this filename allows you to store multiple setup files in the instrument with 

different filenames. The filename is limited to 8 characters. 
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Note: Uploading a setup file with an existing filename will replace the old setup file with the new one. 

 

Once you have finished editing the setup file, you may wish to send it back to the connected 

instrument. To do this, use the buttons at the bottom of the Setup Editor window: 

• Upload setup – stores the setup file to the instrument’s memory in the pre-defined SETUP 

catalogue for future activation. 

• Activate setup – configures the instrument settings according to the edited setup file. The 

setup file is then rewritten. 

• Upload & activate – stores the setup file in the instrument’s memory in the pre-defined SETUP 

catalogue and activates settings from the uploaded setup file. 

 

  
Figure 3-18. Buttons for sending edited setup files to the connected instrument. 

 

If you activate the Setup file editor from the Instrument wizard or by pressing the Setup file editor 

button without selecting a setup file, you will be modifying the current instrument settings (Setup 

filename: Settings). The Upload setup and Upload & activate buttons will then be disabled. Of course, 

you can still use the button  to save various setup files on your PC. 

 

However, if you change the Setup filename (e.g. to Set1), the Upload setup and Upload & activate 

buttons become active, and you can upload the file with the edited settings to the pre-defined 

instrument’s SETUP catalogue. 

 

Note (for SV 106): Most Svantek instruments store their settings in the form of text files with the 

same structure as used by SvanPC++, but the SV 106 instruments do not. Therefore, in the case of 

the SV 106 instruments, it is only possible to modify the current settings of the instrument, but not 

to save setups with different names in the instrument’s memory. The Upload setup and Upload & 

activate buttons will always be disabled. Of course, you can still use the  button to save various 

SV106 setup files to your PC (these files will have an .svn extension). 

 

Note (for SVAN 958): It is not possible to edit the settings of the SVAN 958 instrument (SVAN 958AG 

offers this functionality).  

 

At the top of the Setup file editor window, next to the Setup filename field, there are a number of 

buttons used to manage files: 

•  Open – allows you to open a setup file stored on the PC, 

•  Save – allows you to save the currently edited setup file on the PC, 

•  Print – allows you to print the contents of the currently edited setup file, 

•  Export to text file – allows you to save the contents of the currently edited setup file in 

simple text format. 

Note: If you print the setup file or export it to a text file, the data will be arranged in a similar way to 

the List View, in alphabetical order, with the corresponding values right next to it. A label is added to 

the list indicating the type of instrument for which the setup file has been prepared. 
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During the upload, the device type and software version are compared with the information in the 

file, and any incompatibilities are reported. f the software version of the uploaded file differs from 

that of the unit, the Setup file editor will offer to either abort or upgrade (or downgrade) the file to 

the format accepted by the instrument.  

 

If multiple instruments are connected, the selector at the bottom of the window allows you to choose 

the device to upload. 

Note: A setup file named 'Settings' is treated differently from files with other names when uploaded: 

it is not stored on the instrument's SD card, but is activated immediately. In Tools » Main Options » 

Data Exchange, you can enable a warning to be displayed each time such a file is uploaded. 

 

 

3.4 INSTRUMENT WIZARD 
 

The Instrument Wizard provides an easy access to various features of SvanPC++ concerning a 

connected device. 

It opens automatically each time the software detects a connection to a Svantek instrument for which 

the Wizard is available. Most Svantek instruments are currently supported by the Instrument Wizard. 

Note: To disable the automatic opening of the Instrument wizard, uncheck the Show wizard when 

connecting an instrument control in Main options / Instrument autodetection. 

Note: The Instrument Wizard view depends on the type of instrument connected and the type of 

connection (USB or Internet). 

 

You can also manually show / hide the Instrument Wizard window using the Instrument Wizard 

command in the View menu or the  icon on the Toolbar. 

 

 
Figure 3-19. The Instrument Wizard dialogue box for SV 200. 
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Depending on the instrument connected, different buttons are available in the Instrument Wizard 

window, as shown in Table 3-1. 

 
Table 3-1. Buttons available in the Instrument Wizard. 

 
Button  Function  

  

 

 

 

 

 

  

− allows you to configure the connection to the instrument via 

SvanNET, for details see the SvanNET User Guide available on 

the Svantek website. Once the connection is configured, the 

Remote Communication Center button will appear instead of 

this button. 

Note: This button is only available for SvanNET compatible 

instruments. For other instruments, the standard Remote 

Connection Wizard button is displayed. 

 

  

− opens the Remote Communication Center window. 

The connection type available for the current instrument 

(Internet, USB, RS232, etc.) is automatically selected. 

  

− synchronises the real-time clock of the connected 

instrument with the real-time of the PC. 

 

  

− allows you to calibrate some connected instruments (SV 100, 

SV 100A, SV 101, SV 103 and SV 200 – see SVAN menu); see 

Chapters 7.2 and 7.3 for details.   

  

− compares the firmware version installed on the instrument 

with the latest available version.  

  

− opens the SV100/101 Options configurator window.  

 

 

  

− opens the Connection configuration wizard window to 

configure the connection via TCP Server / AS (for the 

SVAN 953, 955, 956, 957 and 959 instruments).  

In the case of SvanNET compatible instruments , the Remote 

Connection using SvanNET button is displayed instead. 

  

− opens the Setup file editor window.  

  

− opens the SVAN Files dialogue box.  

 

Note: The Check for Updates button is only used to check for newer firmware versions. It is not 

possible to download new firmware using the Instrument Wizard. 

 

 

 

 

 

http://www.svantek.com/
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3.5 SVAN PC++ FILE TYPES 
 

Since the release of the SV 979 instrument, files downloaded from Svantek instruments may have 

different extensions to better distinguish the file contents. 

 

All SvanPC++ file types are listed below. 

 
Icon  Extension Description  

 

  

 

.svn 

 

 

− Files created by the SVAN 94x, SVAN 95x and SV 106 instruments 

(except for SVAN 958AG) and multi-files created using the SvanPC++ 

software. 

  

.svl 

 

− Logger files or new format files containing both time history and 

summary results. 

 
 

.svt − Instrument setup files. 
 

 
 

.svr − Results files (only SVAN 979 with firmware < 3.x). 
 

 
 

.svs − Station wizard settings (RC) files. 
 

 
 

.srt − Real-time analysis results files. 
 

– 
 

.sts − SvanPC++ application settings files. 
 

 
 

.svp − Svan Project files. 
 

 
 

.svu 
− User files, such as functions created with the User Function Wizard. 

(and files from export) 

–  
.svmt 

 

− Files with Measurement tracking data created using the SvanMobile 

Android app. 

 
 

.svz 

 

− Files containing measurement results with including photos, 

generated using the Building acoustics Android app. 

  

.spr 

 

− Files containing measurement results, generated using the Building 

acoustics Android app. 
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4 DATA VISUALIZATION AND PLAYBACK 

 

 

The basic SvanPC++ software package enables the visualisation of measurement results downloaded 

from Svantek instruments. 

 

 

4.1 OPENING DATA FILES 
 

After downloading a data file (see Chapter 3.2.1), you can open it directly from the SVAN Files 

dialogue box by double-clicking on its name in the file list. This will close the SVAN Files dialogue box 

and open the selected file. 

It is also possible to open a file previously stored on the PC. To do this, press the  button or use 

the Open command from the File menu and locate the desired file using the File open dialogue box. 

It is possible to open several files at the same time. To select the files to be opened, you can use the 

Files list toolbar, located in the upper left corner of the SvanPC++ window, below the Main toolbar. 

 

 
 

Figure 4-1. Files list toolbar. 

 

To expand the list of currently open files, click on the  marker. 

To select the file, you want to work with, click its name in the list. 

To close a file, select its name in the list and press the Close file button. 

You can choose to show or hide the Files list toolbar using the Files List command on the View menu. 

It is also possible to change the location of the Files list toolbar. To do this, left-click anywhere in its 

area and drag it to the desired location without releasing the mouse button. 

 

 
4.2 DATA VISUALISATION MODES 
 

The basic SvanPC++ software allows you to visualise the data in one of four different modes: 

• Table View, 

• Plot View, 

• Spectrogram View, 

• Text View. 

 

You can switch between different view modes to find the optimal form for reading and analysing 

data. To switch between views, you can use the corresponding buttons on the View toolbar (located 

at the top of each view sub-window) or the corresponding commands in the View menu, as shown in 

the figure below. 
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Figure 4-2. Controls for switching the view modes in the View Toolbar (left) 

and in the View menu (right). 

 

The availability of the view modes depends on the type of data currently active. For example, Header 

information data can only be viewed in the Table or Text mode, while the results of time domain 

measurements can be viewed as a Table or Plot, but not as a Spectrogram. If a view type is not 

available for the currently active data, its icon will not be displayed. 

 

Each of the view modes has its own set of tools for customising the way the data is displayed to 

achieve a desired form of visualisation. he features of each view mode are described in 

Chapters 4.2.1–4.2.4. 

 

 

4.2.1 TABLE VIEW 
 

Table View displays numeric and text data are displayed in the form of a table. This mode is used to 

view Header information and measurement results such as Main results, Statistics, Logger results etc. 

in numerical form. 

 
Figure 4-3. An example of the Table view.  

Table Plot Spectrogram Text Available 

view modes 
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Normal / Transposed view 

 

In general, when the Normal view is set, the rows of the table contain different time samples, while 

the columns contain the results of different measurements or calculations. Switching to the 

Transposed view sets the inverse configuration. The Transposed view is particularly useful when you 

need to view many variables in a few time points. 

 

To activate the Transposed view, you can click on the  button or use the pull-down menu next to 

it, both of which are available in the toolbar of the View sub-window. 

 

  
Copying with headers 

 

The Copy with headers tool is available from the Edit menu or from the pull-down menu opened by 

right-clicking. It copies the selected data to the clipboard together with the descriptive headers from 

above and to the left of the selection. 

 
 

 

 

 
 

Figure 4-4. The Copy with headers tool.  

 

 
Cell types 

 

There are different types of cells in the table: 

• Cells with a white, red or purple background contain the data values. 

• Cell with a blue background contain selected data that will be copied when you use the Copy 

with headers tool. 

• Cells with a grey or yellow background contain headers, describing the current data. Grey 

headers of selected data (pressed) will be copied when you use the Copy with headers tool. 

P1 (A)

No. Date & time LApeak (TH) [dB]

6 2019-10-02 17:28 85.2
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Customising the view 

 

To configure the way data is displayed in the Table view, use the following buttons: 

 

 
Table Font Size (on the Main Toolbar) – sets the size of the text displayed in the table. 

 

 
AutoSize Columns (on the View Toolbar) – sets the column widths to match the longest 

string of text. 

 

 

The Table view settings can also be configured in the Table View tab of the Main Options dialogue 

box. You can open the Main Options dialogue box using the  button on the Main toolbar or the 

Main Options command from the Tools menu. This tab consists of 3 panels: 

• The Font and colors panel allows you to configure the way text is displayed in the Table view. 

To select the text font, press the Choose button. A font selection window will appear, allowing 

you to select the font you prefer. To select the text colour, press the Text color button. A 

colour selection window will appear allowing you to select the colour you prefer. 

• The Display panel allows you to configure the way results are displayed in the Table view when 

viewing multiple results with different steps. The continuously repeating values option causes 

that the results for cells (time points) where their values are not defined, because a result is 

measured with a greater step than other displayed results, are displayed with the last 

measured value. The show single value at start time of greater step option causes that the 

results for the cells (time points) in which their values are not defined will be empty. 

• The Marker set of values panel allows you to configure the way markers are displayed in the 

Table view. Markers contain regions of the time domain that are specified by the user or that 

are automatically created. They can then be displayed in the Table view as a result. You can 

select the value (1, 0) or special character (+, -) to be displayed in the table corresponding to 

the data contained / not contained in the marker (Existence value / Not existence value).  

 
Conversion of units (for linear units only) 

 

You can easily convert the units of the displayed results in terms of the prefix using the menu that 

opens when you right-click on the header of a column in the normal view or on a row in the 

transposed view. 

 

 
 

Figure 4-5. Converting the units in a Table view. 
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Limiting the time domain 

 

The Limit time domain to tool allows only a selected time domain, defined by a selected result or 

marker, to be displayed in the table. To activate this option, display the Configurator  panel by clicking 

on the  button, select the desired result / marker in the Configurator and click on  » Limit time 

domain to position. To remove the limit, click on  » Clear time domain limit. 

 

In the example below, after selecting the Limit time domain to command, the time domain is limited 

to the range of ‘Marker 1’ (only data for which the marker value is 1 is displayed). For more detailed 

information on the View configurator, see Chapter 4.4. 

 

 
Figure 4-6. Limiting the time domain.  

 
 
 
 
4.2.2 PLOT VIEW 
 

The Plot view displays parameters measured in the time or frequency domain, such as Logger or 1/3 

octave results, in the form of a 2D plot. 
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Figure 4-7. An example of the Plot view.   

 

 

To scroll the view along an axis, you can: 

• use the green sliders, 

• left-click on the axis and drag the mouse . 

 

To scale an axis, right-click on the axis and drag the mouse. 

 
 
Window configuration 

 

The Plot view window consists of 3 sections (Figure 4-8): 

• Central section – the plot with the axes and additional controls, 

• Upper table – containing some additional information, such as the titles, 

• Lower table – containing the positions of the cursors and selections, as well as a list of 

measurement results and calculations. 

 

You can show or hide the tables using the  buttons, located on the left side of the window. You 

can also use the Plot view pull-down menu or press the  button to toggle between the 3 available 

modes: 

• Normal – all sections visible, 

• Data And Results – upper section hidden, 

• Only data – both upper and lower sections hidden.  
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Figure 4-8. Parts of the Plot view window.  

 

The upper table can also be hidden using the Maximize data command from the Window menu. 

 

You can decide whether the titles (at the top of the window) should be displayed by default in each 

newly created plot view using the settings available in Main options » Graph view » Data visualization. 

(You can open the Main Options using the  button on the Main toolbar.) 

 
Contents of the plot view 

 

All results displayed on the plot are listed in the table at the bottom of the Plot view window. 

 

Clicking on a result name in the list will highlight its representation in the plot area so that you can 

easily recognise it when many functions are being plotted at once. The  /  buttons are used to 

hide/show the results. The colour used for plotting a function can be selected by clicking on the 

square next to the result name. 

 

The contents of the table below the plot can be customised using the pop-up menu which is opened 

by right-clicking anywhere in the table area. The menu contains the following commands: 

• Set font... – to select the font used in the table below the plot, 

• Copy with headers – to copy the contents of the table to the clipboard (the column and row 

headers are also copied), 

• Copy line – to copy one line of the table, 

• Autosize columns (fit in window / fit in column) – to automatically adjust the width of the table 

columns: the Fit in window option causes the columns to fill the entire width of the panel, 

while the Fit in column option resizes the columns to fit exactly the width of the text they 

Upper part 
(additional 
information) 

Central part 
(plot and 

controls) 

Lower part 
(selections 
and results) 

Show / hide 
upper table  

Show / hide 
lower table 
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contain. Whenever you manually resize a column, the Autosize off option is automatically 

selected. 

• Show start / stop / duration – to show or hide the columns that display information about the 

time ranges defined by block and cursor selections and markers. 

• Show whole data / inside blocks / outside blocks / individual blocks – to show or hide the rows 

of the table that represent various ranges of the time domain: whole data corresponds to all 

available time history, inside blocks corresponds to the accumulated areas of all block 

selections, outside blocks corresponds to the areas of all fragments of the time domain that 

are not included in block selections, and individual blocks corresponds to separate block 

selections that are displayed individually (as Block 1, Block 2 etc.). 

• If you have selected a calculated result, the Show calculation parameters command allows 

you to open the Calculated results window (see Chapter 5.2.6). 

• The Add selected function to comparison window option can be used to select the results to 

be displayed in the Results comparison windows (see Chapter 4.3.3). 

 

The table at the bottom of the plot can be displayed as a separate window by using the Common 

results window command from the Window menu. 

 

 
 

Figure 4-9. Customizing the contents of the table below the plot. 

 

You can also select the currently active function (result), which is used to define the primary y-axis 

and the main cursor domain, and the parameter to be displayed on the secondary y-axis, using the 

Active function selector and the Secondary y-axis selector located in the top of a plot view. 
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Figure 4-10. Elements of interface related to configuring the contents of a Plot view. 

 

 

Note: Some features in the table below the plot are only available when the Environmental 

Monitoring module is enabled. 

 

 
Graphic options 

 

The graphical options such as the background colour and grid line style of a specific, currently opened 

Plot view can be configured using the Local Plot Settings dialogue box, opened with the Local Plot 

Settings command, available from the View menu and from the pull-down menu opened by right-

clicking in the plot area.  

 

Similar options, but concerning all plot views in SvanPC++, can be configured using the Graph View 

options in the Main Options. 

 

Primary 
y-axis 

selector  

Secondary 
y-axis 
selector  

Displayed 
results  
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Figure 4-11. Configuring graphical options of the Plot view by clicking in the plot area with the right mouse button (left 

window) or using the Graph View options in the Main Options (right window). 

 

 

You can also specify how functions are drawn on the plot using the Drawing mode buttons  /  / 

 on the left of the window. 

 

 
Axis auto scaling 

 

The Y-axis auto scaling tool is used to automatically scale the Y-axis so that the result values fill the 

plot area. To activate the Y-axis auto scaling, use the  /  buttons located on the left hand side of 

the Plot view window. 

 

Similarly, the X-axis auto scaling tool is used to automatically increase or decrease the number of 

pixels per sample to make all samples visible in the entire plot area. If displaying 1 pixel/sample is still 

insufficient all the data for the current number of samples and window size, the algorithm will apply 

time aggregation to the minimum sufficient level (X-axis auto scaling does not apply frequency 

aggregation). To enable the X-axis auto scaling, use the  /  buttons located at the left hand side 

of the Plot view window. 

 

You can also automatically scale the X-axis so that only a selected time interval is displayed using the 

Auto scale x settings dialogue box, accessed by selecting the Auto scale x settings... command from 

the context menu opened by right-clicking anywhere in the plot area. It is also possible to extend the 

range of measurement results for the X-axis starting from a selected hour. 
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Figure 4-12. The Auto scale x settings. 

 

Another method of automatically scaling the X-axis is to right-click in the plot area and select the Auto 

scale x to selection command which will scales the X-axis according to the current block selection. 

The time history displayed may contain unselected fragments if the block selection is not continuous. 

 

 
 

Figure 4-13. Auto-scaling the x axis to a selected range of the time history. 

 

Note: If you scroll or scale an axis when the corresponding auto-scaling tool is active, it is 

automatically deactivated. 

 

The commands related to the auto-scaling of the X-axis are also accessible from the Zoom menu on 

the Toolbar (or by right-clicking), as shown in the figure below.  
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Figure 4-14. X-axis auto-scaling settings from the pull-down menu.  

 

 
Selection of data 

 

To select data, you can use the cursors or block selections. Each cursor allows you to select one 

element of the data at a time, while blocks allows you to select multiple elements at once. 

 

Main cursor 

When you open a window with the plot view, only the Main cursor is present. You can set its position 

by clicking in the plot area, by using the left and right arrow keys on your PC keyboard or by using the 

    buttons at the top of the SvanPC++ window. You can also deactivate the Main cursor, 

by clicking on the  icon next to its name in the table below the plot. When passive, the cursor icon 

changes to . By default, the current position of the Main cursor is marked by a vertical line with an 

inverted background colour. 

 

#1 and #2 cursors 

Two additional cursors are available, called Block cursor #1 and #2. You can set their positions by 

right-clicking anywhere in the plot area and selecting the Put #1 or Put #2 command from the pull-up 

menu, or by pressing CTRL+1 or CTRL+2 keys. The selected cursor position is then set to the current 

position of the Main cursor. By default, the positions of the additional cursors are marked on the plot 

by vertical lines with an inverted background colour and numbers written next to them. You can 

deselect additional cursors by clicking on the  icons next to their names in the table below the plot. 

 

Block selections 

To set a block selection, click in the plot area and drag the mouse without releasing until all the 

required elements are selected. If you select two different blocks, the selections are added (previous 

selections are not removed). The selected area has a grey background. To deselect blocks, click on 

the  icons next to their names in the table below the plot, or right-click in the plot area and select 

Deselect block(s). You can deselect the current (last selected) block or all blocks at once. You can also 

invert the block selection. Selecting this option deselects the current selection and selects all the 

remaining data in the file. 

 

Additional features 

• The #1 and #2 cursors can be used for precise block selection. When both block cursors are 

on the plot: 

o Press ENTER to create a new block selection between the two block cursors, 
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o Press ESC to deselect the part of a block selection between the cursors (if the area between 

the cursors contains a fragment of a block). 

• If the Environmental Monitoring module is enabled, clicking on a block with the main cursor 

will automatically move the slider in the table below the plot to the field containing the area 

of the selected block.  

Note: This feature can be disabled in Main Options » Graph view » Data visualization » Trace 

current block. 

• Pressing ESC when the #1 and #2 cursors are not placed will deselect a block containing the 

Main cursor. If the Main cursor is not inside any blocks, pressing ESC will deselect all blocks 

(you will be asked to confirm this deselection). 

 

 

 

 

 

 

 
 

Figure 4-15. Types of data selection in the Plot view. 

 

The selected data is listed in the table at the bottom left of the Plot view window (not visible if the 

Only Data mode is selected). In the case of the cursors, the point of their position is given. For block 

selections, the “Start” and “Stop” columns show the start and end points of each separate blocks. For 

each cursor and block selection, these points can be edited by entering manually the time values by 

double-clicking on the corresponding fields in the above columns. 

 

 
 

Figure 4-16. Manually editing the position / range of selections in plot views. 

 

Note: To display the “Start” and “Stop” columns, the corresponding options must be enabled in the 

table’s context menu; see this topic for details. 

 

With the Environmental Monitoring module enabled, you can also generate block selections 

according to complex criteria using the Blocks/markers generator. For details, see Chapter 5.1.4. 

Main cursor 

Block selection 

Additional cursors 



                                                                                     SvanPC++ User Manual   

 

39 

 
Limit lines 

 

The Limit lines are lines (horizontal or shaped for spectra) with custom labels and colours that you 

can draw in Plot views at selected levels of the Y-axis.  

 

 
 

Figure 4-17. An exemplary plot view with two limit lines. 

 

If you wish to display limit lines in a plot view, you must first configure them in the Graph view » Limit 

lines settings tab of the Main Options dialogue box. 

 

Note: Separate sets of limit line values and labels can be specified for Logger and Spectrum views and 

for sound and vibration data. 
 

     
 

Figure 4-18. Configuring the limit lines in the Main Options dialogue box for the Logger and Spectrum views. 

 

The value specified in the Limit lines settings is a unitless value – the line will always be drawn at the 

same value on the Y-axis, regardless of the units currently displayed (so the lines will intersect the 

measurement results at different points when linear and logarithmic values are displayed). 

 

You can define a special shape (mask) for the spectrum limit lines by setting different values for all 

1/3 octave bands in the box that opens when you press the Value button. 

Limit lines 
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Once the limit lines have been configured as described above, they can be drawn on the plot as 

follows: 

1. Select the Limit lines settings... command from the context menu available after right-clicking in 

the plot area or using the  button on the View Toolbar. 

2. Set the visibility of the selected lines in the Limit lines dialogue box. 

 

 
 

 

 

 
Figure 4-19. Setting the visibility of limit lines in a plot view. 

 

You can also access the Limit lines settings in the Main options directly from the Limit lines dialogue 

box by pressing the  button, as shown in Figure 4-19. 

 

It is also possible to specify a set of limit lines to be displayed by default in each newly created Plot 

view. In order To do this, use the checkboxes on the left of the Limit lines settings tab in Main Options 

(Figure 4-18). Once the default set of limit lines has been specified, a different set of limit lines can 

be selected for each Plot view as described above. 

 

 
Go to min/max 

 

Buttons above the plot area allow the main cursor to be placed on the sample corresponding to the 

minimum or maximum value of the selected active function. 

  

Select the lines 
you want to be 

drawn 

(Go to Limit lines settings 
in the Main Options) 
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Figure 4-20. Go to minimum/maximum buttons. 

 

4.2.3 SPECTROGRAM VIEW 
 

The Spectrogram view can be used to display the 3D variation of time, frequency and amplitude on a 

2D plot. The X-axis represents the time domain, the Y-axis represents the frequency domain and the 

colour variation shows the amplitude domain of the currently selected result. The time scale is linear 

and the frequency scale is logarithmic. The range of the colour scale is shown at the right of the plot 

area. 

 

 

 
 

Figure 4-21. An example of the Spectrogram view. 

 

The time axis can be scrolled using the green slider above the spectrogram area or by clicking and 

dragging the axis below the spectrogram area. In contrast to the Plot view, axis scaling is not available 

in the Spectrogram view. 

 

The configuration of the Spectrogram view window is the same as for the Plot view, see Chapter 4.2.2 

for details. 

Select active result function Go to maximum Go to minimum 

Main cursor Spectrogram button 
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Customazing the view 

 

You can select the result to be displayed visualized on the spectrogram using the Active function 

selector at the top of the Spectrogram view window. This selector is only visible in Normal mode, it 

is hidden in Data and Results and Only Data modes. The selected result defines the values on the 

Z-axis.  

 

 
 

Figure 4-22. The Active function selector. 

 

You can select the step of the recording of the spectra to be displayed: SR (used for Summary results) 

or TH (used for Time History results). The Auto scale z tool is used to scale the Z-axis to fit the range 

of data currently displayed. When scrolling through the time domain, the scale will change 

automatically. If you deselect the Auto scale z option, the scale will remain unchanged. 

 

 
 

Figure 4-23. The Auto-scale z control in the View Toolbar. 

 

You can change the Z-axis by setting the optimum contrast for the range of data you required. To do 

this, click on the colour bar representing the Z-axis, on the right of the Spectrogram view window. 

Then click on one of the squares displayed to move the range in which the chosen colour scheme is 

displayed. You can set 4 points to adjust the colour scheme as required. Changing the colour scheme 

does not change the scale of the Z-axis. 

 

           
 

Figure 4-24. Examples of z-axis colour scheme in the Spectrogram view. 
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Selection of data 

 

A point on the spectrogram can be selected using the Main cursor. To select a point, simply click 

anywhere in the spectrogram area. You can also change the position of the cursor using the arrow 

keys and the     buttons above the Spectrogram view window. 

 

The current position of the Main cursor is shown as the intersection of grey lines drawn in the 

spectrogram area. The table below the spectrogram area describes the position of the Main cursor 

in the time and frequency domain, as well as the result value at the selected point. 

 

You can hide/show the Main cursor by clicking on the  /  icon next to its name in the table below 

the spectrogram area. 

 

 

4.2.4 TEXT VIEW 
 

The Text view can be used to view Header information and measurement results in the text form. 

Data is presented as plain text with additional descriptions (if available). The text can be copied using 

the appropriate Edit menu commands. 

 

 
 

Figure 4-25. An example of the Text view. 
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4.3 DATA SPECIFIC VIEW SUB-WINDOWS 
 

4.3.1 OPENING VIEW SUB-WINDOWS 
 

After opening a file, downloaded from a Svantek instrument or stored on the PC, a View sub-window 

is automatically opened. It is displayed in the working area of the SvanPC++ window, as shown in the 

figure below. 

 

          
 

             Figure 4-26. A View sub-window and related controls. 

 

 
Figure 4-27. A minimized View sub-window. 

 
Figure 4-28. A maximized View sub-window. 

 

View 
sub-window 

Minimize, 
maximize, 
close the 

sub-window 

Navigator 

Close 

Restore 

Minimize 

Close 

Maximize 

Restore 
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• To move a sub-window, left-click on its title bar and move the mouse without releasing within 

the workspace. 

• To minimise a sub-window, press the  button. A minimised sub-window is automatically 

located in the lower left corner of the workspace, as shown in Figure 4-27. 

• To maximise a sub-window, press the  button. A maximised sub-window fills the entire 

workspace and hides all other sub-windows. When a sub-window is maximised, the Minimize 

/ Restore / Close buttons are moved to the SvanPC++ menu bar, as shown in Figure 4-28. 

• To close a sub-window, press the  button. 

• To change the size of the sub-window (make it bigger or smaller), position the mouse pointer 

at the sub-window border, press the left mouse button and move the mouse without 

releasing it within the workspace. 

 

Note: If the Auto arrange option in the Window menu is enabled, the  /  icons will appear in the 

top right corner of each sub-window. They can be used to lock the visibility of specific sub-windows. 

If the icon is as , that sub-window will remain visible when a new sub-window is opened. 

 

Different views are available depending on the type of data loaded. You can open multiple views of 

a file at the same time, e.g. a Header Information View showing information about the instrument 

and measurement, or an FFT Spectrum View showing the results of FFT measurements. 

 

To display a desired view, use the buttons on the Views bar (Figure 4-26). The icons on the buttons 

correspond to the different types of data represented by the views. 

 

You can also select the type of View sub-window that is automatically displayed when a file is opened. 

By default, Header information is always displayed first. To configure the priority of opening View 

sub-windows, open the Main options dialogue box using the  button or the Main options 

command from the Tools menu, and go to the Views tab. 

 

 
Figure 4-29. The View sub-windows Opening priority settings 

in the Main Options dialogue box. 

 

The data type defined as #1 will be opened with the highest priority. If it is not available in the current 

file, the data type defined as #2 will be opened if available, and so on. If none of the data specified in 

the Opening priority list is available, no View sub-window is automatically opened. You can then open 

a desired view using the Views bar. 
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4.3.2 VIEW SUB-WINDOW TYPES 
 

Depending on the type of data being displayed, different view sub-windows are characterised by 

different features. 

Different view modes (see Chapter 4.2) are available for certain types of sub-windows, e.g. header 

information can be displayed in table or text form, but not on a plot or spectrogram. If a particular 

view mode is not available, the corresponding icon will not be displayed in the Navigator bar. 

The view sub-window types can be grouped into several categories, each with specific tools and 

features, as described below. 

 

Header information  

 

This type of view contains basic information about the opened file, such as the device used for the 

measurement, instrument settings, file name, etc. It can be viewed in the Table or Text view. This 

data is available in every .svn, .svr, .svl, .svu and .svl file, and by default this view sub-window is 

automatically displayed when a file is opened. 

 

Some instrument configurations include alarm configuration. In this case, the Header view will include 

the alarms settings. 

 

 
Figure 4-30. The Header info view with Alarms settings. 
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Main results  

 

This type of view contains the results (a list of available measurement results is displayed in the 

Configurator panel) of a single measurement, together with some additional information such as the 

instrument settings or time elapsed during the measurement. If the data file contains Main results 

for more than one cycle, the user can scroll through them. 

 

It is advisable to view the Main results as a transposed table. The transposition can be easily 

performed by clicking on the  button when the Table view is already active, see Chapter 4.2.1. 

 

 
Figure 4-31. The transposed Main results view. 

 

 

 
 

 

Spectral results   

 

This type of view contains the frequency domain results relating to 1/1 Octave, 1/3 Octave, 1/6 

Octave, 1/12 Octave and FFT measurements. They can be viewed in a Plot or a Table view. 

 

You can specify how spectra are drawn on the plot using the Drawing mode buttons  /  /  

located on the left side of the window. 

 

Scroll to 
select the 

measurement 
cycle 
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Figure 4-32. FFT plot view.  

 

 

 

Logger / merged results  

 

Files containing the results of measurements taken in different times can be obtained in two ways: 

• downloading the results of a logger type measurement from the instrument, 

• merging several files containing individual results. 

The first type of data is displayed as Logger results, the other as Merged results. Both types of data 

represent the time history of measurements and can be viewed in a similar way, in either a Plot or 

Table view.  

Use the  button on the View toolbar, to open a file associated with the opened file. 

If the active file is a results file (.svn or .svr) with the indication of the associated logger file name in 

the header, pressing the  button will attempt to open the logger file from the same directory.  

If the active file is a logger file containing a Filename marker (Autosave option in the SVAN 95x single 

channel instruments), pressing the  button will search for a results file with the specified file 

name, corresponding to the measurement time specified by the current position of the main cursor, 

in the same directory where the logger file is stored. 

If the active file is a logger file containing Wave markers, pressing the  button will search for the 

.wav file corresponding to the time currently selected by the main cursor in the same directory as the 

logger file. If such a file is found, will be opened and the cursor will be moved to the same position as 

selected in the logger view. 

Note: If no matching file is found, the directory is searched again in order to find a .wav file with 

matching measurement time and instrument parameters such as type and serial number. 
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Figure 4-33. Opening the Logger file associated to a Result .svn file. 

 

 

Mixed settings results view  

 

The Mixed settings results view is used to display (in a single table) data from result files measured 

with different instrument settings. This view is therefore only available for multi-files in which such 

files have been merged. 

Note: In this view, values are always displayed on a logarithmic scale (in dB). 

 

See Chapter 3.2.4 for details. 

 
 

Logger / Merged spectral results  

 

Logger and Merged results can also be obtained in case of spectral measurements. The name of such 

a view includes the type of data (Logger or Merged) and the type of measurement (1/1 Octave, 1/3 

Octave, 1/6 Octave, 1/12 Octave or FFT), e.g. Logger FFT view. 

These types of data can be viewed in a Table, Plot and Spectrogram view. See Chapter 4.2.3 for a 

description of the Spectrogram view. 

When working in a Plot view, the spectrum is displayed for a selected point in time. The history of 

the spectrum can be browsed using the buttons in the View Toolbar. 

 

 
 

 

 
 

 

 

Figure 4-34. View Toolbar buttons serving to browse the history of measured spectra. 

Scroll to the beginning 

Previous sample Next sample 

Scroll to the end Current position 
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Statistics   

 

The Statistics view can be available both for both Main results files (.svn, .svr) and Logger files (.svl) 

after necessary calculations. 

 

Statistical data can be presented in two different modes: Histogram or cumulative function (Ln). By 

default, Histogram is initially displayed. To change the presentation mode, use the selector on the 

View Toolbar.  
 

 
 

Figure 4-35. Selection of data presentation mode in the Statistics view as a Histogram. 

 

 

The Statistics view can also relate to spectral results, displayed in the 1/3 Octave statistic and 

1/1 Octave statistic views. 

 

When viewing this type of data in the Histogram / Ln view, the statistics are displayed for a selected 

frequency. Use the  /  buttons on the View Toolbar to select the frequency value to be 

displayed.  

 

In the case of the spectral statistics, another view is available called Ln(f). In this mode, the spectrum 

is displayed for a selected statistical level. The  /  buttons are then used to select the statistical 

level. 

 

 

 

 

Presentation 
mode selector 
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Figure 4-36. Viewing the Statistics for spectral data in a way of cumulative function (Ln). 

 

 

 
 

Wave results  

 

This type of view allows you to view audio data in .wav format, or in .svl format if events have been 

saved. It can be viewed in Table or Plot view. When such a view is opened, the Wave Navigator 

becomes available, see Chapter 4.6. 

 
 

 

Time intersection  

 

The Time Intersection (TSect) views allow logger/merged spectral data to be viewed as a function of 

time for a selected frequency. 

 

Note: The time intersection is most useful when calculating reverberation time, which is one of the 

functions provided in the Building Acoustics module (see Chapter 11). Therefore, the TSect views 

are hidden by default when the BA module is not active. However, the TSect views can be enabled 

in Main Options » Views (see figure below). 

 

 

 

Data presentation mode 

Frequency selection 

Current frequency 



                                                                                     SvanPC++ User Manual   

 

52 

 

 
 

Figure 4-37. Enabling the Time intersection views when Building Acoustics module is not activated. 

 

The TSect view can be used in Table or Plot mode. It is only available if the open file contains spectral 

data measured at multiple times, such as logger/merged 1/1 octave, 1/3 octave or FFT data. 

 

 
Figure 4-38. Viewing the TSect with active Smoothing.  

 

 

The displayed frequency can be selected using the  /  buttons on the View Toolbar. 
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The Data Smoothing tool is available in the Time Intersection views. It can be enabled or disabled it 

using the Smoothing is ON/OFF button located next to the frequency selection buttons. The 

configuration of the data smoothing settings is available in the RT60 tab of the Main Options dialogue 

box. It is possible to configure: 

• the size of the sample set used for smoothing (Samples selector), 

• the response time value used for background detection in RT60 calculations. 

Note: Selecting a time point when working with a Time intersection view automatically changes the 

time displayed in the corresponding spectral view. 

 

 
Totals Results  

 

This type of view is available for results recalculated with the Total values parameter set in the 

Calculator tool (as opposite to Running values) and Summary results from the .svl logger files. This 

view can only be displayed in the Table mode. 

However, in the Total Results view you can see all these results with their values displayed only once 

for each period, along with information about the start time, duration and name of the period. 

In addition, the Total Results view allows you to sort the displayed periods by start time or by name. 

To do this, right-click on the header columns and select the Sort by start time or Sort by name 

command from the pull-down menu. 

In the Total Results view it is possible to display results in the Cumulated view. Cumulation can be 

applied to results, functions, or both. You can change the mode in the View Toolbar of the Marked 

periods Totals. 

 
 

Figure 4-39. Switching the mode of displaying the Total Results view 

with the use of the View Toolbar. 

 

Cumulation of results has the following effects: 

• Results calculated on block selections or markers without the Cumulate results parameter are 

not displayed. 

• Results calculated on block selections or markers with the Cumulate results parameter are 

displayed in a single row with the start time of the first period and the total duration of all 

periods are given in the Start Time and Duration columns. 

• For interval calculations, the Start Time value is the start of the interval. The Duration column 

then contains information about the length of the interval; all functions calculated with the 

same interval start time and length are displayed in the same row. 

• For the LTeq (Ltm5) result, the start time and duration values are displayed according to the 

selection, rather than the resulting values, so that it can be included in the same row as the 

other functions calculated on the given selection. 
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Cumulation of results causes all the calculated results of the same type to be displayed in one column. 

It is useful, for example, when SEL is calculated for two types of events that are marked with two 

different tags; after the cumulation of results, the values of all SEL calculations will be displayed in a 

single column. It is possible to enable cumulation of results and functions at the same time. 

 

 

 

 
 

Figure 4-40. Example of Total Results in the Standard view. 

 

 

  
 

Figure 4-41. Example of Total Results in the Cumulated view. 

 

 

 

Map view  

 

This type of view, available for logger files downloaded from Svantek instruments capable of 

collecting GPS data, allows the location of the measurement point to be displayed. The Map view 

requires Internet Explorer 10 or higher. 

 

 
  

Figure 4-42. Map view.  

Cumulate results on Cumulate results off 

Measurement results 

Displayed 
function 

Color 

scale 
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The data measured at different locations is plotted on a map downloaded from Google Maps. The 

measured result is displayed in the upper right corner of the Map view sub-window. The colours of 

the plotted points represent the measured values according to the colour scale displayed on the right 

side of the Map view sub-window. 

 

You can export the map with the measurement results as a picture to a Microsoft Word document 

using the  button on the View Toolbar. 

 

 

 

 

Other views         
 

 

There are several types of view sub-windows that display the results of specific types of 

measurements, such as: 

• Ln (10 statistical results that .svn files contain), 

• Tonality, 

• Loudness, 

• Meteorological or 

• RT60 

or recorded markers: 

• Alarms. 

  

These views can be displayed in Table or Text mode. 

 

 

 

4.3.3 ARRANGING THE WORKING AREA 
 

When several views are opened simultaneously in SvanPC++, the respective sub-windows can be 

arranged in the workspace in different ways. You can use the Window menu commands listed in Table 

4-1 to achieve the optimal arrangement. 
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Figure 4-43. Window menu commands. 

 
 

Table 4-1. Window menu commands serving for arrangement of sub-windows. 

 
Command  Function  

 

New Window 

 
 

 

− Creates a new window with the same data as the currently active 

window. 
 

Cascade − Arranges windows in an overlapping manner. 
 

Tile Horizontally 
 

− Causes the currently open windows to fill the entire workspace, tiled 

horizontally without overlapping. 

Tile Vertically 
 

− Causes the currently open windows to fill the entire workspace, tiled 

vertically without overlapping. 

Arrange Icons − Arranges only minimised sub-windows in the bottom left corner of the 

workspace. 

Auto arrange 

 

 
 

− Automatically arranges windows to use all the free space on the screen. 

When the Auto arrange tool is enabled,  /  icons appear in the top 

right corner of each sub-window. They can be used to lock the visibility of 

certain sub-windows. If the icon is as , that sub-window will remain 

visible when a new sub-window is opened. 

Common results 

window 

− Displays the results table, normally displayed below the plot window in 

the Plot view, as a separate window. 
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Comparison windows 

 

 

 

 

 
 

− Opens the Comparison window (Logger or Frequency), which allows the 

values of two or more functions from different windows (even different 

files) to be compared in a table. To use this tool: 

1. In the functions list, select the result you wish to compare. 

2. Press the right mouse button and select the Add selected functions to 

comparison window command from the pull-down menu. 

3. The function values are available for comparison in the table. 

Separate comparison windows are opened for Logger and Frequency type 

results. 

1, 2, ... 
− Allows you to select the active sub-window from the list of all currently 

open sub-windows. 

 

 

 
Figure 4-44. Using the results Comparison window.  

 

 

 

 
4.4 VIEW CONFIGURATOR 
 

The view Configurator allows you to select the results to be displayed in a Table, Plot or Text view.  

To show or hide it, use the  button on the View Toolbar (located at the top of each view sub-

window) or the View Configurator command from the View menu. It can also be dragged out of the 

right-hand edge of the sub-window by clicking on the Configurator button in the top right corner of 

the sub-window. 
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Figure 4-45. Selecting results displayed in a view with the use of the Configurator.  

 

 

There are two ways to select multiple results at once: 

• Selecting a result while holding down the CTRL key will select all available results of the same 

type. 

• Selecting a result and then another one in the same subtree with the SHIFT key held down 

will select all results in the subtree between these two results. 
 

Note: The same effect as using the CTRL key can also be achieved by turning on the Lock results option 

in the Options menu. 

 

 
Figure 4-46. Options menu. 

 

By default, the Configurator is displayed in a tree structure (Channel » Profile » Result). By activating 

the Options » Flat view command, it is possible to view the Configurator as a simple list that does not 

represent the structure of the data. It is also possible to select all the available data at once by 

selecting the Flat results check box. 
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Figure 4-47. The Configurator’s list in Flat mode. 

 

Note: The Limit time domain to and Clear time domain limit commands are described in 

Chapter 4.2.1. 

It is possible to save the Configurator settings for later use by pressing the  button. The settings 

are saved in a package that includes the selection of data to be displayed and the colours of the plots. 

To load saved Configurator settings, press the  button, select the settings from the list and click 

one of the commands on the right. 

 
Figure 4-48. The Configurator settings window. 

 

 

 

4.5 DISPLAYED RESULTS 
 

Most Svantek instruments measure a large number of results, which you cannot reduce in the 

instrument, and which appear in the Configurator panel. If you only need a few results for your 

purposes, you can set a filter for these results that will work for all opened files until you 

reconfigure it. 

 

To set such a filter, open the Main Options dialogue box, expand the Displayed results item and select 

Sound or Vibration. 
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In the Displayed results section, tick Enable and select result type filters, weighting filters and/or 

detectors to reduce the list of Available results below. 

Note: Selecting filters for result types, weighting filters and/or detectors is not mandatory. You can 

skip it. 

 

In the Available results section select results you wish to view and press the “>>” button. The selected 
result will be moved to the right section of Selected results. 

 
Figure 4-49. Selection of displayed results. 

 

Once all the required results have been selected, press OK. From this point on, only selected results 

will be visible in the Configurator. 

 

 
Figure 4-50. Filtered results in the Configurator. 
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If some result have been filtered when opening a data file, the programme will inform you. 

 

 
Figure 4-51. Information about filtered result functions. 

 

 

If there are active filters for the results displayed, the “funnel” icon will change its colour to green. 
Clicking it allows you to disable the Sound or Vibration filters, or all filters.  

 

 
Figure 4-52. Activation/deactivation of filters. 

 

 

 

 
4.6 AUDIO PLAYBACK 
 

The audio playback in SvanPC++ includes two main aspects: 

• Playback of the logger events, 

• Supporting WAVE files. 

The SvanPC++ tools that enable playback are the Events Navigator and the Wave Navigator. 

 

It is possible to select the device for the audio stream playback and the buffer length. To do this, open 

the Main Options dialogue box using the Tools » Main Options command or press the  button on 

the Main toolbar and go to the Playback section. 
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Figure 4-53. Audio playback settings in the Main Options dialogue box. 

 

 

 

4.6.1 EVENTS NAVIGATOR 
 

The Events Navigator appears at the top of the view sub-window when a file containing one or more 

audio events recorded during a measurement is opened. It consists of a set of buttons that allow you 

to manage the playback of the signal. The functions of these buttons are described in Table 4-2. 

 

 

  
 

Figure 4-54. Plot view with the Events Navigator. 

 

Events Navigator 
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Table 4-2 Buttons of the Events Navigator. 

 

Icon Function 

 

 

 

Play event / resume playback 

 
Pause playback 

 
Stop playback 

 

 

Jump to previous event 

(press this button and CTRL at the same 

time to go to the first event) 

 

 

Jump to next event 

(press this button and CTRL at the same 

time to jump to the last event) 

 
Show options (described below) 

 

The following options are available in the Events Navigator after pressing the Show options button: 

• The Gain slider allows you to set the level of amplification of the audio signal . 0 dB leaves the 

signal at its original level. 

• The Automatic Gain Control tool is used to automatically adjust the gain of the signal. When 

this option is enabled, fragments of audio data are constantly analysed in order to maximise 

signal dynamics, provided that the Maximum Level slider is left at 0 dB. The length of the 

analysed fragments can be set in Main Options » Playback » Buffer Length. The minimum 

value of the Maximum Level parameter depends on the bit depth of the signal, e.g. 144 dB for 

24 bit, 96 dB for 16 bit. Differences of less than 12 dB between consecutive fragments of audio 

data will not affect the boost level. The algorithm is designed to reduce the boost level faster 

than it increases it, to avoid sudden increases in loudness. 

• The Play event from beginning option changes the behaviour of the Play button so that the  

Main cursor is automatically moved to the beginning of the current event before playback 

starts. 

• The Synchronize All Views option allows the data selection tools to be moved simultaneously 

in all views containing the audio recording (consisting of the Main cursor in the Plot view and 

the selection bar in the Table view). 

• If the Play all events option is enabled, playback will automatically resume from the beginning 

of the next event when the end of the event is reached. Otherwise, it will stop. 

 

Note: In the case of multi-channel audio events, all the channels will always be played at the same 

time. 
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4.6.2 WAVE NAVIGATOR 
 

The Wave Navigator appears in the sub-windows if the Wave view. It consists of a set of buttons that 

allow you to manage audio playback. The functions of these buttons are described in Table 4-3. 

 

 
 

Figure 4-55. Wave view with the Wave Navigator. 

 

 

Table 4-3. Wave Navigator’s buttons. 

 

Icon Function 

 

 
 

 

Start/resume playback 

 

 
 

Pause playback 

 

 
 

Stop playback 

 
Show options (described below) 

 

The following options are available in the Wave Navigator after pressing the Show options button: 

• The Gain slider allows you to set the level of amplification of the audio signal. 0 dB leaves the 

signal at its original level.  

• The Synchronize All Views option allows the data selection tools to be moved simultaneously 

in all views containing the audio recording (consisting of the Main cursor in the Plot view and 

the selection bar in the Table view). 

• The Automatic Gain Control tool is used to automatically adjust the gain of the signal. When 

this option is enabled, fragments of audio data are constantly analysed in order to maximise 

signal dynamics, provided that the Maximum Level slider is left at 0 dB. The length of the 

Wave Navigator 
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analysed fragments can be set in Main Options » Playback » Buffer Length. The minimum 

value of the Maximum Level parameter depends on the bit depth of the signal, e.g. 144 dB for 

24 bit, 96 dB for 16 bit. Differences of less than 12 dB between consecutive fragments of audio 

data will not affect the boost level. The algorithm is designed to reduce the boost level faster 

than it increases it, to avoid sudden increases in loudness. 

• The Mix to mono option allows the signal from all channels to be mixed and played back 

equally on all output channels. 

• The Loop playback option causes the .WAV file to be played from the beginning again when 

the end of the file is reached. 

 

Note: For multi-channel WAVE files, only the selected channels (in the View Configurator) will be 

played. If the Mix to mono option is enabled, a single channel containing the sum of all selected 

channels is played. 
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5 POST-PROCESSING AND DATA ANALYSIS 

 

 

Besides the tools for data visualisation and playback described in Chapter 4, the basic SvanPC++ 

software package offers several possibilities for data post-processing, such as: 

• Editing logger contents, 

• Conversion of units, 

• Aggregation of data by time and frequency, 

• Using markers to select data, 

• Recalculation of various vibration parameters, 

• Converting the spectral data domain. 

In addition, some features of the Calculator tool are available in the basic SvanPC++ module, 

such as: 

• Total LEQ and Total RMS recalculation, 

• Transfer function and coherence recalculation with cross-spectrum result files. 

More data analysis tools are available after purchase of an additional module of SvanPC++, e.g. the 

Environmental Monitoring module. 

Note: All changes made during post-processing can be saved as a project (see Chapter 10). 

 

 

5.1 POST-PROCESSING TOOLS 
 

5.1.1 EDITING LOGGER CONTENTS 
 

it is possible to modify logger type data downloaded from a Svantek instrument. There are three ways 

to modify logger: delete, clip, shift. 

 

 
Figure 5-1. Editing logger contents. 

Deleted 

data 

Clipped 

data 

Shifted 

data 
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If no block selection has been made, the effects of editing will be on all data. If there is a block 

selection, the changes only affect the selected data. The Delete tool affects all the result functions in 

the selected time range, while the Clip and Shift tools only affect the visible result functions (thise 

selected in the View Configurator). 

• To delete data, select a time range (block) and press the  button, or right-click and select the 

Delete data command. 

 

There are two methods for deleting logger contents. After activating the Delete command, the Delete 

logger contents dialogue box will appear, allowing you to select the preferred method. 

 

 
 

Figure 5-2. Deleting logger contents dialogue box. 

 

 

Compress timebase means that after deleting data the remaining time segments are joined 

sequentially to the previous ones and the time axis is compressed. If you select insert breaks and 

mark deleted regions as a marker, the selected data will be deleted and the marker „Deleted data 

marker” will replace it on the time axis. In the last case, if start and/or end blocks are selected, they 

can be removed from the time axis. This means that the measurement virtually starts later and/or 

ends earlier. 

 

• Clipping means that all data above a specified threshold is clipped and the clipped values are 

replaced by the threshold level. To clip data, enter the threshold value in the field to the left of 

the  button and press this button. You can also right-click on the plot area, select the Clip 

data command and enter the threshold value in the dialogue box that appears. 

• Shifting means adding a constant positive or negative value to a range of data. To do this, first 

select a point or a range of data to be shifted using the main cursor or selection blocks. You can 

then enter the value to be added in the field to the left of the  button and press this button, 

or right-click on the plot area, select the Shift data command and enter the value to be added in 

the dialogue box that appears. 

All the changes can be undone by pressing the  button or selecting the Restore data to original 

command from the context menu. 

 

 

Note: The logger data will be modified for all available views. At the same time the source files remain 

unchanged, as SvanPC++ always works with temporary files. If you want to save the changes you have 

made, you can save them as a Project (see Chapter 10).  
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5.1.2 CONVERSION OF UNITS  
 

When visualising the data, you can easily recalculate logarithmic to linear and linear to logarithmic 

units. In the case of vibration results, it is also possible to display the values in linear non-metric units. 

 

The units available are shown in the table below. 

 
Table 5-1. Units for displaying SLM and VLM results available in SvanPC++. 

 

 
SLM results 

 

VLM results 

 

 

Acceleration 

 

 

Velocity 

 

 

Displacement 

 

 

Logarithmic 

 

 

[dB] 

 

 

[dB] 

 

 

[dB] 

 

 

[dB] 

 

Linear 

 

[Pa] 

 

[m/s2] 

 

[m/s] 

 

[m] 

 

Linear non-metric - [g] [ips] [mil] 

 

 

To select the units for the sound results, use the pull-down menu available in the View menu » SLM 

Units. To switch between units, you can also press the  button on the Main toolbar. 

 

Similarly, to select the units for the vibration results, go to View » VLM Units. Pressing the  button 

will also toggle between the available units. 

 

 

5.1.3 ZOOM AND AGGREGATION / ENVELOPING 
 

Zoom is used to stretch or compress the time axis.   

 

There are two algorithms for calculating stretched or compressed values, Aggregation or Envelope. 

In the case of aggregation, the program calculates the resulting value for a set of samples (sample 

group) resulting from the logger step according to the algorithms below. The enveloping algorithm 

selects the maximum/minimum value from the sample group. The algorithm can be toggled using the 

 button on the Toolbar showing the algorithm type:  or  .  

 

In the case of the Enveloping algorithm, values for all results are marked as “max:xx,xx”, indicating 

that the result is a maximum value. 
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In the case of Plot views, this is done by changing the number of pixels per sample (samples per pixel) 

or/and logger step and adjusting the amount of data displayed to the window width in relation to the 

cursor position. Table views mirror the Plot views but without fixing the cursor position (in the case 

of aggregation). For enveloping, the table displays the original data.  

 

Two buttons  /  on the Toolbar are used to Zoom in or Zoom out. The same effect can be 

obtained by right-clicking on the time axis (the special cursor appears). Moving the cursor to the left 

stretches the time axis (zoom in action ), while moving to the left compresses it (zoom out action 

).  

In the Plot view, the active button  on the Toolbar allows you to set the autoscaling options in 

the Auto scale x settings dialogue box. In this box you can set autoscaling to the whole data or just 

the selected period and to align the start of the measurement to a specific time. 

 

 
 

Figure 5-3. Setting the auto scale options. 

 

 

You can change the logger step manually in the Change logger step… dialogue box, which is opened 

with the  button on the Toolbar. If you select User in the end of the Logger step list, you can 

define a logger step in the Enter logger step selector. 

 

 
Figure 5-4. Setting the aggregation level manually. 

 

 

After pressing the  /  buttons, the pixel per sample ratio is displayed in the line of the file 

name: 
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If you have more than one viewing panel using the same data, you can apply the Aggregation to all 

panels at the same time by using the Zoom buttons in the Main Navigator. 

 

 
 

Figure 5-5. Zoom buttons of the Main Navigator. 

 

 

 
Aggregation algorithms for the basic functions 

 

The value of an aggregated sample is calculated from the set of original samples according to a 

formula selected based of the function type: 

 

Maximum value 

functions: Lmax, Max, Lpeak, Peak, max(Lmax), max(Max), max(Lpeak), max(Peak), max(Leq) 

 

Minimum value 

functions: Min, Lmin, min(Leq) 

 

Root mean square 

functions: RMS, aw, ahw, Leq, Lden, Ldn, Lday, Leve, Lnight, SEL, VECTOR, awv, ahv, Ltm3, Ltm5 

 

4-degree generalized mean 

function: VDV 

 

 

➢ All the calculations used for aggregation are performed on linear values. 

 

 

➢ Setting an aggregation level affects all the views of the current data except the Marked Periods 

Totals. 

 

➢ Zooming is performed according to the following rules: 

• Zooming is always performed on the entire time domain in the file. 

• The selection of blocks, in the configurator and in the time domain limiter tool, does not affect 

the aggregation. 

 

➢ Calculator actions are always performed on non-aggregated data, even if the current view shows 

data after aggregation. Sometimes the results of calculations cannot be displayed in aggregated 

mode. 

 

➢ The maximum aggregation available depends on the number of samples. 
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5.1.4 MARKERS 
 

Markers can be used as a data classification tool. They are binary functions defined in the time 

domain. A marker designates a certain range of data, either automatically specified or selected by 

the user. They can be stored in a file by a Svantek instrument or created by the SvanPC++ program. 

Note: This tool is particularly useful and applicable in the Plot view. However, markers can also be 

used in the other modes, e.g. for limiting the time domain in the Table view. For details on the 

visualisation modes in SvanPC++, see Chapter 4.2. 

 

 
Creating markers 

 

There are two types of markers: 

• Block markers, 

• Point markers. 

The block markers contain a finite range of data, while the point markers contain only one sample. 

 

To create a block marker: 

1. Make a block selection in the plot area by simply dragging the mouse with the left button pressed. 

Note: A block marker does not have to be continuous, i.e. it can consists of several separate areas. 

2. Right-click on the plot area to open a pull down menu and select Edit markers » Use selected 

blocks » New marker. 

3. In the Create New Marker dialogue box, enter the desired name and colour for the new marker. 

 

 
Figure 5-6. Creating a block marker. 

 

 

 

1 

2 

3 
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When creating point markers, instead of making block selections in the plot area, you simply place 

the Main cursor at the desired location (left click). The rest of the procedure is the same as for 

creating block markers, the only difference being the path in the pull-down menu: Edit markers » 

Point marker » New marker. 

 

Note: With the Environmental Monitoring module is enabled, you can also create markers according 

to complex criteria using the Blocks/markers generator (see Chapter 8.2.2). 
 
 

 
Markers visualization 

 

Block markers appear in the Plot view as horizontal lines below the plot area, above the X-axis. Point 

markers are also drawn as semi-transparent vertical lines. Each marker has its own colour, which is 

selected when the marker is created. 

 

The markers created are listed in the table below the plot. To show or hide a marker, click on its check 

box. 

 
Figure 5-7. Visualization of markers in the Plot view. 

 

 

Note: In the basic package of SvanPC++ some functions are locked. This is indicated by lock icons in 

some positions of the menu or views. If the Environmental Monitoring (EN) module is enabled, the 

lock icons disappear. 

 

Note: The SV 307 and SVAN 958AG instruments have additional information assigned to the markers, 

which appears in the tooltip when the cursor is placed on the marker. 

 

Click to 

hide/show 

markers on 

the plot 

Point marker Block marker 
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Figure 5-8. Marker information in case of file generated by the SV 307 instrument. 

 

 

If the EM module is enabled 

If the Show individual blocks option is enabled (see Chapter 4.2.2, paragraph Contents of the plot), all 

the individual areas of the block markers are also listed in the table. In this case you can use the  

buttons to remove areas of markers. To show/hide the separate areas of a marker, double-click on 

its name. 

In the Table view, markers are considered to be one of the functions available for display. You can 

select the values to be displayed in the table for data included/not included in the area of a marker 

using the Table View position in the Main Options. 

 

 

Editing markers 

 

A marker does not have to be continuous - it can consist of several unconnected continuous 

fragments. Such a single fragment is called a 'range' of the marker. 

 

To change the area of markers you can use the pull-down menu that opens when you right-click 

anywhere in a plot area when working in a Plot view. The following commands are available: 

• Edit markers » Use selected blocks » Add selection – adds the current block selection to a 

selected marker. 

• Edit markers » Use selected blocks » Remove selection – subtracts the current block selection 

from a selected marker. 

• Edit markers » Point marker » Add cursor position – adds the range of the current cursor 

position to a selected marker. 
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• Edit markers » Point marker » Remove cursor position – removes the area of the current cursor 

position from a selected marker. 

• Edit markers » Delete marker – deletes a selected block or point marker. 

 

Each time you modify or delete a marker, the Choose marker window appears. It is used to select the 

marker you want to modify or delete. You can select several markers by clicking on their names while 

holding down the CTRL key. You can also select several consecutive markers by clicking on the first 

and then the last while holding down the SHIFT key. 

 

 
Figure 5-9. The Choose Marker dialogue box. 

 

Note: A group of areas (ranges) can be selected to perform some operations on several markers at 

the same time. To select/deselect an area, click on it with the SHIFT key held down. You can also use 

the Add/remove marker range to/from selection to select/deselect areas. Selected areas are shown 

in black.  

 

You can easily modify ranges in the following ways: 

• Clicking with the left mouse button in the middle of a range and moving the mouse without 

releasing it will move the selected range within the time domain. When the mouse is in a 

position that allows a range to be moved, the name of the marker and the range number is 

displayed (Fig.5-10a). 

Note: If several ranges are selected, moving one of them automatically moves the whole 

group. 

• Left-clicking on one of the ends of a range and moving the mouse without releasing will 

change the size of the selected range. When the mouse is in a position that allows a marker 

range to be resized, the signs <<, >> are added to the name of the marker (Fig.5-10b). 

 

 
 

a) Clicking and moving mouse will move the range. 

 
 

b) Clicking and moving mouse will resize the range. 

 

Figure 5-10. Labels that appear when the mouse is in a position allowing 

for the modification of a marker range. 

 

Right-clicking on a marker range activates a pull-down menu containing the following commands (all 

of which can be applied to a group of selected ranges): 

• Open comment file – opens the comment file corresponding to the selected marker. 
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• Export event(s) – for markers that indicate the range of audio events, this command opens 

the Export Events dialogue box (see Chapter 6.4.1) and automatically selects the event 

corresponding to the selected marker. 

• Add marker range to selection – selects the range you clicked on. 

• Remove marker range from selection – deselects the range you clicked on. 

• Selected ranges to blocks – adds the selected ranges to the block selection on the plot. 

• Add selected ranges to another marker – adds the selected ranges to a selected marker. 

• Remove current range from marker – removes the range you clicked on from the marker to 

which it belonged. 

• Remove all selected ranges from marker – removes the selected ranges from a selected 

marker. 

 
 

Quick markers adding 

 

You can add markers using the right ALT + [0...9] convention. A new point marker of the named 

M[0...9] is automatically created at the current position of the Main cursor. 

 

If a marker of the selected number already exists, the sample selected with the Main cursor will be 

added to the selected marker. 

 

 
Special markers 

 

Some markers are created automatically and cannot be edited: 

• The Audio marker shows the time ranges containing audio data, if available in the currently 

displayed data. You can right-click on it and select Export event(s) to export the corresponding 

audio events (see also Chapter 6.4.1). 

• The Whole data marker contains the entire time domain. 

• The Pause or Break marker indicates the time ranges containing pauses or breaks, if they are 

present in the currently displayed data. 

• The Block selection marker indicates the current block selection. 

• The High vibration marker, generated by SV 104 units, indicates data fragments where the 

measured vibration level exceeds a threshold. 

• The Overload marker, indicates ranges of time when overload has occurred.  

Note: The Overload marker is set for a record if at least one of the results is overloaded, although 

some instruments append overload information independently for each type of result. 

Note: The Whole data marker and the Block selection marker are only available in the Table view. 

 

 

 
Global markers  

 

Global markers allow you to define markers that will always be visible in the program (you do not 

need to create them each time). 

They are defined in the Main Options dialogue box, where you can specify the marker name, colour 

and whether it is available on newly created views. 
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Figure 5-11. Global markers definition. 

 

 

If you check a marker, any newly created view will "see" that marker and you can quickly add blocks 

to that marker using Shift + x, where x is the marker number. 

 

If the marker is unchecked, but you want to use the marker in the view, you need to enable it by 

clicking on the Global marker settings icon. Once checked, the marker will be available in that view. 

 

 

 
Figure 5-12. Global markers selection. 
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Level+ marker  

 

In the currently open logger file, you can easily create a marker corresponding to the time ranges 

with high level using the Show trigger level+ marker parameters button located at the right end of 

the View Toolbar. 

 

 
 

Figure 5-13. Displaying Level+ markers in a Logger results view. 

 

The parameters related to the generation of the Level+ marker are available in the menu, as shown 

in the figure below. 

 
 

Figure 5-14. The Level+ marker generation parameters. 

 

• Threshold - minimum level to be taken into account in the analysis, 

• Minimum duration - allows for removal of all the generated Level+ marker ranges with 

durations less than the specified minimum duration, 
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• Smoothing samples - allows the measured level to be smoothed using a selected number of 

samples, 

• Remove distortions - if this option is enabled, the areas where an overload, underrange, high 

vibration level or force underrange marker occurs will be removed from the generated Level+ 

marker. 

 

 

 

5.1.5 ACCELERATION, VELOCITY AND DISPLACEMENT 
 

In the case of vibration spectrum measurement results, SvanPC++ offers the recalculation of three 

parameters: 

• Acceleration, 

• Velocity, 

• Displacement. 

 

This applies to files containing spectral data, e.g. 1/3 Octave results. 

 

To select the parameter to be displayed, use the pull-down menu that opens next to the VLM units 

selection button on the Main toolbar. 

 

 

 
 

Figure 5-15. Selection of the displayed VLM parameter. 

 

 

Acceleration, velocity and displacement can all be displayed simultaneously. In the Plot view, the 

respective parameters can be recognised in the result list below the plot by the addition of “Acc” for 

acceleration, “Vel” for velocity and “Dil” for displacement to the name of the result function. 

 

 
 

Figure 5-16. Functions list containing the same function for various VLM parameters. 

 

 

 

 

Click to open the menu 

Parameter selection 
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5.1.6 SPECTRUM RECALCULATION 
 

You can easily convert:  

• FFT spectrum to 1/3 octave, 1/6 octave or 1/12 octave spectrum, 

• 1/12 octave spectrum to 1/6 octave, 1/3 octave or 1/1 octave spectrum, 

• 1/6 octave spectrum to 1/3 octave or 1/1 octave spectrum, 

• 1/3 octave spectrum to 1/1 octave spectrum. 

 

If the FFT, 1/12 octave, 1/6 octave or 1/3 octave based results are available in the current data file, 

you can display the same results in a different domain by doing the following (as shown in the figure 

below): 

1. Switch to the Plot view by clicking on the  icon. 

2. In the Configurator, select the function(s) you wish to convert. 

3. Right-click on the list below the diagram to open the pull-down menu. 

4. Select the conversion option (Octaves 1/3, Octaves 1/1, ect.) from the Show results based on the 

selected functions menu. 
 

 
 

Figure 5-17. Recalculation of 1/1 octave spectrum from 1/3 octave spectrum. 

 

 

A new sub-window will open containing the converted data. 

 

Note: The same functionality is available in the Environmental Monitoring Calculator. It is realised by 

the Band Recalculation function (see Chapter 8.1.3). 
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Algorithmic details: Recalculating 1/x octave bands into wider octave bands 

 

The conversion of a 1/x octave band into a wider octave band consists of estimating each individual 

line of the output spectrum by summing the energy of several lines of the input spectrum according 

to the following formula: 
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where: 

iL'  – i -th line of the output spectrum, 

in  – first line of the input spectrum corresponding to the i -th output octave band, 

k  – number of lines summed together for one output octave band, 

nL  – n -th line of the input spectrum. 

 

The value of the parameter k  depends on the input and output octave bands; it is the result of 

dividing the output fractional octave by the input fractional octave, as in the following examples: 

• input = 1/3 octave, output = 1/1 octave, k  = 3; 

• input = 1/6 octave, output = 1/3 octave, k  = 2; 

• input = 1/12 octave, output = 1/3 octave, k  = 4. 

 

The lowest frequency used in the calculations is equal to the lower frequency bound of the octave of 

the output spectrum closest to the first octave of the input spectrum. 

 

The Total values are copied from the input spectrum. 

 

 

 
Algorithmic details: Recalculating FFT to 1/x octave bands 

 

The conversion of FFT spectra to 1/x octave spectra is similar to the conversion between different 

1/x octave spectra and consists of summing the energy of the FFT lines around the octave centre 

frequency according to the following formula: 
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where: 

iL'  – i -th line of the output spectrum, 

1,in , 2,in  – FFT lines covering the i -th octave band, 

nL  – n -th line of the input spectrum, 

fW  – FFT window factor (used only when the number of summed lines is greater than 1). 
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Note: The value of the parameter fW  is provided by a Svantek instrument together with 

the measurement results; for details, refer to the documentation of the files created by your 

instrument. 

 

The indices 1,in  and 2,in  of the FFT lines are found using the lower and upper frequency bounds of 

the i -th output octave band. 

 

The bandwidth of the octaves varies linearly with frequency, whereas the resolution of the FFT 

spectra is constant. Therefore, if the FFT resolution is low, the result of the conversion will be 

inaccurate for low frequency octaves. 

 

The Total values are copied from the input spectrum. 

 

 

 

 

5.1.7 NOISE RATING AND NOISE CRITERION 
 

If LZeq spectral data are available (e.g. 1/1 Octave LZeq results), the Noise Rating (NR) can be 

calculated according to ISO 1996 and the Noise Criterion (NC) can be calculated according to 

ANSI S12.2-1995 or ANSI S12.2-2008. 

To do this, use the Configurator as shown in the figure below. Select the “grid” option to display 
NR/NC curves or the “result” option to display the NR/NC value calculated for the current 
measurement data. 

 

  
 

Figure 5-18. Calculating the Noise Rating and Noise Criterion using the View Configurator. 

 

To select the standard used to calculate the NC, go to Main Options » Spectrum calculations, as shown 

in the figure below. 
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Figure 5-19. Selection of standard used for calculation of the Noise Criterion. 

 

 

 

 

5.2 CALCULATOR BASIC TOOLS  
 

SvanPC++ makes it possible to recalculate various functions, based on the measurement data 

downloaded from a Svantek instrument using the Calculator function.  

 

You can access to the Calculator via the Calculator pull-down menu, which can be opened by clicking 

on the  icon in the Main toolbar, or via the Tools » Calculator menu. 

 

The basic module of SvanPC++ allows the use of three Calculator functions: 

• Total RMS / Leq, 

• Dose / Exposure, 

• Analyser: wave. 

 

There are additional Calculator functions that are locked for the basic package. Before using these 

functions, the user should unlock optional modules. These functions are: 

• Building Acoustics (this function requires the Building Acoustics module to be enabled), 

• Analyser: time history (this function requires the Environmental Monitoring module to be 

enabled). 

 

If a type of recalculation is not supported for the currently open data, the corresponding command 

will be disabled. 

 

Clicking on a command associated with a Calculator function will display the Calculator dialogue box. 
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5.2.1 TOTAL RMS / LEQ 
 

The recalculations can be carried out as follows:  

1. Select the function(s) you wish to recalculate from the list on the left side of the Calculator 

dialogue box. To select a function, click the check box next to its name. 

Note: You can recalculate more than one function at a time. 

2. Select the measurement data to be recalculated. All available measurement channels and profiles 

are displayed in the Channels and profiles panel on the right-hand side of the dialogue box. The 

checked boxes correspond to the data for which the selected function is supported. 

3. Press the Calculate button. 

Note: The Parameters, Calculation period(s) are not available for configuration in the basic SvanPC++ 

package. 

 

The recalculation is performed on the current block selection made in the Plot view of the analysed 

data. To perform the calculation on all available data, remove the block selection. See Chapter 4.2.2 

for details on data selection. 

 

  
Figure 5-20. Calculator dialogue box for Total RMS / Leq recalculations. 

 

 

5.2.2 DOSE MEASUREMENTS 
 

The basic SvanPC++ package allows the calculation of several dosimetry results available for Acoustic 

and Vibration Dosimetry. To access the dosimetry calculation tools, use the Dose / Exposure 

command in the Calculator pull-down menu.  
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The calculation of the results using the Dose Measurements function can be performed as follows:  

1. Select the function(s) to be recalculated from the list on the left of the Calculator dialogue box.  

2. Select the channel and profile for the source measurement data. 

3. Select the data to be recalculated.  

4. Set parameters for some result functions. 

5. Select the period for the data to be considered. 

6. Press the Calculate button. 

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-21. Calculator dialogue box for Cross-spectra recalculations. 
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Figure 5-22. Calculated result functions. 

 

 

5.2.3 ANALYSER: TIME HISTORY (ENVIRONMENTAL MONITORING MODULE) 
 

This command opens the Environmental Monitoring Calculator, which allows many additional results 

to be recalculated based on what the instrument has already measured, see Chapter 8.  

 

Note: This tool becomes is after unlocking the EM module. 

 

 

 

5.2.4 ANALYSER: WAVE 
 

With a recorded signal in the .wav format, SvanPC++ can calculate most of the results measured by 

the instrument and even more. 

 

Note: This tool is available for .wav files created by Svantek instruments. For other .wav files, please 

contact the SVANTEK office. 

 

 

This can be done as follows:  

• Open the Analyser dialogue box by selecting the Analyser: wave item from the Calculator menu. 

• Press the  button and select the source of the wave signal from the Add source run dialogue 

box: Real-time stream, Current session, Project or PC filesystem. 
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Figure 5-23. Selection of the wave signal source. 

 

• Press the  button in the Results section and select the measurement result you wish to 

calculate in the Add results dialogue box. Press the ADD button at the bottom of the dialogue box. 

 

 
 

Figure 5-24. Selection of the measurement result. 

 

 

 

• After selecting the source and results, press the ANALYSE button. 
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Figure 5-25. Analyse dialogue box view. 

 

 

After the analysis, SvanPC++ shows the results calculated based on the data recorded in a .wav file. 

 

 
 

Figure 5-26. Results calculated with the use of Analyser: wave function. 
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5.2.5 BUILDING ACOUSTIC 
 

This command opens the Building Acoustics Calculator tool, which allows many additional results to 

be recalculated based on measurements already taken by the instrument, see Chapter 11.  

 

Note: This tool becomes available after the BA module has been unlocked. 

 

 

 

5.2.6 VIEWING CALCULATED RESULTS 
 

When a recalculation is performed, the results are automatically displayed in the current view. They 

are also listed in the Configurator view, allowing them to be hidden or shown, where they can be 

recognised by the addition of “Calc.” to their names (see figure below). 

 

In the Plot view, the calculated results are displayed in the table below the plot area, next to the 

measured results. As with the other results, you can decide whether to display them or not using the 

 /  icons. 

 

  
 

Figure 5-27. Plot view with calculated functions and the Configurator. 

 

 
Calculated results sub-window 

 

To manage the results of calculations, you can use the Calculated results sub-window, which can be 

opened in two ways: 

• Using the Calculated results button in the lower left corner of the Calculator dialogue box, 

• using the Show calculation parameters command, available after right-clicking on a calculated 

result in the table below the graph (shown in the figure below). 

 

Calculated function 



                                                                                     SvanPC++ User Manual   

 

89 

  

 

   
 

 

Figure 5-28. Calculated Results sub-window. 

 

 

All calculated results listed at the left side of the window are grouped by calculation modules, 

measurement channels, profiles and type of source data. 

 

By selecting a result, you can view the parameters used for its calculation in the panel on the right of 

the window. 

 

You can also delete a selected result or all results using the Delete / Delete All buttons at the bottom 

of the window. 
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Pressing the Show button switches to the Plot view, closes the Calculated Results sub-window and 

highlights the selected result so that it can be recognised amongst all the plotted functions. 

 

If the Calculated Results sub-window was opened directly from the Calculator window, you can return 

to the Calculator by pressing the Calculator button located in the lower left corner of the window. 

 

 

 

 

5.3 DOSE MEASUREMENTS FORMULAE 
 

 

5.3.1 ACOUSTIC DOSIMETRY 
 
PSEL 

 

The PSEL result (Personal Sound Exposure Level to the noise) is equal to the standing sound level in 

a measurement period. It is calculated on the basis of the Leq according to the formula: 𝑃𝑆𝐸𝐿 = 𝐿𝑒𝑞 + 10 ∙ log 𝑇𝑇8h  

where: 

T - current measurement time, 

T8h - period equal to 8 hours (28 800 seconds). 

 

Note: When this result is measured with a specific filter and detector, it is referred to by the acronym 

"PLx(y)e" instead of "PSEL", where: 

x is the filter type: A, C, Z, B or G. 

(y) is the detector type: I (impulse), F (fast) or S (slow), provided only for exponential integration. 

 
LEPd 

 

The LEPd result is used to calculate the total noise exposure of an employee at work, considering the 

average sound level (Leq) and the amount of the time spent in the noise exposure area. 

 

Parameters 

• Exchange rate [dB] - specifies the amount of acceptable sound level increase when the exposure 

time is halved. 

• Exposure time - specifies the amount of time spent in the noise exposure area. 

 

Note: If you select the Exposure time according to calculation period option, the exposure time will 

be set to the length of the data period selected in the Calculation period(s) tab. Otherwise, the value 

can be entered manually. 

 
DOSE 

 

The DOSE result is the amount of noise received by the worker, expressed as a percentage of the 

acceptable daily value. This result is calculated using the formula: 
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𝐷𝑂𝑆𝐸 = 100%𝑇8ℎ ∫ 10𝐿𝑑(𝑡)−𝐿𝑐𝑞 𝑑𝑡𝑇0   

where: 𝑇8ℎ – period equal to 8 hours (28 800 seconds), 𝑇 – current measurement time 𝐿𝑑(𝑡) – sound level (as a function of time) depending on the threshold level 𝐿𝑐  – criterion sound level 𝑞 = { 𝑄log2    for 𝑄 ≠ 310       for 𝑄 = 3  𝑄 – exchange rate in decibels 

 

Parameters 

• Threshold level [dB] - the LT value, affecting the Ld(t) value according to the following formula: 𝐿𝑑(𝑡) = {𝐿(𝑡)  for 𝐿(𝑡) ≥ 𝐿𝑇−∞   for 𝐿(𝑡) < 𝐿𝑇  

• Criterion level [dB] - the LC value used in the DOSE calculation formula. 

• Exchange rate [dB] - Q value used to define the q parameter value in the DOSE calculation formula. 

 
 

DOSE_8h 

 

The DOSE_8h result is the amount of noise received by the worker during 8 hours. It is calculated 

using the formula: 𝐷𝑂𝑆𝐸8ℎ = 100%𝑇 ∫ 10𝐿𝑑(𝑡)−𝐿𝑐𝑞 𝑑𝑡𝑇0 = 𝑇8ℎ𝑇 ∙ 𝐷𝑂𝑆𝐸  

 
Exposition 

 

The E (Exposition) result is the amount of the acoustic energy received by the worker. It is calculated 

using the formula: 𝐸 = 𝑇[𝑠]3600 𝑝02 ∙ 10𝐿𝑒𝑞10   

where: 

T[s] - current measurement time in seconds,  

p0 - reference value equal to 20 μPa. 
The E result is expressed in linear units (Pa2h). 

 
PCTC 

 

The PCTC result (Peak C Threshold Counter) is the number of times the THRESHOLD LEVEL is exceeded 

by the PEAK_C result (PEAK measured with C weighting filter). This result is incremented at 100 ms 

intervals. 

 
PCTP 

 

The PCTP result is the PCTC result expressed as a percentage according to the formula: 𝑃𝐶𝑇𝑃 = 100∙𝑃𝐶𝑇𝐶10𝑇𝑐   

where Tc is the integration period. 
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5.3.2 VIBRATION DOSIMETRY 
 
max(Max) 

 

max(Max) is the maximum value of the Max results for the calculation period. 

 
max(MTVV) 

 

max(MTVV) is the maximum value of the MTVV (Maximum Transient Vibration Value) results for the 

calculation period. 

 
max(Peak) 

 

max(Peak) is the maximum value of the Peak results for the calculation period. 

 
VDV 

 

The VDV function is calculated using the measured VDV values. The result function is monotone. 

 
Current dose 

 

The Current dose is a measure of vibration dose, calculated using the measured VDV values according 

to the formula: 

 𝐶𝐷𝑜𝑠𝑒 = max {1.4 𝑉𝐷𝑉𝑥 , 1.4 𝑉𝐷𝑉𝑦, 𝑉𝐷𝑉𝑧}  

where 𝑉𝐷𝑉𝑥 , 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧  denote the measurement results from different channels. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

• Exposure time - this parameter cannot be changed as the function value is calculated 

independently for each instant. 

• Reference time - this parameter is permanently set to 8h. 

 
Daily dose 

 

The Daily dose is a measure of the vibration dose during a specified exposure time, related to an 8-

hour period, according to the formula: 𝐷𝐷𝑜𝑠𝑒 = max {1.4 𝑉𝐷𝑉𝑥 , 1.4 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧} ∙ √𝑇𝐸𝑇4
  

where: 𝑉𝐷𝑉𝑥 , 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧  denote the measurement results of different channels, 𝑇𝐸 – exposure time, 𝑇 – measurement time. 

 



                                                                                     SvanPC++ User Manual   

 

93 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

• Exposure time - specifies the time spent in the noise exposure area. 

Note: If you select the Exposure time according to calculation period option, the exposure time 

will be set to the length of the data period selected on the Calculation period(s) tab. Otherwise 

the value can be entered manually. 

• Reference time - this parameter is permanently set to 8h. 

 
Current exposure 

 

The Current exposure is a measure of vibration dose in relation to a selected time period, calculated 

according to the formula: 𝐶𝐸𝑥𝑝 = max {1.4 𝑅𝑀𝑆𝑥 , 1.4 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧} ∙ √ 𝑇𝑇0  

where: 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels, 𝑇0 – reference time, 𝑇 – measurement time. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

• Exposure time - this parameter cannot be modified because the function value is calculated for 

each moment independently. 

• Reference time. 

 
Daily exposure 

 

The Daily exposure is a measure of vibration dose during a specified exposure time in reference to a 

selected time period, according to the formula:  𝐷𝐸𝑥𝑝 = max {1.4 𝑅𝑀𝑆𝑥 , 1.4 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧} ∙ √𝑇𝐸𝑇0   

where: 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels, 𝑇0 – reference time, 𝑇𝐸 – exposure time. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 
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Parameters 

• Channels (1-3 or 4-6). 

• Exposure time - specifies the time spent in the noise exposure area. 

Note: If you select the Exposure time according to calculation period option, the exposure time 

will be set to the length of the data period selected on the Calculation period(s) tab. Otherwise 

the value can be entered manually. 

• Reference time. 

 
EAV total time 

 

The EAV total time result is calculated using the measured VDV or RMS values and the EAV value set 

in the Parameters tab. For the Whole-Body EAV, the EAV value can be set in m/s2 or m/s1.75 units. 

Note: Depending on the measurement profiles of the analysed data, Hand-Arm EAV or Whole-Body 

EAV recalculation is available. 

 

Hand-Arm EAV total time 

The Hand-arm EAV total time result is calculated using the formula: 𝐸𝐴𝑉𝑇𝑇 = 𝑇0 (𝐸𝐴𝑉𝐴𝐸𝑄)2
  

where: 𝐴𝐸𝑄 = √𝑅𝑀𝑆𝑥2 + 𝑅𝑀𝑆𝑦2 + 𝑅𝑀𝑆𝑧2, 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels, 𝐸𝐴𝑉 – Exposure Action Value (adjustable), 𝑇0 – reference duration of 8h (28 000 s). 

 

Whole-Body EAV total time 

The Whole-Body EAV total time result can be calculated in two different ways depending on the EAV 

unit selected (m/s2 or m/s1.75): 

 

If the EAV is expressed in m/s2, the Whole-Body EAV total time result is calculated using the formula:  𝐸𝐴𝑉𝑇𝑇 = 𝑇0 ( 𝐸𝐴𝑉𝑅𝑀𝑆𝑊𝐵)2
  

where: 𝑅𝑀𝑆𝑊𝐵 = max {1.4 𝑅𝑀𝑆𝑥 , 1.4 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧}, 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels, 𝐸𝐴𝑉 – Exposure Action Value (adjustable), 𝑇0 – reference duration of 8h (28 000 s). 

 

If the EAV is expressed in m/s1.75, the Whole-Body EAV total time result is calculated using the 

formula:  𝐸𝐴𝑉𝑇𝑇 = 𝑇 ( 𝐸𝐴𝑉𝑉𝐷𝑉𝑊𝐵)4
  

where: 𝑉𝐷𝑉𝑊𝐵 = max {1.4 𝑉𝐷𝑉𝑥 , 1.4 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧}, 𝑉𝐷𝑉𝑥 , 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧  denote VDV measurement results from different channels, 𝐸𝐴𝑉 – Exposure Action Value (adjustable), 𝑇 – measurement time. 
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The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

• Reference time - the T0 parameter used in the formulas. 

• Standard - You can select one of the available standards to automatically set the appropriate EAV 

and ELV, or select the User option to enter the values manually. 

 
EAV time left 

 

The EAV time left result is calculated from the EAV Total Time result (see above) according to the 

formula: 𝐸𝐴𝑉𝑇𝐿 = 𝐸𝐴𝑉𝑇𝑇 − 𝑇  

where: 𝐸𝐴𝑉𝑇𝑇  – EAV total time, 𝑇 – measurement time. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

• Reference time - the T0 parameter used in the formulae. 

• Standard - You can select one of the available standards to automatically set the appropriate EAV 

and ELV or select the User option to enter the values manually. 

 

Note: Depending on the data analysed, Hand-Arm or Whole-Body EAV calculation is available. 

Parameters of the unavailable option are greyed out. In the case of Whole-Body EAV calculations, it 

is also possible to select the unit (m/s2 or m/s1.75). 

 
ELV total time 

 

The ELV total time result is calculated using the measured VDV or RMS values and the ELV value set 

in the Parameters tab. In the case of the Whole-Body ELV, the ELV value can be set in m/s2 or m/s1.75 

units. 

Note: Depending on the measurement profiles of the analysed data, Hand-Arm ELV or Whole-Body 

ELV recalculation is available. 

 

Hand-Arm ELV total time 

The Hand-arm ELV total time result is calculated according to the formula: 𝐸𝐿𝑉𝑇𝑇 = 𝑇0 (𝐸𝐿𝑉𝐴𝐸𝑄)2
  

where: 𝐴𝐸𝑄 = √𝑅𝑀𝑆𝑥2 + 𝑅𝑀𝑆𝑦2 + 𝑅𝑀𝑆𝑧2, 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels, 
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𝐸𝐿𝑉 – Exposure Limit Value (adjustable), 𝑇0 – reference duration of 8h (28 000 s). 

 

Whole-Body ELV total time 

The Whole-Body ELV total time result can be calculated in two different ways, depending on the ELV 

unit selected (m/s2 or m/s1.75): 

 

If ELV is expressed in m/s2, the Whole-Body ELV total time result is calculated using the formula:  𝐸𝐿𝑉𝑇𝑇 = 𝑇0 ( 𝐸𝐿𝑉𝑅𝑀𝑆𝑊𝐵)2
  

where: 𝑅𝑀𝑆𝑊𝐵 = max {1.4 𝑅𝑀𝑆𝑥 , 1.4 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧}, 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels, 𝐸𝐿𝑉 – Exposure Limit Value (adjustable), 𝑇0 – reference duration of 8h (28 000 s). 

 

If ELV is expressed in m/s1.75, the Whole-Body ELV total time result is calculated using the formula:  𝐸𝐿𝑉𝑇𝑇 = 𝑇 ( 𝐸𝐿𝑉𝑉𝐷𝑉𝑊𝐵)4
  

where: 𝑉𝐷𝑉𝑊𝐵 = max {1.4 𝑉𝐷𝑉𝑥 , 1.4 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧}, 𝑉𝐷𝑉𝑥 , 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧  denote VDV measurement results from different channels, 𝐸𝐿𝑉 – Exposure Limit Value (adjustable), 𝑇 – measurement time.  

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

• Reference time - the T0 parameter used in the formulae. 

• Standard - You can select one of the available standards to automatically set the appropriate EAV 

and ELV or select the User option to enter the values manually. 

 
ELV time left 

 

The ELV time left result is calculated from the ELV Total Time result (see above) according to the 

formula:  𝐸𝐿𝑉𝑇𝐿 = 𝐸𝐿𝑉𝑇𝑇 − 𝑇  

where: 𝐸𝐿𝑉𝑇𝑇  – ELV total time, 𝑇 – measurement time. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 
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Parameters 

• Channels (1-3 or 4-6). 

• Reference time - the T0 parameter used in the formulas. 

• Standard - You can select one of the available standards to automatically set the appropriate EAV 

and ELV or select the User option to enter the values manually. 

 

Note: Depending on the data analysed, Hand-Arm or Whole-Body ELV calculation is available. 

Parameters of the unavailable option are greyed out. In the case of Whole-Body ELV calculations, it 

is also possible to select the unit (m/s2 or m/s1.75). 

 
AEQ 

 

The AEQ (Acceleration Equivalent Level) result is used in the Hand-Arm vibration dosimetry 

calculations. It is calculated using the formula: 𝐴𝐸𝑄 = √𝑅𝑀𝑆𝑥2 + 𝑅𝑀𝑆𝑦2 + 𝑅𝑀𝑆𝑧2  

where 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

 
VECTOR 

 

The VECTOR result is calculated using the Total RMS data from several channels according to the 

formula: VECTOR𝑘 = 10 ∙ log (√∑ 𝑘𝑛𝑇𝑜𝑡𝑎𝑙𝑅𝑀𝑆𝑘,𝑛2𝑛 )  

where: 𝑛 – channel number, 𝑘 – sample index in a given data set. 

 

The kn coefficients can be adjusted in the Parameters tab. 

In this function, the selection of Channels and Profiles is disabled. The channels used can be selected 

in the Parameters tab. 
 

Parameters 

• Vector coefficients – allows you to select the channels to be used for recalculations by checking 

their controls and adjusting their coefficients. 

Note: At least one channel must be selected for calculation. 

 

 
MaxRMS 

 

The MaxRMS result is used in Whole-Body vibration dosimetry calculations. It is calculated using the 

formula: 
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𝑀𝑎𝑥𝑅𝑀𝑆 = max {1.4 𝑅𝑀𝑆𝑥 , 1.4 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧}  

where 𝑅𝑀𝑆𝑥 , 𝑅𝑀𝑆𝑦, 𝑅𝑀𝑆𝑧 denote RMS measurement results from different channels. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 

 
MaxVDV 

 

The MaxVDV result is used in Whole-Body vibration dosimetry calculations. It is calculated using the 

formula: 𝑉𝐷𝑉𝑊𝐵 = max {1.4 𝑉𝐷𝑉𝑥 , 1.4 𝑉𝐷𝑉𝑦, 𝑉𝐷𝑉𝑧}, 

where 𝑉𝐷𝑉𝑥 , 𝑉𝐷𝑉𝑦 , 𝑉𝐷𝑉𝑧  denote VDV measurement results from different channels. 

 

The Channels and Profiles selection is not available for this function as it is calculated using the results 

of measurements in all three directions simultaneously. However, you can choose to use channels 

1-3 or 4-6 in the Parameters tab. 

 

Parameters 

• Channels (1-3 or 4-6). 
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6 DATA EXPORT 

 

 

6.1 MICROSOFT EXCEL 
 

You can use the Send to MS Excel command to export the displayed data directly to a Microsoft Excel 

worksheet: 

 

 

  
 

Figure 6-1.  Exporting data from Table view to Microsoft Excel. 

 

1. Click on the  icon to switch to the Table view by. 

2. Select the data you want to export. 

3. Press the  /  button located on the view toolbar. 

4. If you are using this tool for the first time, the Send To Microsoft Excel dialogue box will appear, 

allowing you to configure the export settings. 

 

In the left panel of the Send To Microsoft Excel dialogue box, you can select the target Microsoft Excel 

worksheet. All currently open worksheets are displayed in the list. The New Worksheet option allows 

you to create a new Microsoft Excel worksheet for the exported data. 

 

On the right-hand side of the window, you can choose to paste the data from the first free column in 

the worksheet, the first free row or the currently selected cell. You can also decide whether the Table 

header or Header information should also be copied. 

Table view Send to MS Excel 1 

2 

Data 
selection 

3 
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Figure 6-2.   Configuration of data export to Microsoft Excel settings. 

 

If you check the Remember these choices and don’t ask again box, the next export is performed with 

the same settings in the Send To Microsoft Excel dialogue box, and this box will not appear. The same 

effect can be achieved by selecting the Use Last Settings command from the pull-down menu next to 

the  icon. 

 

 
 

Figure 6-3.  Saving the last settings for later data exports to Microsoft Excel. 

 

• The Ask For Settings command means that the export settings must be configured. This 

command restores the  icon. 

• The Use Last Settings command means that the last export settings are saved and the Send To 

Microsoft Excel dialogue box is not displayed. This command restores the  icon. 

 

After exporting, Microsoft Excel will automatically open with the selected data pasted into the 

worksheet.  If the amount of data exceeds the limit of the number of rows or columns in Microsoft 

Excel, the data will be split into more than one worksheet. 

 

Note: In the Plot view, you can export data from the bottom table by pressing the  /  icon. 
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6.2 MICROSOFT WORD 
 

Results in text or image form can be exported directly to Microsoft Word using the next steps. 

 

 

  
 

Figure 6-4.  Exporting data from Plot view to Microsoft Word. 

 

1. Switch to the desired view mode, e.g. Plot or Table view. 

2. Configure the exported data: 

a. In the case of a table, select the cells to be exported. 

b. In the case of a plot, use the customisation tools as described in Chapter 4.2.2 to obtain the 

desired visualisation. The entire sub-window will be copied unchanged to Microsoft Word, 

including the tables above and below the plot area. 

3. Press the  /  button on the view sub-window toolbar. 

4. If you are using this tool for the first time, the Send To Microsoft Word dialogue box will appear, 

allowing you to configure the export settings. 

 

Note: The Logger and Merged views cannot be exported to Microsoft Word in table form, only as 

plots. Pictures are exported as Windows metafiles. 

 

View 
configuration 

View mode selection Send to MS Word 1 

2 

3 
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Figure 6-5.  Configuration of data export to Microsoft Word settings. 

 

In the left panel of the Send To Microsoft Word dialogue box, you can select the target Microsoft 

Word document. All currently open documents are displayed in the list. The New Document option 

allows you to create a new Microsoft Word document for the exported data. 

 

On the right-hand side of the window, you can choose to insert data at the end of the current 

document (Insert at document end) or at the current cursor position in the open document (Insert at 

cursor position). You can enable automatic selection of the newly pasted data in Microsoft Word 

(Select inserted data). 

 

If you check the Remember these choices and don’t ask again box, the next time you export, the same 

settings will be used in the Send To Microsoft Word dialogue box, and this box will not appear. The 

same effect can be achieved by selecting the Use Last Settings command from the pull-down menu 

next to the  icon. 

 

 
 

Figure 6-6.  Saving the last settings for later data exports to Microsoft Word. 

 

• The Ask For Settings command means that the export settings must be configured. This 

command restores the  icon 

• The Use Last Settings command means that the last export settings are saved and the Send To 

Microsoft Word dialogue box is not displayed. This command restores the  icon 

 

After the export, Microsoft Word will be automatically opened with selected data pasted to the 

selected document. 
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6.3 CSV FORMAT 
 

SvanPC++ also supports data export in CSV (Comma Separated Values) format. To save the currently 

opened data to a .csv file, use the Save Current View command from the File menu. After activating 

this command, the Save current view dialogue box appears, where you can select the name and 

location of the .csv file created. 

 

To configure the format of the exported CSV data, open the Main Options dialogue box using the  

button on the Main toolbar or use the Main options command from the Tools menu and go to 

Formatting values tab. 

 

Note: These settings also have an effect on the way numbers are displayed in SvanPC++. 

 

 

 
Figure 6-7.  Configuration of the formatting of data exported as .csv files. 

 

This dialogue box allows you to configure the following settings: 

• Format (Fixed-point / Scientific) and precision (1-5) of the displayed linear and frequency values, 

• Enable / disable the Center to decimal point in table view option, 

Note: This option sets the position of linear values in cells so that the decimal point is in the centre 

of the column. Otherwise, the numbers in cells are aligned horizontally. 

• Sign used as decimal separator in all displayed numbers (. / , / system default), 

• Precision of display of logarithmic values (dB resolution) as 0.1dB / 0.01dB. 

Note: The display resolution does not affect the accuracy of the calculations, 

• Symbol used as field separator in CSV output data (; / : / . / , / tabulator / space). 

 

Main options 1 

2 
Configuration 
of CSV output 

settings 

Configuration 
of ASCII output 

settings 
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6.4 AUDIO EXPORT 
 

SvanPC++ supports exporting audio data from files with the formats used by Svantek instruments to 

the files of commonly used formats, for example WAV format. At the same time, SvanPC++ can create 

a new logger file from the file containing audio event records, but with or without some of them. This 

type of file export is called Strip Events. 

 

6.4.1 EXPORTING LOGGER EVENTS 
 

To export the events contained in the active logger view, use the File » Export » Logger events 

command. 

After activating this command, the Export Events dialogue box appears. The logger events available 

in the current data are listed in the upper part of the window. You can specify the destination 

directory for the output WAV files by clicking on the  icon next to the Path field. 

To export the events as WAV files, press the Export button at the bottom of the window. 

 
 

Figure 6-8.  Export Events dialogue box. 

 

You can select the events you wish to export using the checkboxes in the Export column, or the Select 

all and Select none buttons. It is also possible to select events by length. To do this, specify a minimum 

and/or maximum length and press the Select by length button. 

To configure more detailed export settings, press the Advanced >> button. 

 

  
Figure 6-9.  Advanced settings of the Export Events dialogue box. 

Available 
events list 

Wave export 
settings 

Press to export events Press to show more settings 



                                                                                     SvanPC++ User Manual   

 

105 

The available settings are: 

• Filename prefix – a string of characters with which the output file name will begin, 

• Naming convention – select whether to append the event number or start time to the file name, 

• Output Files Format – the format of the output file, 

Note: Currently only the WAV file format is supported. 

• Settings – Wave parameters settings (Compression, Sampling Rate [Hz], Channels, Bits Per 

Sample), 

• Gain control – select whether to use no gain, constant gain or the Automatic gain control smart 

gain mechanism, 

Note: For more information on SvanPC++ audio signal boosting, see Chapter 4.6.1. 

• Play – play the last selected audio event. 

 

You can also create a new logger file containing only some of the audio events present in the original 

file. Use the Export » Strip Events command from the File menu to open the Strip events from logger 

file window. 

 

 
Figure 6-10.  Strip events from logger file dialogue box. 

 

Select the audio events you want to remove from the logger file using the checkboxes in the Remove 

column of the table at the top of the window. Press the Export button to create a new logger file with 

the selected events removed. 

 

It is also possible to select events by length. To do this, enter the minimum and/or maximum length 

and press the Select by length button. 

 

You can also use the selector in the lower left corner of the window to choose between no signal 

amplification, constant level amplification or the Automatic gain control smart signal amplification 

mechanism (see Chapter 4.6.1 about the Events Navigator). 

 

Select events 
to be removed 
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6.4.2 EXPORTING WAVE FILES 
 

Although Svantek files with a recorded signal have the.wav extension, they are not compatible with 

standard programs for processing .wav files. This is because they have a special header. To make 

these files compatible, it is necessary to create new files (export) without the header. 

 

To export .wav files from wave data opened in SvanPC++, use the File » Export » Wave command. 

 

After activating this command, the Export wave dialogue box appears. The audio channels available 

in the current data are listed in the upper left part of the window. You can set the target filename 

and directory for the output WAV files by clicking on the  icon next to the Filename field. 

 

 
 

 

Figure 6-11.  Export wave dialogue box. 

 

You can select a set of channels to export and the WAV tag format. The EXTENSIBLE format should 

be used, especially if the Bits per sample parameter exceeds 16 bits, unless the device or software 

that is to handle the exported files supports only the standard PCM format. 

 

You can also choose whether want to use no boost, constant level boost or Automatic gain control 

smart boost mechanism. For more information on SvanPC++ audio signal boost, see Chapter 4.6.1. 

 

The Manual range control option, also available in the list-box related to gain options (Figure 6-11), 

allows the wave signal to be scaled according to manually specified range values for each channel 

separately. This can be useful in the case of .wav files generated by different instruments where 

ranges in certain channels do not match—in such case, you can use the Manual range control to scale 

the ranges in order to be able to compare values stored in different .wav files. When this option is 

selected, double-click on a channel name in the list located in the top left-hand corner of the window 

to open the Edit wave range dialogue box, where you can specify a new range for the selected 

channel. 

Press to export wave files with configured settings 

Wave format 
settings 

Target filename 
and directory 

List of available 
audio channels  

Uncheck to 
mix channels 

to mono 

Gain options 
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Figure 6-12.  The Edit wave range dialogue box. 

 

By default, selected channels are exported to separate files. You can choose to mix all channels into 

one mono channel by unchecking the Export each channel individually as new file option. 

To export the wave files, press the Export button located at the bottom of the window. 

 

 

6.5 USING THE CLIPBOARD 
 

Data can also be easily exported from SvanPC++ using of the clipboard. 

 

6.5.1 COPYING TABLE VIEW CONTENTS 
 

You can export the contents of Table view to a text editor application using the clipboard by doing 

the following: 

1. In the Table view, select the data you want to export. 

2. Right-click on it to open a pull-down menu. 

3. Select the Copy or Copy with headers command. 

4. Go to the text editor application and use the Paste command. 

 
 

Figure 6-13.  Copying the Table view contents using the clipboard. 

 

The Copy with headers option includes the grey header cells in the copied data. 
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6.5.2 COPYING TEXT VIEW CONTENTS 
 

The contents of a text view can be easily copied to a text editor application, as is done in all text 

editors. To do this: 

1. Select the data to be copied. 

2. Left-click on it. 

3. Without releasing the mouse button, drag the selection to the text editor application. 

4. Drop the selection into the destination document. 

 

 
 

Figure 6-14.  Using the drag & drop technique to export the contents of Text view. 

 

 

6.6 SVU Export 
 

The .svu files (user files) can contain various types of data. You can export data to an .svu file using 

the Export commands from the File menu. 

 

 
 

Figure 6-15. Exporting data as .svu files. 

 

In the Export type selection dialogue box that opens, select the command: 

• Export data from current session to save all measurement results and calculated functions in 

the form of an .svu file.  

• Exporting visible data from current view to save only the data displayed in the currently active 

view in the form of an .svu file. 
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7 OTHER FEATURES 

 

 

7.1 TOOLBAR CUSTOMISATION 
 

SvanPC++ is operated using of the Main Toolbar and toolbars dedicated to different views. 

 

The Main Toolbar is displayed at the top of the SvanPC++ application window, below the menu bar. 

It provides quick access to many of the tools used in SvanPC++. When you start SvanPC++ without 

opening a file, the tollbar contains a maximum of seven basic functions. The content of the Main 

Toolbar is automatically expanded when you open any SvanPC++ compatible file. 

 

 
 

 
 

Figure 7-1. Basic and extended Main Toolbar. 

 

You can configure the Main Toolbar using of the pull-down menu that opens with the arrow at the 

end of the toolbar. To add or remove a button, simply check or uncheck it. For example, in the figure 

below, the About… button is unchecked and is not displayed on the toolbar. 

 

 
 

Figure 7-2. Toolbar configurator dialogue box. 

 

 

You can use the Reset Toolbar command to return to default settings. 

 

All the buttons available on the Main Toolbar are described in the table below. 

 
Table 7-1. Buttons available for displaying on the Main Toolbar. 

 

Icon 

 

Name 

 

Function 

 

 
New Window − Opens another window for the active document. 
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Open / Add file − Opens an existing document / adds a file. 

 
New Project − Creates a new Svan project. 

 
Save file − Saves the current document. 

 
Save current view − Saves the current view as a file. 

 
Print − Prints the current document. 

 
Cut − Cuts the selection and places it in the clipboard. 

 
Copy − Copies the selection to the clipboard. 

 
Paste − Pastes the clipboard contents. 

 

Show / hide instrument 

wizard 

− Displays / hides the Instrument wizard dialogue 

box. 

 
SVAN Files 

− Accesses internal SVAN files. Opens the Svan file 

view. 

 

 

Communication (group) 

 

− Gives access to SVAN Files, Remote 

Communication Center and Connection 

Configuration Wizard. 

 
Calculator − Gives access to Calculator functions. 

 

 

Blocks/markers generator 

 

− Opens the Blocks/markers generator dialogue box 

(only available if the Environmental Monitoring 

module is activated). 

 
AI sound classification 

− Allows you to identify and classify sound sources 

using artificial intelligence. 

 
Change SLM units 

− Allows you to select units for displaying SLM 

results. 

 
Change VLM units 

− Allows you to select units for displaying VLM 

results. 

 Zoom mode 
− Allows you to select the zoom mode: Aggregation 

or Envelope. 

 
Change logger step − Allows you to change the logger step for all views. 
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Grow Font 

− Allows you to adjust the size of the numbers 

displayed in the Table view. 

 
Main options − Opens the Main options dialogue box. 

 
About 

− Displays information about the version of 

SvanPC++ you are using. 

 
Table 7-2. Additional buttons available for displaying on the Main Toolbar for Projects. 

 

Icon 

 

Name 

 

Function 

 

 
Add file − Adds a file to the project 

 
Switch layout mode − Toggles between single and double column layout 

 
Generate report − Creates report from panels  

 
Generate report preview − Creates report preview from panels  

 
Report options − Opens the report options dialogue box 

  

       

The View Toolbar is displayed at the top of the view window. Its content is specific to the view and 

cannot be configured.  

 

 
 

Figure 7-3. An example of the Toolbar for the Logger results view. 

 

 

All the buttons that can be displayed on the toolbar are described in the Table below. 

 
Table 7-3. Buttons available for displaying on the view Toolbars. 

 

Icon 

 

Name 

 

Function 

 

 
Table − Toggles to the Table view 

 
Plot − Toggles to the Plot view 
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Spectrogram − Toggles to the Spectrogram view 

 
Text − Toggles to the Text view 

 
Zoom plus 

− Zooms in the plot if possible or increases number of 

pixels per sample  

 
Zoom minus 

− Zooms out the plot if possible or decreases number 

of pixels per sample 

 
Zoom to selections − Zooms the plot to the current block selection 

 
Zoom settings − Opens the Auto scale x settings dialogue box 

 
Reset zoom − Resets plot zoom 

 
Zoom mode 

− Toggles zoom mode between aggregation and 

envelope 

 
Change logger step − Opens the Set logger step… dialogue box 

 
Send to MS Excel − Allows data to be exported to Microsoft Excel 

 
Send to MS Word − Allows data to be exported to Microsoft Word 

 
Scroll to the beginning − Scrolls to the first record 

 
Scroll left − Scrolls one record to the left 

 
Scroll right − Scrolls one record to the right 

 
Scroll to the end − Scrolls to the last record 

 
Open associated file 

− Opens results file associated with current recording 

time or associated logger file  

 
AutoSize columns 

− Automatically resizes table columns for the current 

view 

 
View configuration − Opens the Configurator for the current view 
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Shift data 

− Adds a constant positive or negative value to a 

range of data  

 
Clip data − Truncates all data above a specified threshold 

 
Delete data − Deletes block selections  

 
Restore data − Restores deletions, shifts, clips to original (undone) 

 
Limit lines settings − Opens the Limit lines dialogue box 

 
Trigger marker − Displays trigger Level+ marker parameters 

 
Go to maximum − Moves the cursor to the maximum value of the 

active function in the block, if any, or all data 

 
Go to minimum − Moves the cursor to the minimum value of the 

active function in the block, if any, or all data 

 
Play − Starts playback of event / wave 

 
Stop − Stops playback of event / wave 

 
Previous event − Goes to the previous event 

 
Next event − Goes to the next event 

 
Show options − Opens the player settings menu 

 

 

 

7.2 SV10x CALIBRATION 
 

The SvanPC++ software makes it easy to calibrate an SV 100, SV 101 or SV 103 instrument connected 

to a PC via USB. The calibration function can be activated in several ways: 

• using the SV100/101/103 Calibration (USB) command from the SVAN menu, 

• by clicking on the  icon available on the Main Toolbar, 

Note: This icon is not available in the default configuration of the Main Toolbar. For details on the 

icons available on the Main Toolbar, see Chapter 7.1. 

• by pressing the Calibration button in the SV100/101/103 Instrument Wizard. 

 

Each of these actions opens the SV100/101/103 Calibration dialogue box. 
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Figure 7-4. SV100/101/103 Calibration (USB) dialogue box. 

 

f more than one instrument is connected to the computer, you can use the Select instrument 

pull-down menu in the bottom right-hand corner of the window to select the instrument you wish to 

calibrate. 

You can manually set the Calibration Factor as well as the calibration measurement profile settings, 

such as: 

• Calibration Level, 

• Filter, 

• Detector, 

for each individual measurement channel using the controls grouped in the Channel X / Y / Z panels 

below the Measurement progress bar. It is also possible to configure the Measurement Time Settings 

and select the units for the vibration measurement results. 

The settings are automatically downloaded from the instrument when you open the SV 100/101/103 

Calibration dialogue box. You can also download them manually using the Read Settings button at 

the bottom of the window. The Send Settings button is used to send the configured settings to the 

instrument. 

The Start Measurement button allows you to start measurements with the current instrument 

settings. The results of the RMS measurement for each channel, downloaded from the SVAN 100/101 

instrument, are displayed in the panels at the top of the window, above the Measurement progress 

bar. The values are automatically updated during the measurement. 

Press the Start Calibration button: 

• sends the configured settings to the instrument, 

• sets the calibration mode in the instrument, 

• starts the calibration measurement. 

 

To send the Calibration factor value to the connected instrument, press the Save Calibration button 

(individually for each measurement channel). 

You can use the Terminate button to stop the current action, e.g. downloading settings from the 

instrument, etc. 

Note: A short manual in PDF format explaining how to work with the SV 100 instrument is available 

on the SVANTEK website: www.svantek.com. 
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7.3 SV 200 CALIBRATION 
 

To calibrate the SV 200/SV 200A instrument, connect it via USB and use the SV 200 Calibration (USB) 

command from the SVAN menu or the  button in the Instrument wizard (see 

Chapter 3.4). 

You can use the Auto Calibration function if it is available for the connected instrument. Then all you 

have to do is place the calibrator on the microphone in accordance with the procedure described in 

the instrument’s User Manual. The calibration factor will be calculated and saved automatically. 

Note: The Auto Calibration function can also be used without connecting the instrument to SvanPC++. 

 

 
Figure 7-5. The Auto Calibration, available for some instruments, allows for performing all actions 

necessary for calibration automatically. 

 

If you want to calibrate the instrument manually, use the SV 200 Calibration (USB) window. 

 

  
Figure 7-6. SV 200 Calibration (USB) dialogue box.  

 

• Enter the Calibration Level in dB (the reference sound level generated by the calibrator). 

• Press Start to start the calibration measurement. 

• Wait until the calibration is finished, the measurement results will be displayed after a short 

delay. 

• Decide whether to save the new calibration factor value (if not, the previous value will still 

be used). 

 
Figure 7-7. Results of SV 200 calibration. 
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7.4 SV 10x OPTIONS CONFIGURATION 
 

To configure the optional functions of the SV 100, SV 101, SV 103, SV 104 or SV 301 instruments 

connected to your PC via USB, use the SV100/101/103/104/301 Options Configurator (USB) 

command from the SVAN menu. The Options Configurator window appears. 
  

 
 

Figure 7-8. SV 100/101/103/104/301 options configuration. 

 

The Options and Functions lists contain the options and functions available for configuration. When 

you select an option, the Enter code dialogue box appears. To activate an option, you must enter the 

activation code for that particular option, which you will receive when you purchase the instrument. 

 

  
 

Figure 7-9. The dialogue box allowing for entering the activation code for an option in an 

SV100/101/103/104 instrument. 

 

Note: If a limit of incorrect code entries is exceeded, the device must be reconnected before the 

selected option can be activated. 

 

The Instrument pull-down menu below the Options and Functions lists can be used to select an 

instrument if more than one is connected. 

 

Note: The Options Configurator can only be used with a  direct (cable) connection to the instrument.  
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7.5 SVAN 958AG BUILDING VIBRATION  
 

The SV 258 PRO outdoor monitoring system based on the SVAN 958A class 1 four-channel vibration 

and sound level meter with special firmware (SVAN 958AG) is designed for building vibration 

measurements. The monitoring system uses special methods based on Peak Particle Velocity and 

Dominant Frequency, which comply with many local standards and also allow the measurement of 

human vibration. The SV 258 PRO outdoor monitoring system generates alarms based on special 

events registered in the data files (see SV 258AG User Manual). 

There are generally two approaches to assessing the of dominant frequency based on 1/3 octaves or 

FFT and the vibration results associated with that frequency. Different local standards use one or the 

other approach. 

SVAN 958AG uses both methods and creates files (group of files) that SvanPC++ recognises and 

presents data in the special Building vibration view. 

In the case of the 1/3 octave approach, the instrument creates .svl files with the name Lxx, where xx 

is a number. 

In the case of the FFT approach, the instrument creates .svl files and also .wav files with the name 

Rxx associated with the .svl file. An Rxx file contains a waveform signal recorded for a detected event 

during the time set as Duration.  

Note: When retrieving data from SVAN 958AG, remember to retrieve all files created during a 

measurement. 

 

7.5.1 1/3 OCTAVE APPROACH 
 

In the case of the 1/3 octave approach, the Building vibration view presents a table with SVAN 958AG 

settings and data for the time history, events or alarms, and Criterion curves with measurement 

results for three axes (X, Y, Z) in the form of 1/3 octave spectra. 

 
Figure 7-10. Building vibration view for the 1/3-octave approach. 

Select 
standard 

Select 
channels 
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7.5.2 FFT APPROACH 
 

In the case of the FFT approach, the Building vibration view presents a table with SVAN 958AG 

settings and data for time history, events or alarms, and Criterion curves with measurement results 

for three axes (X, Y, Z) as a points. 

  
Figure 7-11. Building vibration view for the FFT approach. 

 

The content of the table and the data presented in the right plot depend on selections made in the 

second position of the View toolbar (Time history, Alarm or Event). If Time history is selected, you can 

view PPV and Dominant frequency for all measurements made with the Logger step. If you select 

Event or Alarm, you can view PPV and Dominant frequency for events or alarms only. You can scroll 

through the records using the arrows in the View toolbar. 

 

Criterion curves depend on the standard selected in the upper right cell of the table (DIN 4150-3, 

BS 7385-2, FR/IN-1226-A, FR/IN-1226-B, FR/IN-1226-C, FR/23/07/1986/1, FR/23/07/1986/2, 

FR/22/09/1994, SBR-A). 

Note: SVAN 958AG calculates PPVs, dominant frequencies, events and alarms based on the selected 

standard, which is displayed together with other settings in the second column of the table. Selecting 

the standard in the upper right cell only places another criterion curve, but all measurement results 

are not changed. 

 

Scrolling down the view allows you to examine the waveform signals associated with the selected 

event or alarm registered for three axes. 
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Figure 7-12. Waveform signals associated with the selected event or alarm for three axes. 

 

Pressing the Events list button  next to the Alarm/Event/Time history selector will bring up the 

new Alarms view. This view displays the table of all detected events.  

 

You can display two tables, Building vibration and Alarms, side by side. Changing the row in the Alarms 

table in the right pane will automatically change the alarm record in the left pane and vice versa. 

 

 
Figure 7-13. Presentation of Building vibration and Alarms view. 
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To create a report, press the Send to MS Word button on the left-hand side of the view  toolbar 

. 

 
Figure 7-14. Report example of Building vibration view for the FFT approach. 

 

 

 

7.5.3 EVENTS CALCULATION FROM WAVE FILES 
 

By opening the Wave results view, you can examine a signal waveform over the entire measurement 

time. 

 

If you select a number of blocks, you can recalculate events according to the standard selected in the 

special toolbar (PN-B-02170, PN-B-02171, IEST, DIN 4150-3 or BS 7385-2).  The calculation of events 

can be started by pressing the Dominant frequency or 1/3 Octave button, depending on the selected 

standard. After calculation the Building vibration view is displayed and the new event sequence is be 

added to the Time history, Events, Alarms list. 

 

Note: The events calculation tool also works with wave files created by other Svantek instruments 

(e.g. SV 106) if these wave files have been created for three-channel measurements of the vibration 

signal (for X, Y and Z axes). In this case, when you open one of these files, SvanPC++ will automatically 

display the toolbar for BA event calculation. 
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Figure 7-15. Wave results view. 

 

 

7.6 SV 200A NOISE DIRECTIVITY 
 

The SV 200A monitoring station is equipped with special microphones that make it possible to 

determine the direction of the noise source.  

The noise source direction algorithm detects the source of the dominant energy in a given time 

interval. Detection is performed in two planes - horizontal "XY" and vertical "Z". The user receives 

information on the direction of the noise source with the dominant energy, together with the 

percentage of this energy in the total signal and the distribution of the total energy as a function of 

angle.  

There are two measurement results that the SV 200A instrument measures and saves in a file: the 

sound energy distribution for the “XY” and “Z” planes as logger results with the Logger Step (if the 

logger step is less than 1 second, the sound energy distribution is recorded with a 1 second step) and 

the estimated directional Leq as summary results with the Integration Period step. 

The energy in a given direction is expressed as a percentage of the total energy in all directions.  

 

The direction is the angle of the deviation:  

• for the “XY” plane - from the north direction clockwise in the range from 0 to 359 degrees, 

• for the “Z” plane - from the vertical direction in the range from 0 to 180 degrees (top = 0 

degrees, bottom = 180 degrees). 

To simplify the perception of the results, the calculations give results for sectors, the number of which 

can be defined by the user, instead of degrees. 

Estimated Leq is calculated from the general Leq multiplied by the percentage of energy from the 

selected sectors.  

Directivity settings can be made in the Setup file editor (see Chapter 3.3).  
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Figure 7-16. Directivity settings in the Setup file editor. 

 

You can switch all directivity calculations on or off. 

You can define the number of sectors in both planes. For the “XY” plane it is possible to select 32, 16, 

8, 4 and 2 sectors. For the “Z” plane it is possible to select 17, 9, 5, 3 and 2 sectors. 

 

 
Figure 7-17. Selecting the number of sectors in the Setup file editor. 
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You can set sectors for two estimated Leq results (LE1 and LE2) for both planes (XY and Z). 

 
Figure 7-18. Selecting sectors for the LE calculation in the Setup file editor. 

 

You can view logger results with directional characteristics and map with the SV 200A localisation and 

direction of noise or its distribution by clicking on the corresponding buttons: Logger results and Map.  

 
Figure 7-19. Logger results and Map (Distribution) view with directivity data. 

The direction or distribution of the noise on the map corresponds to the time of the cursor position 

on the Logger results screen. 
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You can select the type of results to be 

displayed in the Map view: noise distribution 

(Directivity (TH) – Distribution), direction of 

maximum energy (Directivity (TH) – Max), 

noise sources (Directivity (TH) – 

Noise sources) or Leq. 

 

 
Figure 7-20. Map view – Max and Noise source. 

 

7.7 ALARMS 
 

Some instruments (e.g. SV 307, SV 200A) can generate alarms and save them in logger files as Event 

markers. 

When you open such a logger file, an additional Alarms button  appears in the Views 

toolbar.  

This view displays events that have generated alarms during the period of data logging. 

 
Figure 7-21. Alarms view. 
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If you mark events in the Configurator, you can also view alarm events in the Logger results view. 

Alarm events are displayed as block markers. 

 
Figure 7-22. Alarm block markers on the Logger results view. 

 

When you move the cursor over an event marker, the label for that marker appears in the top left 

corner of the view. 

 

If you place both the Alarms and Logger results views on the screen, you can see the selected event 

marker in the table highlighted in the time history plot. 

 
Figure 7-23. Viewing Alarm event on the Logger results view. 
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7.8 LOUDNESS ANALYSIS 
 

The SVAN 979 instrument has an optional function (Loudness) that allows the calculation of so-called 

bark spectra according to with the Zwicker algorithm and ISO 532B.  

If you open the .svl file containing such spectra, an additional Loudness button  will appear 

in the Views toolbar.         

The Loudness view shows the bark spectrum (sone/phone vs bark) with a resolution 0.1 Bark or 

1 Bark. 

 
Figure 7-24. Loudness view. 

 

You can select the desired unit for the Loudness analysis in the Main options » General » Units. 

 
Figure 7-25. Selection of Loudness units. 
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You can view the history of the bark spectra in the Spectrogram view by clicking on the Spectrogram 

icon. 

 
Figure 7-26. Viewing the history of Loudness spectra by clicking the Spectrogram icon. 

 

 

 

7.9 TONALITY ANALYSIS 
 

If you are using the Svantek instrument with the Tonality function, SvanPC++ detects tonality results 

and activates the Tonality view  when opening the logger file. This view shows a table of 

the tones detected for the measurement period(s): tone frequency, critical band frequencies, tone 

audibility (ΔL), tone level (Lt), sound level (Ls), masking noise (Lg), masking index (av), penalty (Kt) and 

uncertainty (sigma). 

 

 
Figure 7-27. View of the table with tones. 

 

When you open the wave file, SvanPC++ allows you to calculate the tones using the Calculator 

functionality. To do this, open the Calculator » Analyser: wave and press „+ Results” button in the 

Analyser dialogue box. In the Add result dialogue box, select Tonality from the list of results and set 

properties: the Standard according to which the tonality analysis will be performed, the time interval 

during which the tones will be searched (Interval), the weighting filter, the resolution and the band 

of the FFT, as well as specific tonality parameters. Once selected, press the ADD Tonality button as 

shown in the figure below. 

Note: The Svantek instruments support the ISO 20065:2016, ISO 226:2003 and ISO 226:1987 

standards for assessing the audibility of tones, while the Calculator currently supports the 

ISO 1996-2:2007 and DIN 45681 standards. 
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As a result of the calculations, the Tonality view is created with a table of the tones level (Lpt), noise 

levels (Lpn), tone audibility (Lta) and critical band frequencies (CBfreq) detected for the periods 

defined by the Interval parameter.  

 

 
Figure 7-28. Setting parameters of the Tonality analysis. 

  

If you select the interval by clicking on its row in the Tonality view table , you can view the FFT 

spectrum calculated for that interval with the tone displayed. 

 

 
Figure 7-29. Combined Tonality and FFT views. 
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7.10 SHORTCUT KEYS 
 

The key combinations available in SvanPC++ are listed in Table 7-4. 

 
Table 7-4. Shortcut keys in SvanPC++. 

 
Key combination 

 

Function 
 

 

CTRL + C 
 

 

− Copy selection. 
 

CTRL + V 
 

− Paste from clipboard. 
 

CTRL + Z 
 

− Undo last action. 
 

F1 
 

− Access help. 
 

CTRL + P 
 

− Print. 
 

CTRL + O 
 

− Open a file. 
 

Left ALT + F, E, ... 
 

− Access to menus (F – File, E – Edit etc.). 
 

Shift + F1 

 
 

− Enables to use the mouse to open help page related to a 

selected control. 
 

CTRL + F6 
 

− Show next opened sub-window. 
 

ESC 

 

 

− In the Plot view, delete the block selection containing the 

current position of the Main cursor / delete the only existing 

block selection / delete all block selections. 

 

 

7.11 ACCESSING ADDITIONAL MODULES 
 

Besides the free basic SvanPC++ software there are several additional modules available for purchase, 

such as: 

• Remote Communication (RC) 

• Environmental Monitoring (EM) 

• Projects 

• Dose Measurements (DM) 

• Building Acoustic (BA) 

 

There are two ways to activate additional modules: 

• Entering an activation code, 

• Using a hardware dongle. 

 

 

7.11.1 RC MODULE ACTIVATION 
 

The RC module is licensed separately for each Svantek instrument. To access this module, you must 

purchase an activation code for each instrument you want to use with the RC module and enter it in 

the Enter Activation Keys window. 
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Figure 7-30. Entering codes for RC Module activation. 

 

 

 
7.11.2 HARDWARE DONGLES 
 

The EM, DM and BA modules can be activated using hardware dongles. 

 

 
 

Figure 7-31. A hardware dongle. 

 

The dongles contain keys for activating additional SvanPC++ modules. When you plug a dongle into a 

USB port on your computer, the key is automatically unpacked and you get access to the modules. If 

the dongle is removed, access to the module is blocked. 

 

Several SvanPC++ modules can be activated with one dongl. 

 

Keys in the dongle are linked to its serial number. Therefore, a key copied from the dongle will not 

work unless the dongle is plugged into the computer. 

 

Note: If you do not have access to the additional modules after inserting the dongle, this may be due 

to an older version of SvanPC++ being installed on your computer. In this case, it is necessary to 

uninstall SvanPC++ and then install the latest version of the software, which is available from 

Svantek's website. 

 

When using a Terminal Server, the dongle is available for one user at a time. 

 

  

Type the code here 
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8 ENVIRONMENTAL MONITORING MODULE TOOLS 

 

 

SvanPC++ Environmental Monitoring (EM) is an additional module of the SvanPC++ software package, 

designed for processing data from noise or vibration measurements, including long-term unattended 

environmental monitoring. 

 

The EM module enriches the SvanPC++ software with the following features: 

• Advanced recalculation tools (Calculator), 

• Extended functionality of the table below the plot (see Chapter 4.2.2, paragraph Contents of 

the plot). 

 

 

 

8.1 ENVIRONMENTAL CALCULATOR 
 

SvanPC++ Environmental Monitoring provides tools for noise assessment in terms of recalculations 

based on measurement results. In this chapter the functions available for recalculation are 

considered.  

 

 

8.1.1 NOISE ASSESSMENT 
 

The Environmental Monitoring Calculator provides many tools for noise assessment. 

 
 

Leq – Equivalent Continuous Sound Level 

 

The total Equivalent continuous sound level value over a given period can be calculated from the Leq 

measurement results using the formula: 

 Leq𝑘𝑡𝑜𝑡 = 10 log10 (1𝑇 ∑ 100.1×𝐿𝑒𝑞𝑘𝑘1 × 𝑇𝑘) (8-1) 

where:  𝑘 – sample index in the given data set, 𝑇 – sum of Leq sample durations 𝑇 = ∑ 𝑇𝑘𝑘1  , 𝑇𝑘 – individual sample duration. 

 

This is done using the Leq function from the Logger » Acoustics group. 

 

  
Figure 8-1. The Leq function on the Calculator functions list. 
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Unlike the simple function available in the Total RMS / Leq sub-module of the Calculator (described 

in Chapter 5.2.1), its version available in the Environmental Monitoring module offers several options 

that can be found in the Parameters tab: 

• Calculate using SEL – this option can be used when Leq needs to be calculated for separate events, 

such as blocks created by airplane flights. When selected, SEL values are first calculated for 

separate events, and then Leq values are calculated based on these SEL values. 

• Calculation mode: 

o Standard calculation 

o Using reference time – this option is also related to the calculation of Leq for separate events. 

When enabled, Leq values are calculated according to the specified Reference time and the 

time range not belonging to the event is filled with the specified Reference level value. 

o Within moving window 

 

The following options are available in the Within moving window calculation mode: 

• Window – the length of the moving window, in hh:mm:ss format. 

• Continue over missing values – if there is missing data in the logger and this option is enabled, Leq 

values will also be calculated in the time periods corresponding to the missing data. This is done 

by using only the part of the window for which measurement results are available. If this option 

is disabled, Leq will only be calculated in time periods for which logger data is available. 

• Continue over breaks shorter than – if the Continue over missing values option is enabled, this 

option allows you to specify a threshold length for time ranges with missing data – Leq will not be 

calculated over logger pauses equal to or longer than the specified threshold. This can be useful 

if short bursts of noise have been cut from the logger, but you still wish to calculate Leq at the cut 

points. 

• Use reference level within breaks – if the Continue over missing values option is enabled, this 

option allows you to define a value to use to fill in the missing data, rather than taking the 

measurement results from the part of the window where they are available. 

• Show Lmin/Lmax marker – creates markers corresponding to the windows with the lowest / 

highest Leq values in the calculation period. 

 

The EM Calculator also provides other types of Leq recalculations, such as: 

• Total / spectral (averaging), 

• In intervals, 

• Finding max and min levels, 

• Statistical levels, 

 

Spectral Leq is available in the Logger 1/n octave » Acoustics group. In the Parameters settings for 

this function, you can select whether the 1/1 octave or 1/3 octave spectrum is to be calculated. 

 

Note: In the case of spectral logger-based calculations, the calculation is performed separately for 

each logged frequency. Calculating a spectral function automatically opens a 1/3 or 1/1 octave logger 

recalculated sub-window containing the calculation results. 
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SEL – Sound exposure level 

 

The SEL result is essentially a subset of the Leq function. 

 SEL𝑘 = Leq𝑘 + 10 log (T𝑘[𝑠]1[𝑠] ) (8-2) 

where: 𝑘 – sample index in the given set of data. T𝑘 – measurement time. 

 

You can calculate the SEL function in intervals by setting the start and stop time of the calculation 

period using the Calculate in selected absolute time period option in the Parameters panel. 

 

The SEL function is available in the Logger » Acoustics group. For spectral data, it can also be 

calculated using the SEL function in the Logger 1/n octave » Acoustics group. 

 

 
Maximum and Minimum Leq 

 

You can calculate the highest and lowest Leq level during the measurement period using the max(Leq) 

and min(Leq) functions, available in the Logger » Acoustics group. 

 

These functions are also available for spectral data under the same names in the Logger 1/n octave 

» Acoustics group. In the case of spectral min(Leq) and max(Leq), the choice between 1/1 octave and 

1/3 octave spectrum is available in the Parameters panel. The min/max values are found 

independently for each frequency band over the entire calculation range. 

 

 
Statistics 

 

Statistics can be calculated for several logger or multifile type functions. All available statistical 

recalculations are listed in the Logger » Statistics group and, in the case of spectral data, in the Logger 

1/n octave » Statistics group. For example, you can use the Logger » Statistics » Leq stats function to 

obtain statistics on the results of Leq calculation. 

 

Calculating a Statistics type function automatically opens a Logger statistics sub-window containing 

the calculation results. The statistics results can be viewed in two modes: 

• Histogram mode shows the percentage of each dB level in the given function values at 1 dB 

resolution. 

• The Ln mode has the following interpretation: x% of the samples have values equal to or greater 

than the Lnx value. 

In the case of spectral statistics, the Ln(f) mode is also available, as described in the Statistical Views 

section (see Chapter 4.3.2). 
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Figure 8-2. Leq-based functions on the Calculator functions list. 

Sound Exposure Level 

Minimum / Maximum Leq Result 

Leq-based functions 
for spectral data 

Leq statistics 

Leq spectrum 
statistics 
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Leq Averaged Spectrum 

 

To calculate the averaged Leq spectra based on logger spectra, select the Leq function from the 

Logger 1/n octave group.  

 

In the Parameters tab, deselect Calculate spectrum total for selected frequencies. In the Calculation 

period(s) tab, deselect Whole data and select section Calculate in intervals section and define the 

interval(s) for averaging spectra. Finally, press the Calculate button. 

  
Figure 8-3. Setting parameters of Leq spectrum averaging. 

 

As a result of the calculation, averaged Leq spectra appear in the Configurator list.  

 
Figure 8-4. View of averaged Leq spectra. 

 

If you wish to calculate Leq total values for the selected bands, select Calculate spectrum total for 

selected frequencies in the Parameters tab and 1/3 octave bands for which you wish to recalculate 

total Leq.  In the Calculation period(s) tab define the interval(s) for total Leq. Finally, press the 

Calculate button. 
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Figure 8-5. Selecting 1/3 octave bands for total Leq calculation. 

 

 

As a result of the calculation, the total Leq results for the selected bands will appear in the 

Configurator list.  

 
Figure 8-6. Leq spectrum averaging. 

 

 

This function is only available for files containing spectral data at multiple time points, such as Logger 

or Merged spectral data. It is not available for Results files. 
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Day / Evening / Night level functions 

 

The Lday, Leve, Lnight, Ldn and Lden functions are noise level descriptors based on the Leq results for the 

day, evening, night, day-night and day-evening-night periods respectively, with penalty factors for 

certain parts of the day. They can be accessed in the Logger » Acoustics group. 

 

  
Figure 8-7. Lden family of functions on the Calculator functions list. 

 L𝑑𝑒𝑛𝑘 = {Leq𝑘 + 𝑝𝑘                                                                        𝑓𝑜𝑟 𝑘 = 110 log [1𝑘 (∑ 10L𝑑𝑒𝑛𝑛10𝑛=𝑘−1𝑛=1 + 10Leq𝑘10 )] + 𝑝𝑘           𝑓𝑜𝑟 𝑘 > 1  (8-3) 

 𝑝𝑘 = {0       𝑓𝑜𝑟 𝑡𝑘 ∈ (𝑇𝑑 , 𝑇𝑒〉𝑝𝑒     𝑓𝑜𝑟 𝑡𝑘 ∈ (𝑇𝑒 , 𝑇𝑛〉𝑝𝑛     𝑓𝑜𝑟 𝑡𝑘 ∈ (𝑇𝑛 , 𝑇𝑑〉  (8-4) 

 𝐿𝑑𝑎𝑦𝑘 = 10 log (1𝑘 ∑ 10Leq𝑘10𝑘1 )               𝑓𝑜𝑟  𝑡𝑘 ∈ (𝑇𝑑 , 𝑇𝑒〉 (8-5) 

 𝐿𝑒𝑣𝑒𝑘 = 10 log (1𝑘 ∑ 10Leq𝑘10𝑘1 ) + 𝑃𝑒    𝑓𝑜𝑟  𝑡𝑘 ∈ (𝑇𝑒 , 𝑇𝑛〉 (8-6) 

 𝐿𝑛𝑖𝑔ℎ𝑡𝑘 = 10 log (1𝑘 ∑ 10Leq𝑘10𝑘1 ) + 𝑃𝑛    𝑓𝑜𝑟  𝑡𝑘 ∈ (𝑇𝑛 , 𝑇𝑑〉 (8-7) 

where: 𝑇𝑑   – day-time start point (by default: 6:00 AM), 𝑇𝑒  – evening-time start point (by default: 6:00 PM), 𝑇𝑛  – night-time start point (by default: 10:00 PM), 𝑝𝑒  – evening-time penalty, 𝑝𝑛  – night-time penalty, 𝑘  – sample index in given set of data, 𝑡𝑘   – k-sample measurement time. 

 

In the Parameters panel for Lden family functions, you can adjust the values of the following 

parameters: 

• Day-time start point [hh:mm:ss], 

• Evening-time start point [hh:mm:ss], 
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• Night-time start point [hh:mm:ss], 

• Evening-time penalty factor [dB], 

• Night-time penalty factor [dB]. 

 

Note: The start points of the day parts are given in absolute time, regardless of the Main options 

settings.  

 

If the Calculate in intervals option is enabled, the common part of the intervals and the selected day 

parts are used for the recalculation. For details on calculating in intervals, see Chapter 9.2. 

 

You can also choose to calculate the functions described using a specified reference time. This option 

is particularly useful if you are performing calculations on a shorter range of the time domain. 

 

If the Calculate using reference time option is enabled, the recalculation consists of the following 

steps: 

1. Leq is calculated for separate events, selected by the user with blocks or markers. 

2. Calculations are performed using the following formulae: 

 𝐿𝑑𝑎𝑦 = 10 log [ 1𝑇𝑅𝑑 ∑ 𝑡𝑗100.1𝐿𝐴𝐸𝑗𝑛𝑑𝑗=1 ]  (8-8) 

 𝐿𝑒𝑣𝑒 = 10 log [ 1𝑇𝑅𝑒 ∑ 𝑡𝑗100.1(𝐿𝐴𝐸𝑗+𝑝𝑒)𝑛𝑒𝑗=1 ] (8-9) 

 𝐿𝑛𝑖𝑔ℎ𝑡 = 10 log [ 1𝑇𝑅𝑛 ∑ 𝑡𝑗100.1(𝐿𝐴𝐸𝑗+𝑝𝑛)𝑛𝑛𝑗=1 ] (8-10) 

 𝐿𝑑𝑒𝑛 = 10 log [ 1𝑇𝑅𝑑 ∑ 𝑡𝑗100.1𝐿𝐴𝐸𝑗𝑛𝑑𝑗=1 + 1𝑇𝑅𝑒 ∑ 𝑡𝑗100.1(𝐿𝐴𝐸𝑗+𝑝𝑒)𝑛𝑒𝑗=1 + 1𝑇𝑅𝑛 ∑ 𝑡𝑗100.1(𝐿𝐴𝐸𝑗+𝑝𝑛)𝑛𝑛𝑗=1 ]  

  (8-11) 

where: 𝑇𝑅𝑑   – reference time (day) 𝑇𝑅𝑒  – reference time (evening) 𝑇𝑅𝑛  – reference time (night) 𝐿𝐴𝐸𝑗  – Leq for event j 𝑡𝑗   – duration time of event j 𝑛𝑑   – number of events in day-time 𝑛𝑒  – number of events in evening-time 𝑛𝑛  – number of events in night-time 

 

If the calculation is performed in intervals, the calculations for each interval are performed 

independently with a specified reference time. 

 

 
LTeq, Tm5 – Takt-Maximum levels  

 

The LTeq and Tm5 functions in the Logger » Acoustics group allow the Takt-Maximum levels to be 

calculated in accordance with the German TA Lärm standard. 
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Figure 8-8. Takt-Maximum level functions on the Calculator functions list. 

 

The calculations are performed in 5-seconds time intervals, beginnings from the file start, 

independently on the intervals set in the Calculation periods settings. 

 

The LTeq and Tm5 values are only calculated for data ranges where the entire 5-second period is 

selected for calculation. If part of a period is not included in the selection, the calculation for a period 

< 5 s will never be performed. 

 

Maximum / minimum value calculation 

 

It is possible to calculate the maximum or minimum value of functions measured by the Svantek 

instruments, such as Lmax, Lpeak and Lmin, using the max(Lmax), max(Lpeak) and min(Lmin) 

functions from the Logger » Acoustics group. These functions simply return the maximum value of 

given measurement results within the calculation range. 

 

 
 

Figure 8-9. Maximum / minimum value functions on the Calculator functions list.  
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LVA (Level of Evaluation of Aircraft Noise) 

 

According to the Italian law, LVA is calculated as follows (see DM 31/10/1997 Appendix A): 

 

1. The monitoring stations detect events connected with airplanes using SEL (Sound Exposure Level). 

 

2. The reference year is divided into three periods of four months: 

• October 1 – January 31, 

• February 1 – May 31, 

• June 1 – September 30. 

 

3. The days are divided into two periods: 

• Day: 06.00–23.00, 

• Night: 23.00–06.00. 

 

4. Calculation of LVA daily using the formula LVAday + LVAnight (logarithmic addition): 𝐿𝑉𝐴𝑗 = 10 log (1724 10LVAday 10⁄ + 724 10LVAnight 10⁄ )  dB(A)  

where: 

LVAday is the sum of the SEL measured during the day, 

LVAnight is the sum of SEL measured during the night (a penalty of 10 dB is added to each SEL, as 

the airborne noise is perceived more during the night). 𝐿𝑉𝐴𝑑𝑎𝑦 = 10 log ( 1𝑇𝑑𝑎𝑦 ∑ 10𝑆𝐸𝐿𝑖 10⁄𝑁𝑑𝑎𝑦𝑖=1 )  dB(A)  𝐿𝑉𝐴𝑛𝑖𝑔ℎ𝑡 = [10 log ( 1𝑇𝑛𝑖𝑔ℎ𝑡 ∑ 10𝑆𝐸𝐿𝑘 10⁄𝑁𝑛𝑖𝑔ℎ𝑡𝑘=1 ) + 10]  dB(A)  

 

5. Calculation of LVAweek on a daily basis (logarithmic average). 

 

6. Selection of the three worst weeks corresponding to the traffic peaks for the three periods of 

point 2. 

 

7. Calculation of the average LVA (logarithmic) on the basis of LVAweek of the 3 weeks selected in 

point 6. 

 
Perceived Noise Level indicators 

 

The EPNL, PNL, PNLT functions are indicators of aircraft noise annoyance as perceived by humans. 

They are calculated according to the ICAO Annex 16 standard. 

• EPNL – Effective Perceived Noise Level 

• PNL – Perceived Noise Level 

• PNLT – Corrected Perceived Noise Level 

 

 

Projected Leq 

 

The projected Leq result is calculated on the base of the Leq,T measured for the T period from the 

start hour of the projection period T0.   
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The LeqPR calculation function assumes that the noise level will remain the same from the moment 

the Leq limit is exceeded until the end of the projection period. 𝐿𝑒𝑞𝑃𝑅(𝑘) = 10 log10 (1𝑇 ∑ 𝑡(𝑖)100.1𝐿𝑒𝑞(𝑖)𝑘
𝑖=0 ) + 10 log10 𝑇𝑇0 

where: 𝑇 = ∑ 𝑡𝑖𝑘𝑖=0  𝑇0 − measurement / block time 

 

 

Projected Leq with estimated background noise  

 

The LeqPR+Ln calculation function assumes that the estimated background noise level (Ln) is 

maintained from the moment the Leq limit is exceeded until the end of the projection period. 

 

𝐿𝑒𝑞𝑃𝑅, 𝐿𝑛(𝑘) = 10 log10 ( 1𝑇0 ((𝑇 + 𝑇𝑝𝑟𝑒) 1𝑇 ∑ 𝑡(𝑖)100.1𝐿𝑒𝑞(𝑖) + (𝑇0 − 𝑇 − 𝑇𝑝𝑟𝑒)100.1𝐿𝑛𝑘
𝑖=0 )) 

where: 𝑇 = ∑ 𝑡𝑖𝑘𝑖=0  𝑇0 − measurement / block time 𝑇𝑝𝑟𝑒 −pretrigger time 

 Ln - selected statistical level calculated for the period from the beginning of the measurement / 

block. 

 

 
Peak and harmonics detection 

 

Detection of peaks and harmonics in FFT data is provided by the Peak detection and Harmonic 

detection functions in the Result FFT group of the Environmental Monitoring Calculator.  

 

 
 

Figure 8-10. Peak and harmonics detection functions on the Calculator functions list. 

 

These two functions are only available for recalculation if the currently opened file contains FFT Result 

data. 

Note: Harmonic detection is performed using the main cursor position as the starting point. It is 

recommended to perform peak detection first, then place the main cursor on the desired peak and 

start the harmonic detection calculation. 

You can set the Peak / Harmonic detection criterion between 1dB and 30dB. 
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Tonality analysis 

 

Tonality analysis in SvanPC++ can be performed using three methods, depending on the type of data 

available. In order for each method to be available in the Environmental Monitoring Calculator, the 

file currently open in SvanPC++ must contain adequate data: 

• a single FFT Leq spectrum, 

• a single 1/3 Octave Lmin spectrum, 

• a time history (logger) of FFT or 1/3 Octave Leq spectra. 

The locations of the tonality-analysis-related functions in the Calculator list are shown in the figure 

below, followed by a detailed description of the methods. 

 

 

           

 
 

Figure 8-11. Functions for tonality analysis on the Calculator functions list. 
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Tonality analysis based on a single FFT Leq spectrum 

 

This tonality analysis method is available for Result FFT files containing Leq measurement results. The 

following parameters are available for configuration: 

• Standard: Nordic (according to ISO 1996-2:2002) / German 

• Maximum tone bandwidth: 5% – 25% (default: 10%) 

• Tone search criteria: 1 dB – 5 dB (default: 5 dB) 

• Regression range: 0 – 100% (default: 75%) 

• Tone bandwidth: 1 dB – 6 dB (default: 6 dB) 

 

As a result of the analysis, the Penalty factor (K) is calculated in relation to the selected parameter 

values. It is displayed in a dialogue box when the calculation is complete. 

 

  
Figure 8-12. Results of tonality analysis: calculated value of the Penalty factor. 

 

In addition, any tones found during the analysis are marked on the FFT spectrum, as shown in the 

figure below. 

 
 

Figure 8-13. Results of tonality analysis: tones marked on a FFT spectrum. 

 

 

Tonality analysis based on a single 1/3 Octave Lmin spectrum 

 

This method of tonality analysis is available for Result 1/3 Octave files containing Lmin measurement 

results. In the Parameters tab, you can enable the Allow dual-band tonality option. 

 

Found tones 
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Figure 8-14. The Allow dual-band tonality option in the Tonality analysis Parameters tab. 

 

• If the Allow dual-band tonality option is unchecked, a tone is defined as a band whose value is at 

least 5 dB higher than the values of both its neighbours (left and right). 

• If the Allow dual-band tonality option is checked, the presence of two tones of similar levels next 

to each other is allowed. The threshold for the maximum difference between adjacent bands that 

will be classified as a dual tone can be set in the Max difference between bands [dB] field. In 

addition, the two bands must have values at least 5 dB higher than their left and right neighbours 

in order to be classified as a dual tone. 

 

If at least one tone is present in the analysed spectrum, the resulting correction factor is KT = 3 dB. 

In addition, if there is a tone with a frequency less than or equal to 200 Hz in the nighttime, the 

correction factor KB = 3 dB is added. The correction factors are displayed in a dialogue box at the end 

of the analysis. 

  
Figure 8-15. Results of tonality analysis: calculated values of correction factors. 

 

In addition, all the tones found during the analysis are marked on the Lmin spectrum, as shown in the 

figure below. For each tone, the corresponding Equal Loudness Contour (ELC) curve is calculated and 

displayed. 

 

  
Figure 8-16. Results of tonality analysis: tones and ELC curves marked on a 1/3 Octave spectrum. 

ELC curves 

Found tones 
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Tonality analysis based on a time history (logger) of 1/3 Octave Leq spectra 

 

This method of tonality analysis is available for Logger 1/3 Octave files containing time history of Leq 

measurement results. You can enable the Calculate using stationarity criterion option in the 

Parameters tab. 

 

  

Figure 8-17. The Calculate using stationarity criterion option in the Tonality analysis Parameters tab. 

 

• If the Calculate using stationarity criterion option is unchecked, the analysis consists of searching 

for tones in each 1/3 Octave spectrum stored in the logger file according to the following 

algorithm: 

1. Calculate averaged Leq spectra according to the selected value of the Leq averaging interval 

parameter (e.g. calculate spectra defined at 1s intervals using spectra acquired at 100ms 

intervals). 

2. Calculate the Lmin spectrum using the time history of the averaged Leq spectra (taking into 

account the division into blocks and intervals specified in the Calculation period(s) settings). 

3. Perform a tonality analysis on the obtained Lmin spectrum(s) using the method for analysing 

single 1/3 Octave Lmin spectra (described above). 

• If the Calculate using stationarity criterion option is checked, the analysis consists of searching 

for tones whose duration is greater than or equal to a threshold specified in the Stationarity 

criterion of tonality signal [s] field, according to the following algorithm: 

1. Calculate averaged Leq spectra according to the selected value of the Leq averaging interval 

parameter (e.g. calculate spectra defined aton 1s intervals using spectra acquired at 100ms 

intervals). 

2. Take the first averaged Leq spectrum. 

3. Calculate the tonality in the currently analysed Leq spectrum. 

4. If no tones are found, take the next Leq spectrum and go to step 3. Otherwise: 

a) Take the next averaged Leq spectrum and calculate the Lmin spectrum using the 

currently analysed spectra where tonality has been detected. 

b) Analyse the tonality again. If at least one tone was found, go to a); if not, go to step 5. 

5. Calculate the duration of the obtained time range in which tonality has been detected. If it is 

less than the specified threshold, ignore the found tone. Otherwise, calculate correction 

factors and other results. Take the next averaged Leq spectrum and go to step 3. 

 

As a results of the analysis, the correction factors KT and KB are given for each detected tone, in the 

same way as in the case of a single 1/3 Octave spectrum (described above). The tones are marked on 
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the spectra. The Equal Loudness Contour (ELC) curves are also drawn for each detected tone. In 

addition, the Tonality marker is generated and displayed in the Logger view, describing the time 

ranges in which tones were detected. 

 

 
 

Figure 8-18. Results of tonality analysis: the tonality marker. 

 
 

 
Impulsivity analysis 

 

The impulsivity of a logger-stored signal can be evaluated using the Impulse analysis function from 

the Logger group. 

 

 
 

Figure 8-19. Impulsivity analysis function on the Calculator functions list. 

 

The recalculation is performed according to the UNI/BS 9432:2002 standard on the basis of the 

measured Lmax function. As a result of the calculations, a dialogue box appears with information on 

the impulsivity of the evaluated signal. 

 

To enable recalculation of the Impulse analysis, the following requirements must be met: 

• The analysed Logger file must contain the Lmax measurement results . 

• The measurement must be performs in 3 profiles using the following detector types: Fast, 

Impulse and Slow. 

• The logger step must be less than 1 s. 

 

Tonality marker 
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After the calculation, the information window shown below will appear. 

 

 
 

Figure 8-20. Impulse analysis results. 

 

When the OK button is pressed, the Logger screen is displayed with the new calculated pulse function. 

 
 

Figure 8-21. Logger view with calculated impulse function. 

 

 

 

8.1.2 VIBRATION-MEASUREMENT-BASED CALCULATIONS 
 
RMS-based calculations 

 

The averaged RMS value for a vibration measurement signal can be calculated using the Total RMS 

function in the Logger » Vibrations group. It is similar to the Leq function for acoustic measurements. 

 

The maximum and minimum RMS values can be calculated using the min(RMS) and max(RMS) 

functions from the Logger » Vibrations group in a similar way as in case to Leq-based calculations for 

acoustic measurements, except that Leq values are replaced by RMS values. 
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Consequently, the RMS statistics and the RMS spectrum statistics can also be calculated in the same 

way as described in the Statistics section of Chapter 8.1.1. 

 

  

    
 

Figure 8-22. Vibration RMS-based functions on the Calculator functions list. 

 
 

 

 
 

 

Minimum / Maximum RMS Result 

RMS value calculation 

RMS statistics 

spectral RMS statistics 
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VECTOR function 

 

The VECTOR function, available in the Logger » Vibrations group, is calculated using the Total RMS 

data measured on different channels, according to the formula: 

 VECTOR𝑘 = 10 ∙ log (√∑ 𝐾𝑛𝑇𝑜𝑡𝑎𝑙𝑅𝑀𝑆𝑘,𝑛2𝑛 ) (8-12) 

where: 𝑛 – channel number, 𝑘 – sample index in the given data set, 𝐾𝑛 – vector coefficients that can be adjusted in the Parameters panel. 

 

In the case of this function, the selection of measurement channels to be used for calculations is only 

available in the Parameters panel. 

  
Figure 8-23. The VECTOR function on the Calculator functions list. 

 

 
Total VDV – Total Vibration Dose Value 

 

The Total VDV function is calculated using the VDV results, according to the formula: TotalVDV𝑘 = 5 ∙ log (∑ 10VDV𝑘5k1 ) (8-13) 

where  𝑘 – sample index in the given data set. 

 

It is available in the Logger » Vibrations group. 

 

  
Figure 8-24. The Total VDV function on the Calculator functions list. 
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8.1.3 OTHER FUNCTIONS 
 

The Environmental Monitoring module also provides other useful calculator functions that can be 

used with both sound and vibration data. 
 
Band recalculation 

 

This function allows you to convert spectra to spectra with a smaller number of bands, e.g. from FFT 

to 1/12 Octave or from 1/3 Octave to 1/1 Octave etc. 

  
Figure 8-25. Band recalculation. 

 

This function works for both single spectra and spectral loggers. 

Note: You can also recalculate the spectrum directly from the view sub-window using the Show 

results based on selected functions option (see Chapter 5.1.6). 

 
Spectrum comparison 

 

This function allows you to calculate the difference or ratio between two selected spectra. 

 
 

Figure 8-26. Spectrum comparison. 

Source data 

Output resolution 

First argument 

Operator 

Second argument 
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Filter recalculation 

 

This function allows spectra measured with one type of filter to be converted to spectra based on 

another type of filter, e.g. from filter A to filter B or from filter HP to filter KB, etc. 

 

 
 

Figure 8-27. Filter recalculation. 

 
FFT averaging 

 

The FFT averaging function allows the FFT spectrum averaged over a selected time range to be 

calculated using the results of the FFT measurement (logger or merged). 

 

Once the averaged FFT spectrum has been calculated, an FFT logger/merged recalculated sub-

window is opened containing the results of the calculation. 

 

 
8.2 OTHER FEATURES 
 

8.2.1 USING MARKERS WITH ENVIRONMENTAL NOISE DATA 
 

Markers can be defined on selected areas of the measurement data as a classification tool. Details 

on the use of markers can be found in Chapter 5.1.4. 

 

In the case of the Environmental Monitoring module, the markers can be used in conjunction with 

the advanced Calculator tool to simplify work with noise events. 

 

To process a period separately or to process data without an unwanted fragment: 

1. Switch to the Plot view. 

2. Create a marker containing the desired event and give it a name, e.g. Event1. 

3. Activate the Environmental Monitoring Calculator using the Calculator / Analyser: time history 

commands. 

4. Go to the Calculation period(s) panel of the Environmental Monitoring Calculator dialogue box. 

5. For processing only in the marked area, find the created marker in the list of periods and select it 

to perform calculations only in its area. 

Source data 

Filter in source 
data 

Output filter 
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6. To remove the selected event from the range of calculations, find the range of the inverted 

marker in the periods list, e.g. Event1 (inverted). Select it to perform calculations only outside the 

range of the marker. 

7. Calculate the desired functions using the selected period. 

This procedure is illustrated in the figure below. 

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 8-28. Using markers with environmental data. 
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8.2.2 BLOCKS/MARKERS GENERATOR 
 

The Blocks/markers generator allows you to define areas on the time axis according to one or more 

complex conditions and use them to create block selections and markers. 

 

The Blocks/markers generator can be opened using either the Tools menu command or the  

button on the Toolbar. 

Note: The Blocks/markers generator is only available if a panel containing results defined in the time 

domain (e.g. Logger results) is currently active.  

 

The procedure for creating blocks and markers is divided into three steps: 

1. Specify the time range in which any further conditions are to be considered. 

2. Specify one or more conditions, according to which blocks/markers will be generated. 

3. Specify the output, which can be new blocks/markers or changes to existing blocks/markers. 

 
Step 1 

 
Figure 8-29. Step 1 of the Blocks/markers generator. 

 

In Step 1, you should declare a time range – generally larger than the target range - within which the 

trigger conditions will be considered. All operations described in the following steps will only be 

performed within the time range specified here. 

 

Several conditions can be used in this step, all of which are linked by logical AND (i.e. adding any 

condition can only reduce the resulting time range). The possibilities include: 

• using existing block selections and markers (as well as their inversions), or the entire time 

history of results stored in the currently open file (Whole data), by checking the corresponding 

checkboxes in the list at the top of the window, 

• filtering the time history by time of the day by checking the Time period checkbox and specifying 

the start and stop time of the period to be considered, 
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• filtering the time history by days of the week by checking the Day of week checkbox and the 

checkboxes corresponding to the days of the week you want to consider, 

• filtering the time history by month by checking the Month checkbox and checkboxes 

corresponding to the months you want to be considered, 

• using a specific period between selected values of year, month, day of month, hour, minute 

and second by checking the Date checkbox and specifying the start and stop dates in the fields 

below. 

Once all the necessary conditions have been specified, proceed to Step 2 by clicking on the Next 

button. 
 
Step 2 

 
Figure 8-30. Step 2 of the Blocks/markers generator. 

 

Step 2 allows more specific and complex conditions to be configured. There are three conditions 

available, of which at least one - the trigger condition - should be specified (otherwise the entire area 

selected in Step 1 will be used for block/marker generation). 

 

The importance of the pre-trigger and post-trigger conditions can be understood by analysing the 

procedure for selecting time ranges according to the three conditions: 

1. A point on the time axis, for which the Trigger condition is met, is found. 

2. The time history is browsed towards earlier time values until a point meeting the Pre-trigger 

condition is found. 

3. The time history is browsed towards later time values until a point meeting the Post-trigger 

condition is found. 

4. The range between the points found in steps 2 and 3 is selected. 

Note: If the pre-trigger and post-trigger conditions are not met, only the point found in step 1 is 

selected. 

5. Steps 1–4 are repeated until all points meeting the Trigger condition have been considered. The 

areas selected in subsequent iterations are accumulated. 

6. Continuously selected areas whose duration is shorter than the specified Minimum duration or 

longer than the specified Maximum duration are discarded. 
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Figure 8-31. An illustration of the procedure for selecting a single time range according 

to conditions specified in Step 2 of the Blocks/markers generator. 

 

The Trigger condition test may consist of: 

• comparing the value of a measured parameter to a specified fixed value, or the value of another 

measured parameter, or to the value of another measured parameter offset by a specified fixed 

value, 

• comparing the value of the gradient of a measured parameter with a specified constant value, 

• both of the above comparisons being linked by a logical conjunction or disjunction. 

 
 

  
 

 

Figure 8-32. Specifying the Trigger condition in Step 2 of the Blocks/markers generator. 

 

The tests for the Pre-trigger and Post-trigger conditions can consist of comparing the value of a 

measured parameter with a specified constant value or the value of another measured parameter, 

or simply measuring a fixed time from the trigger point (if the Fixed time option is selected). 

 

The relational operators available for comparing parameters with fixed values and other 

parameters are: 

• = (equal to), 

• < (less than), 

• <= (less than or equal to), 

• >= (greater than or equal to),  

• > (greater than),  

• <> (not equal to). 

 

Once you have specified the conditions and (optionally) the minimum and maximum duration of the 

time ranges, proceed to Step 3 by pressingthe Next button. 
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Step 3 

 
Figure 8-33. Step 3 of the Blocks/markers generator. 

 

 

In Step 3 you can choose how you want to use the time ranges generated by the conditions specified 

in the previous steps. The options include: 

• creation of a new marker with a specified name, 

• creation of a new block selection (the previous block selection is deleted), 

• adding the time ranges to the current block selection, 

• removing the time ranges from the current block selection, 

• adding the time ranges to a selected marker, 

• removing the time ranges from a selected marker. 

After specifying the output, press the Finish button. 

 

Note: For details on block selection, see Chapter 4.2.2, paragraph Selection of data. For details on 

markers, see Chapter 5.1.4. 

 

Note: You can press the Finish button in earlier steps of the Blocks/markers generator. In this case, 

several things may happen: 

• If you configure settings in Step 2 or 3 and then go back to an earlier step using the Back 

button and press Finish, all the settings you configured will be taken into account. 

• If you press Finish in Step 1 or 2 and do not proceed to Step 3, Create new block selection is 

automatically selected as the output option. 

• If you press Finish in Step 1 and do not proceed to Step 2, no conditions other than the general 

ones selected in Step 1 are set and Create new block selection is automatically selected as the 

output option. 
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8.2.3 NOISE SOURCE IDENTIFICATION USING AI 
 

The AI Sound Source Classification Model of SvanPC++ enables automatic noise source recognition 

and classification by using artificial intelligence and machine learning. It employs machine learning 

algorithms to analyse recorded audio data, accurately categorizing sound sources into 28 distinct 

classes, such as industrial noise, traffic, and natural sounds. This model allows acousticians to 

automatically distinguish between cars, trucks, cargo trains, passenger trains, and aircraft, providing 

valuable insights into long-term noise patterns. 

 

The main application of the SvanPC++ AI model is in environmental noise management, particularly 

for urban noise and traffic. It is used to monitor, identify, and categorize various noise sources in 

cities, helping authorities and planners implement targeted noise reduction measures.  

 

The AI icon  on the Main panel, which is linked to the AI function, becomes active if you open an 

SVL file to which wave files are linked (or an SVL file contains event recordings). 

 

 
Figure 8-34. Active AI icon. 

 

 

When you press the AI icon, the ‘AI Sound Classification’ (BETA version) Wizard appears. It informs 

you about the types of noise that are being distinguished: 

• Industrial noise (industrial noise, explosion, construction noise) 

• Transport noise - vehicle (vehicle noise, vehicle horn, vehicle alarm) 

• Transport noise - railway (train, train horn) 

• Transport noise - aircraft (airplane, helicopter, drone) 

• Boat 

• Motorcycle 

• Emergency vehicle 

• Nature noise - animal (dog, bird, cat, another animal) 
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• Nature noise - weather (wind, rain, storm, other nature noise) 

• Human generated noise (speech, applause, music, gunshot, movement generated noise) 

• Other 

 

Figure 8-35. AI Sound Classification Wizard. 

 

When you use the Wizard for the first time, a box appears proposing you to accept rules.  

Pressing the Next button the Wizard prompts us to select an event source: an event-associated 

Marker (for example, for the SV 307 instrument this could be a weather event), all associated Wave 

files or data from a weather station (for example, the Rain marker, which marks the time when it 

rained). 

 
Figure 8-36. Selecting an event source. 
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Select the event source and press the Finish button. 

The AI module then analyses the SVL file and associated wave files and presents the results in the 

table of Events report on the left panel and the Logger results panel with the highlighted events on 

the right panel. 

 

 
Figure 8-37. View of the SvanPC++ after AI processing. 

 

 

To show markers associated with events, open the Configurator and select the required event in the 

Markers tree.  
 

 
Figure 8-38. Using Configurator to create markers associated with events. 
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The markers can be used in different ways, for example, you can use the Calculator to calculate the 

noise from the Train, etc (see Chapters 5.1.4 and 5.2). 

The Events report table is divided into periods: Day time (6.00 – 22.00) and Night time (22.00 – 6.00). 

For each period the Average SEL and Leq is calculated. 

Note: The Leq presented in the Events report table is referenced to the Day time or Night time period.  
 

 
Figure 8-39. Using Configurator to create markers associated with events. 

 

 

Double-clicking on a cell in the Valid column excludes the event from the calculation of the SEL and 

Leq results. 

 
Figure 8-40. Excluding events from the SEL and Leq calculation. 
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The Events report panel has tree additional icons that allow you to: 

-  – adds a column where Notes can be entered 

 
Figure 8-41. Added Notes column. 

 

 

-  – adds a Counter column where you can change the number of 

events 

 
Figure 8-42. Added Counter column. 
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-  – changes the layout of the table by extending it to the right with additional columns 

from Time to Notes for further events originally placed vertically 

 
Figure 8-43. Different table layout. 
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9 CALCULATOR OPTIONAL TOOLS 

 

 

The Environmental Monitoring (EA), Dose Measurements (DM) and Building Acoustics (BA) modules 

provide more advanced tools for data analysis and recalculation in relation to the basic Calculator 

tool described in Chapter 5.2. This is realised by unlocking additional features of the Calculator that 

are disabled in the free version of SvanPC++. This chapter presents these additional possibilities of 

the Calculator tool and methods of using them. 

 

Once the EM or BA module has been activated (the DM module doesn’t need to be activated), the 

corresponding item in the Calculator pull-down menu is enabled. To use the recalculation tools 

specific to the module purchased, open the Calculator pull-down menu by using the Tools » 

Calculator command or by clicking on the  icon in the Main Toolbar and selecting a sub-module 

from the menu. 

 

 
 

 

 

 

 

 
Figure 9-1. Accessing the module-specific Calculator tool. 

 

Note: For details of how to view the results of calculations, see Chapter 5.2.6. 

 

 

 

9.1 USING THE CALCULATOR DIALOGUE BOX 
 

After selecting a Calculator function, the Calculator dialogue box appears.  

 

All the results available for recalculation are displayed in the list on the left of the window. By clicking 

on the checkboxes next to the names of the functions, you can select / deselect the functions you 

wish to calculate. You can select multiple results for simultaneous calculation. The results are 

displayed in tree mode, grouped by category. By selecting a branch containing multiple results, you 

can select all the results belonging to that category. 

 

Different settings are available for each result. Some settings are common to all results, but all of 

them can be configured separately for each result. The right-hand side of the Calculator dialogue box 

allows you to configure the settings for a particular result after selecting it from the list, or simply by 

clicking on its name if it is already selected. 

 

The Calculator settings are divided into 3 subsets: 

• Channels and profiles, 

• Parameters, 

• Calculation period(s). 

Functions available in 
the basic SvanPC++ 

package 

Functions available 
after activating relevant 

SvanPC++ modules 
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You can select a set of options by clicking on a tab at the top right of the window. 

 

 
 

Figure 9-2. The Calculator dialogue box. 

 

 
9.1.1 CHANNELS AND PROFILES 
 

The Channels and profiles settings allow the selection of the data set to be used for recalculations. 

All available measurement channels and profiles for the currently open data are listed in this panel. 

The grey items represent data for which the selected calculation is not available. To select data, click 

on the appropriate checkboxes. Clicking on a checkbox next to a channel name will select all profiles 

available for the selected channel. Similarly, clicking on a checkbox next to a profile name will select 

all channels available for the selected profile. 

 

Result 
functions 
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Sets of options 
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Press to start 
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Figure 9-3. Channels and profiles panel of the Calculator dialogue box.  

 

Note: For some result functions calculated on specific data, this data selection mode is disabled.  

 

Sometimes more options are available, such as selecting the function used as the data source for the 

calculation (if there is more than one); to view these options, use the Show advanced button. 

 

 

9.1.2 PARAMETERS 
 

The Parameters panel allows you to configure the result-specific parameters of calculations. The set 

of parameters available for configuration depends on the currently selected function. For details on 

the functions available in a particular SvanPC++ module, see the chapter related to that module. 

 

 
Figure 9-4. Parameters panel of the Calculator dialogue box for the VECTOR function. 
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9.2 SPECIFYING CALCULATION PERIODS 
 

The Calculation period(s) settings allow you to select the time domain range for which calculations 

are to be performed. 

  
 

Figure 9-5. Calculation period(s) panel of the Calculator dialogue box. 

 
Periods 

 

The Period section allows you to select a subset of data to be used for calculations. 

• The Whole data marker is always available, enabling to perform calculations on the whole data. 

• If a Block selection has been made in the current view, you can choose to perform calculations 

only on the selected data. You can also choose to perform inverted selection, which means that 

all data outside the current Block selection will be calculated. 

• If Markers are defined on the data, you can perform calculations on the time periods specified 

by the markers or outside of them. 

 

You can select more than one period. The selected result(s) will be calculated separately for each 

period. 

 

The table below the Period panel shows the start and end points of all the separate time ranges 

included in the selected period. 

Available periods 

Time ranges contained 

in the period selected 

on the list 

Type of results 

Check to enable 

calculation in intervals 

Total available time range Press to set 

 interval start/stop 

= file start/stop 

Intervals settings 
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Note: You can use the Inverted block selection to remove a selected fragment of data from the 

calculations. It is also possible to use the Period data selection mode at the same time as using 

calculation on intervals mode. 
 

 

Running / Total values 

 

The buttons in the centre of the window allows you to choose whether to calculate Running values, 

Total values or both. 

• Running values – this option should be used if changes in the calculated result values during 

each interval / period are to be considered. 

• Total values – this option should be used if only the final results of the calculations are to be 

considered. 

 

Note: In the case of recalculated Total values results, a specific View sub-window type is available, 

which displays result once for each calculation period, together with information about the period. It 

is described in Chapter 4.3.2. 

 
Cumulation of results 

 

Ability to cumulate results refers to calculations performed on non-continuous blocks of data. 

• In non-cumulating mode, the selected result(s) are calculated independently for each separate 

block of data, restarting the calculation at the starting points of each block of data. 

• In cumulating mode, the result(s) are calculated as if all the separate blocks of data were one 

continuous selection, without restarting the calculation. 

You can collect cumulative and non-cumulative results at the same time by selecting the Both option. 

Note: This option is not available for some results. It is also not possible to calculate on intervals with 

the Cumulate option. To make the Cumulate option available, uncheck the Calculate in intervals 

checkbox. 

 
Intervals 

 

You can also choose to perform the calculations in intervals. To do this, click on the Calculate in 

intervals checkbox. You can then select the start and stop time of the intervals and the interval period. 

 

The time range in the currently open file is displayed at the bottom of the window. Pressing the Reset 

start/stop button will set the interval start/stop time to the file start/stop time. 

If you choose to calculate on intervals, the common part of the set intervals and the selected periods 

will be used for the calculation. 

Note: If the selected interval start time does not match the logger step, it will be adjusted 

automatically. 

 

When the Calculator dialogue box is reopened, the last settings for the interval start/stop time and 

period are reloaded if possible. If the last used settings do not fit the available data range , they are 

automatically set within the limits of the available data. If the Fixed start time option is enabled, the 

specified start time will be remembered by SvanPC++ together with other calculator settings. 

Therefore, even if another file contains results of measurements performed on different dates, the 

start time of the intervals will automatically be set as specified, e.g. at 6:00 am. 
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Note: With the Fixed start time option, the start time can also be saved calculator settings (saving 

calculator settings is only possible in the Projects module, see Chapter 10.6.2). 

 
Periodic results 

 

For some results, settings relating to the calculation period are also available in the Parameters panel, 

e.g. Lden, Ldn, Ld, Le, Ln results. The period used for calculations is then equal to the common part 

of the Parameters and Calculation period(s) settings. 

 
Time display mode 

 

You can choose to work with absolute or relative time values. To do this, open the Main Options 

dialogue box using the Tools » Main options command or by clicking on the  icon on the Main 

Toolbar. Then go to the General settings and use the buttons in the Time panel. 

 

  
 

Figure 9-6. Time settings in the Main Options dialogue box. 

  

General 
settings 

Time mode 
selection 
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10 SVAN PC++ PROJECTS 

 

 

The Projects feature is a useful tool that allows you to manage multiple files of different types and 

group them in a project file, modify and save data views, and create reports using the measurement 

data contained in a project. 

 

This function is included in the free version of the SvanPC++ software.  

 

A Svan Project is a structure in the form of an .svp  file containing files downloaded from Svantek 

instruments and other types of files. 

 

 

10.1 CREATING PROJECTS 
 

To create a new project, use the New project command from the File menu or the  button on 

the Main Toolbar. In the opened New project dialogue box, fill the Title and Comment fields and select 

the Project type by clicking on the appropriate icon on the left. The created project will be empty. 

 

  
 

Figure 10-1. Creating project with New Project Wizard. 

 

You can also create a new project from the data files currently open in SvanPC++. This way you can 

save all the changes you have been made to the data file. Use the Save as Project command from the 

File menu. All other files will be closed when you start working with a Svan Project. 

 

Once a project has been created, you can add data to it using the Add file… command from the File 

menu.   

 

Once you have created the Standard Project, you can import data from another project into the new 

one. To do this, use the Import » Data from another project command from the File menu. The Import 

data from another project window appears when you select and double-click the project from which 

you want to import data. 

These project 
types are 

available after 
activating the 

corresponding 
modules 



                                                                                     SvanPC++ User Manual   

 

170 

 
 

Figure 10-2. Importing data from another project. 

 

Imported data can include Objects, Sessions and Reports. 

Note: When a Session is imported, the Object used to create it is also imported. 

 

To import data, select it from the list on the right-hand side of the window and press the  button. 

To change the project from which data will be imported, press the Open project button. 

 

Note: For Standard projects, files are copied into the project. To reduce the size of the project, Simple 

projects use links to files by default, but you can also copy files into the project.  

 

 

10.2 USING THE PROJECT BROWSER 
 

When a Svan Project is opened, the Project Browser is automatically displayed on the right side of the 

SvanPC++ screen. The Project Browser can be expanded by clicking on it and can also be hidden/ 

shown using the Project Browser command from the View menu. 

 

 
 

Figure 10-3. The Project Browser. 
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Managing files 

 

A list of files that are included in the current project will be displayed in the Project Browser. It is 

divided into three sections: 

• Project Objects – files containing measurement data and other related information used in the 

project. This can include calculation results, photographs, graphics, images, report templates, 

etc. 

• Project Sessions – sessions used to display data in the form of tables, graphs, etc., such as the 

ones described in Chapter 4.3.2, which you can modify and save. 

• Project Reports – Microsoft Word documents containing measurement data, results, etc. 
 

Moving the Project Browser 

 

You can change the location of the Project Browser in two ways: 

• By pressing the  icon, then left-clicking anywhere in the Project Browser header and moving 

the mouse without releasing the button (this action activates Floating mode), or 

• With the Dock left / Dock right commands in the pull-down menu opened by right-clicking 

anywhere in the Project Browser area, you can place the Project Browser on the left or right 

side of the SvanPC++ window. 
 

 
 

Figure 10-4. Commands for docking the Project Browser. 

 

If, after changing the location of the Project Browser, you wish to dock it again, right-click anywhere 

on the Project Browser header and select Docking mode from the pop-up menu. 

 

 
 

 Figure 10-5. Docking the Project Browser. 
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10.2.1 PROJECT OBJECTS 
 
Adding data 

 

You can add data files to the project in a number of ways: 

• using the  Add button, located on the Toolbar; when you are working with a project, this 

button is used to select files to add to the Project Objects list. 

• by selecting the file in the Windows Explorer and dragging it to the Project Objects list, 

• using the Add file command, available after right-clicking on Project Objects or a folder 

contained in this list. This command activates the Open File dialogue box where you can select 

the file to be added. 

 

 
 

Figure 10-6. Adding files to the Project Objects. 

 

The Save active view data as object command allows you to create a virtual Project Object containing 

all the data used to create the current active view. 

 
Managing data 

 

You can manage the files in the Project Objects list in sub-catalogues. 

• To create a new folder, right-click on Project Objects or the name of an existing folder and select 

New folder from the menu. The new folder will be created in the selected location. 

• To move a file to a folder, left-click and drag to the desired location. 

• To rename a file, right-click on its name and select Rename. You can also use the F2 key or 

double-click on the file name. 

• To delete a file from the project, right-click on its name and select Delete. You will be prompted 

for confirmation. 

 

Note: Any changes you make to the files in the project, such as renaming them, will not affect the 

original files. If you delete a file from the current Svan Project, the original file is not deleted. 

Note: If you try to delete an object that has been used to create sessions that are included in the 

current Project Sessions, you will be asked for additional confirmation. You can also choose whether 

or not SvanPC++ should automatically remove the session folders that remain empty after the the 

object has been deleted. To set this option, tick the Remove empty sessions checkbox. 
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Figure 10-7. Removing empty views from the Project Objects. 

 

 
Creating sessions from data 

 

To start working with a result file and create a session, do one of the following. 

• Right-click on the file name. A menu will open containing all the view types (described in 

Chapter 4.3.2) available for the selected file. Select one to create a session of the selected type. 

• Right-click on the file name and select Create default session to create a session according to 

the priority list specified in Main Options » Views settings. If none of the types specified in the 

Opening priority list is available for the selected file, a Header Info session will be created. The 

same can be done by double-clicking on the file name. 

• If you select more than one file, the results of these files will be merged during session creation 

(see Chapter 10.6.1). 

 

When you create a session using the Project Objects, a view is automatically created in the Working 

Area. A corresponding folder is created in the Project Sessions list. 

 

 

 
 

Figure 10-8. Creating sessions using the Project Objects list. 
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10.2.2 PROJECT SESSIONS 
 

The Project Sessions list contains data displayed in SvanPC++ sessions created in the current Svan 

Project using Project Objects. 

 

A feature of the Svan Projects module is that changes made while working with sessions can be saved 

and reloaded when you open the project. 
 
Creating sessions 

 

New sessions can be created from the measurement data using the Project Objects list as described 

in the Creating sessions from data section in Chapter 10.2.1. 

 

If there is at least one session in the Project Sessions list, you can create a copy of it. To do this, right-

click on the session name and select Duplicate session. A new session, identical to the duplicated one, 

will be added to the list. 

 

 
 

Figure 10-9. Duplicating a Project session. 

 

Managing sessions 

 

Sessions are grouped into separate folders containing all the session types available for the 

measurement results, listed in the Data sub-catalogue. 

 

 
 

Figure 10-10. Project session folder structure. 

 

When sessions are created from multiple files, they are automatically named "Session (#)", where # 

is the lowest unassigned number. When sessions are created from a file, the session name inherits 

the name of that file. 
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There are three ways to change the name of a session folder: 

• Right-click on the folder name and select Rename. 

• Double right-click on the folder name. 

• Press F2 with the folder name selected on the Project Browser list. 

Note: Session folders names cannot contain any of the following characters: / \ : * ? " < > | 

 

You can delete a session folder by right-clicking on its name and selecting Delete. You can also press 

the Delete button with the folder selected in the Project Browser list. 

• All data contained in this folder will then be deleted. However, the corresponding 

measurement results file (contained in the Project Objects list) remains unchanged. 

• You can also delete several sessions at once. To do this, select all the folders to be deleted (click 

on their names while holding down the CTRL or Shift key) and press the Delete button. 
 

 
Opening sessions 

 

To open a session window in the working area, do one of the following. 

• Right-click on a session folder in the Project Browser to open a pull-down menu with the names 

of all the view types available for the data used to create the selected session. Selecting a view 

type from the menu creates a view of that type. 

• Select Show session from the same pull-down menu to create a view of the type specified in 

Main Options » Views settings. If none of the types specified in the Opening priority list is 

available for the selected data, a Header Info view will opened. The same can be done by 

double-clicking on a session folder. 

• All the available views are also listed in the session folder. To open a selected view, double-click 

on its name or right-click on the session name and select Show session. 

 

 
 

Figure 10-11. Opening sessions using the Project Sessions list. 

 

 

Note: When a view is created, you can work with it in the same way as external projects. However, if 

you want to save the view with some changes, it will be saved as a project. 
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10.2.3 PROJECT REPORTS 
 

A report is a file in the Microsoft Word format created using the use of objects and sessions contained 

in the project. 

 

Note: To work with reports, you must have MS Word installed on your PC. 

 

 
Creating reports 

 

To create a new report, right-click on Project Reports in the Project Browser and select New report. 

 

This will open MS Word and automatically create a new blank document. A new object named 

"Report (#)" will also appear in the Project Reports list, where # is the lowest unassigned number. This 

name can then be edited manually. 

 

 

 
 

Figure 10-12. Creating a new report. 

 

The report can only be viewed in MS Word. If you close the report document, you can reopen it by 

right-clicking on the report name and selecting Show report. 

 

 
 

Figure 10-13. Reopening a report. 

 

 

To delete a report, select it from the Project Reports list and press the Delete button. You will be 

prompted for confirmation. 

 

 

 
 



                                                                                     SvanPC++ User Manual   

 

177 

 

Adding data 

 

You can add files of various types to the report document by clicking on the files in the Project Browser 

area and dragging them onto the report file name in the Project Reports list. 

 

Adding objects such as images, text, etc. simply pastes them into document. 

 

Adding session content from the Project Sessions list can be done in two modes, selected from the 

Projects Toolbar: 

• as bitmaps - in this mode the session is displayed in a stable image form, but cannot be 

modified, 

• as metafiles - n this mode it is possible to modify the session in MS Word, but its display may 

not be stable. 

 

Objects added to the report are inserted at the current cursor position in the report document. 

 

The easiest way to add session content or image files to the report is to simply drag them from the 

Project Browser directly into the MS Word document, as shown in the figure below. 

 

 
 

Figure 10-14. Adding data to report by dragging objects from the Project Browser to MS Word. 
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10.3 PROJECTS TOOLBAR 
 

The Projects Toolbar contains useful tools that are specific to working with projects reports. You can 

show/hide the Projects Toolbar using the Projects Toolbar command from the View menu. The 

controls available on the Projects Toolbar are listed in Table 10-1. 

 

 
Table 10-1. Projects Toolbar buttons. 

 

Button 

 

Function 

 

 
− User function wizard (see Chapter 10.6.3) 

 
− Data search (see Chapter 10.5) 

 
− Toggle drag mode 

 
− Enable/disable dragging of current spectrum from 

active logger spectrum view  

 
− Include table header 

 
− Drag table selection (button pressed) or all data 

 
− Include fonts and colours when dragging table 

 
− Drag plot as bitmap 

 
− Drag plot as metafile 

 

− Keep templated objects when generating report from 

template (see Chapter 10.4.3) 

 
− Automatically create missing sessions when generating 

report (see Chapter 10.4.3) 

 
− Tile main and report window horizontally 

 
− Show Report templates browser (see Chapter 10.4.4) 

 
− Generate report for current project (see 

Chapter 10.4.4) 

 

− Include map when copying Measurement Tracking 

views to reports 
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Drag mode 

 

Drag mode is a tool that allows you to easily add data to a report. To toggle the drag mode on/off, 

use the  button. When drag mode is enabled, the mouse pointer changes to . 

 

With drag mode enabled, you can grab the contents of a Plot view and drag it into the window of 

another application, such as MS Word. 

  
Dragging the current spectrum 

 

The Dragging of current spectrum from active logger spectrum tool allows you to drag the currently 

displayed spectrum from a Logger spectrum view and drop it into another view sub-window as a 

reference spectrum. 

Note: When using this tool, only a single spectrum corresponding to the currently displayed time is 

dragged, as opposed to using the  button to drag the entire spectral logger. 

 

To enable/disable dragging of the current spectrum, use the  button. This is particularly useful 

when you need to view a time history of spectral results superimposed on another single spectrum. 

 

 
Include table headers button 

 

The  button can be used to configure the parts of the table view that are to be copied to the 

report. 

 

If the Include table header button is pressed, when you add a Table view to a report, the table view 

is copied along with the columns and rows containing information about the table contents. 

 

If it is not pressed, only the cells containing numerical data are copied. 

 

 
 

Figure 10-15. Parts of the Table view, which are copied only if 

the Include table header button is pressed (marked in red).  
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Table drag modes 

 

The mode of adding Table views to the report can be toggled using the  button. Two modes are 

available: 

• Drag table selection mode - in this mode, only the selected cells are copied to the report. If 

there is no current selection in the table view, the whole table is copied. This mode is active 

when the Drag table selection button is pressed. 

• Drag whole data mode - in this mode, the entire table is copied to the report, even if there is 

there is a current selection of cells in the table view. This mode is active when the Drag table 

selection button is not pressed. 

 

 
Include fonts and colors button 

 

The  button can be used to configure the settings for the copying of Table views to the reports. 

 

If the Include fonts and colors button is pressed, the Table views are copied to the reports with the 

current table font and colour settings. 

 

Otherwise, tables added to the report will include the font and colour set in MS Word. 

 
 
Plot dragging modes 

 

The  /  buttons can be used to set the mode of exporting sessions to reports. 

 

Two modes are available: 

• Drag plot as bitmap (BMP), 

• Drag plot as metafile (EMF). 

 

In BMP mode the sessions are displayed in a stable image form, but cannot be modified. In EMF mode 

it is possible to modify the session in MS Word, but the display may not be stable. 

 
 
Tile horizontally button 

 

The  button can be used to set the screen configuration to make it easier to work with SvanPC++ 

and a report at the same time. After pressing this button, the SvanPC++ application window will fill 

the left half of the screen, while the MS Word report document window will fill the right half of the 

screen. 

 
 

Measurement tracking views 

 

Measurement tracking views can be opened by creating sessions using imported .SVMT files. 

 

Note: .SVMT files can be created using SvanMobile, an application for mobile devices running on 

Android. For details, visit: http://svantek.com/software/svanmobile-new.html. 

http://svantek.com/software/svanmobile-new.html
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Figure 10-16. Measurement tracking view. 

 

A Measurement tracking view contains additional information about the measurement, such as 

location, photos, voice comments, etc. 

 

The  button on the Projects Toolbar allows you to enable or disable the inclusion of maps 

containing measurement locations along with other measurement tracking information when 

exporting Measurement tracking views to reports. 

 

 

 

10.4 REPORT TEMPLATES 
 

Report templating is a special feature useful for creating reports. The report templates have the same 

form as a report, but they can contain templated objects. When you generate a report based on a 

report template, all templated objects are replaced with views, parameters or results taken from 

objects contained in the current Svan project. 

 

 

10.4.1 CREATING TEMPLATES 
 

The report templates contained in the current Svan project are listed in the Project Browser » Project 

Reports list. 

 

To create a new report template, right-click on the name of the Project Reports list (or a sub-

catalogue) and select the New report template command. 
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Figure 10-17. Creating a New report template. 

 

 

Report templates are created as MS Word documents (just like reports) named "Report template (#)" 

where # is a number. When you create a report template, the corresponding MS Word document is 

automatically opened. 

 

 

 

10.4.2 EDITING TEMPLATES 
 

The constant parts of the report templates are edited directly in MS Word. 

• The MS Word document corresponding to the report template is automatically opened when 

a new template is created. 

• To open the corresponding document manually, right-click on the name of the template you 

wish to open and select the Show report command. 

 

  
 

Figure 10-18. Opening a report template in MS Word. 

 

 

You can use the Report Template Editor dialogue box to edit the templated objects. 

• This dialogue box opens automatically when you create a new template. 

• To open the Report Template Editor manually, right-click on the name of the template you wish 

to edit and select the Edit report template command. 
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Figure 10-19. Opening the Report template editor. 

 

Note: Templated objects are added to the MS Word document in the form of comments containing 

code understandable by SvanPC++; it is recommended to edit template objects using the Report 

template editor and not to modify the corresponding comments directly in MS Word. 

 
 
Report template editor 

 

 
 

Figure 10-20. Report template editor dialogue box. 

 
The name of the template currently being edited is displayed in the Current template field at the top 

of the window. 
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The templated objects included in the current report template are listed in the Templated objects list 

on the left of the window. To add a new templated object, do one of the following: 

• Press the Add button. 

• Select a templated object from the list and press the Duplicate button. A copy of the selected 

object is created. 

• Select an object from the Project Browser list and drag it to the Templated objects list. 

 

The new objects can be added: 

• at the current cursor position in MS Word, or 

• at the end of the report template document. 

To decide, use the buttons in the Place templated object at panel located on the right side of the 

window. 

 

Note: If an MS Word warning window appears stating that comments must be added to the main 

text, this means that the cursor in MS Word is currently in a comment text where it is not possible to 

add templated objects. To add a templated object, you must move the cursor out of the comments 

in MS Word. 

 

To edit the templated objects, use the Template object editor. It opens automatically when you add 

a new templated object or drag an object from the Project Browser and drop it to the Templated 

objects list. You can also activate it manually by selecting a templated object from the list and pressing 

the Edit button. It allows you to specify the data source and parameters of the templated object. 

 

There are several types of data sources for the templated objects: 

• View – a SvanPC++ view, as described in Chapter 4.3. 

• Calculation parameter – a value of the parameter related to calculations performed in 

SvanPC++. 

• Special result – a result of calculations, representing a single value (e.g. penalty factor in case 

of tonality measurements). 

• Result – a result of the measurement or calculation. 

• Measurement parameter – a value of the parameter related to the measurement, such as the 

type of Svantek instrument used. 

• Template constant – a parameter that will be constant for all reports generated using the 

particular template. 

• Microsoft Excel Chart – a chart in MS Excel format. 

You can select the source type for the current templated object from the Source type menu. 

 

If the Path option is checked, an object from the specified path will be used as the source for the 

templated object. Otherwise, all the objects matching the specified criteria are searched for. 

The Path field is automatically filled when a templated object is created by dragging an object from 

the Project Browser into the Report template editor. 
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Figure 10-21. Template object editor. 

 

The source parameters can be configured to specify the data source for the templated object. 

Different parameters are available for different types of sources. 

If you want to use one of the parameters to define the source, tick the box next to its name and set 

the required value. 

 
Table 10-2 Source parameters available in the Template object editor. 

 

Parameter name Source types Function 

Window type View Allows you to select one of the view sub-window types 

to replace the templated object with. 

View type View Allows you to select one of the view forms in which 

the view will be displayed. 

Calculation 

parameter type 

Calculation parameter Allows you to select the calculation parameter to 

replace the templated object with. 

Special result Special result Allows you to select the kind of special result to 

replace the templated object with. 

Measurement 

parameter type 

Measurement 

parameter 

Allows you to select the measurement parameter to 

replace the templated object with. 

  



                                                                                     SvanPC++ User Manual   

 

186 

Spectrum type Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to select the domain of the data used as 

the source for the templated object. 

Function type Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to select the function (measured or 

recalculated) to be used as the data source. 

Value type Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to select the type of result to replace the 

templated result: 

Standard - value received from a Svantek 

instrument, 

Running / Total - values obtained using the 

Calculator tool. 

Channel Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to specify the channel number used for the 

measurements whose results are to be used. 

Profile Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to specify the profile number used for the 

measurements from which results are to be used. 

Result type Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to specify whether to use logger or simple 

results. 

Calculated result Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to specify whether to use calculation 

results or not. 

Cumulated result Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

Allows you to specify whether to use cumulated 

calculation results or not. 

Marker name Calculation parameter, 

Result, Special result, 

Measurement 

parameter 

If you wish to replace the templated object with the 

calculation results performed in time periods defined 

by a marker, this parameter allows you to specify the 

name of this marker. 

Time range Result Allows you to specify a range of the time domain from 

which the results should be taken. The time range can 

be configured using the Time range dialogue box. 
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Frequency range Result, Excel Chart Allows you to specify a range of the frequency domain 

from which the results should be taken. The frequency 

range should be specified by entering the minimum 

and maximum frequencies in Hz, separated by a 

hyphen. Several ranges can be selected, separated by 

a comma. 

(e.g.: “1.000-2.000,8.000-16.000”) 

Ln range Result, Excel Chart Allows you to specify a range of the Ln domain from 

which the results should be taken. The Ln range 

should be specified by entering the minimum and 

maximum Ln values, separated by a hyphen. It is 

possible to select several ranges, separated by a 

comma. 

(e.g.: “L80,L90,L95-L99”) 

RT60 results filter Result, Excel Chart Allows you to select reverberation time calculation 

methods, the results of which will be included in the 

report. 

Logger total result Calculation parameter, 

Result, Special result 

Allows you to specify whether to use logger total 

results or not. 

Tags query All Allows you to specify a query for finding source 

objects using the Data search tools described in 

Chapter 10.5. 

Orientation View Allows you to specify whether a Table view should be 

included as normal, transposed or unchanged (see 

Chapter 4.2.1). 

Name Template constant Name of the template constant parameter. 

Value Template constant Value of the template constant parameter. 

 

 

The time range can only be defined using the Time range dialogue box, opened by the Edit button, 

which becomes active after the Time range parameter has been checked (Figure 10-22). It can be 

specified in absolute or relative time: 

• Absolute - represents the actual measurement time as saved in the results file. 

• Relative – the first sample time is set to 00:00:00 of the first day of the measurement and all 

subsequent sample times represent the time elapsed since the measurement of the first 

sample. 

To select the time type, use the selectors at the top of the window. The time range can also be made 

up of several separate time periods. To add a time period, you must: 

1. Specify the Begin time of the new period: 

To select the date, use the  button that activates the calendar window. 

To select the time, click on the hours, minutes or seconds and use the  buttons to increase / 

decrease the value. 

Note: For relative times, the date is not available. 

2. Set the End time of the new period in the same way as the Begin time. 
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3. Press the Add button. 

 

 
 

Figure 10-22. Time range dialogue box. 

 

The Formatting parameters tab allows you to: 

• Specify a text string to be included in the report instead of the templated object if no data is 

found that meets the conditions specified in Source parameters. To enable this option, select 

the If no source is matched... checkbox. 

• Select to format the results as: 

o Table - a standard MS Word table with rows containing individual data and columns referring 

to different information, 

o List - a list of results with each data on a separate line, with different information separated 

by a comma, 

o Text - results in raw text form with individual data on separate lines. 

• Select the unit in which the results to be displayed: 

o Logarithmic (dB) 

o Linear metric (Pa, m/s2, m/s, m) 

o Linear non-metric (g, ips, mil) 

• Select the time domain type in logger results (Logger time type): 

o Absolute - represents the actual measurement time, as saved in the results file. 

o Relative - the first sample time is set to 00:00:00 of the first day of the measurement and 

subsequent sample times represent the time elapsed since the first sample was measured. 

• Configure the following settings fir the display of the values (Values formatting): 

o Fixed-point / Scientific and Precision of the numbers displayed. 

o The symbol used as Decimal separator in all displayed numbers ( , / . / system default), 

o dB resolution - the precision with which logarithmic values are displayed (0.1dB / 0.01dB). 

o Time span format - the way time values are formatted, including hours, minutes, seconds 

and milliseconds. 

o Linear unit prefix – use the unit prefix milli, micro, nano, pico or none. 

• Select the information to include: 

o Add unit, 
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o Add result header, 

o Add result. 

 

 
Figure 10-23. Formatting parameters tab. 

 

 

The View parameters are available if the source type for the templated object has been specified as 

View. 

• The Plot parameters allows you to configuring plot options, such as axis limits and background 

colour, if the source is a Plot view and you want them to differ from the options configured in 

Main Options / Graph view and Local Plot Settings. 

• If you enable the Screen-by-screen export option, the plot will be divided into several figures, 

each containing data measured in a different time range. The length of the time ranges can be 

specified in the Interval field. 

• The Proportions option allows you to specify the shape of the resulting figure. 

• The Units panel allows you to select the units in which sound and vibration levels will be 

presented in this template object. 

• The Visible results query allows you to filter the data using Data search tools. 
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Figure 10-24. View parameters tab. 

 

 

Press the OK button to save the settings and close the Template object editor,. 

Press the Cancel button to discard the changes and close the Template object editor. 

 
 

Including templated Microsoft Excel charts 

 

To include an MS Excel chart into a report template, perform the following steps: 

• Insert an MS Excel Chart object into the MS Word document corresponding to the report 

template being edited (Insert >> Object >> Object >> Microsoft Excel Chart). 

• Still in MS Word, define the data series for the chart and configure the appearance of the chart. 

• Select the chart in MS Word. 

Note: The chart should not be opened in Edit mode in MS Word; you must quit editing and simply 

click on the chart to select it. 

• In the Report template editor, add a new templated object and in the Template object editor 

define its Source type as Microsoft Excel Chart. 

• Specify the chart parameters in the Source parameters tab and assign SvanPC++ tag queries to 

the Excel data series in the Excel chart parameters tab. 
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Figure 10-25. Excel chart parameters tab. 

 

 

To add/remove series, use the Add and Remove buttons below the series list. To edit series 

parameters using Data search tools, use the panel to the right of the series list. To specify the function 

that will be the data source for an Excel chart's data series, the Source function tag query should have 

the form: 

 
Results = [...] 

 

It is also possible to add other conditions to the data series, such as: 

 
Results = PEAK AND Filter = C 

 

When generating reports, SvanPC++ fills the charts with data by using tag queries to search for 

measurement results that match the Excel data series. 

 

In the Formatting parameters tab, you can also decide whether to include units, headers, and results 

(see figure below). If you choose to include headers, the names of the series will be changed. 
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Figure 10-26. Formatting parameters of a templated MS Excel chart. 

 

 

10.4.3 GENERATING REPORTS FROM TEMPLATES  
 

The main purpose of using report templates is to easily create reports that contain constant text parts 

together with templated objects, depending on the results files and other project objects. 

 

To generate a report based on a report template, drag a session you want to use with the template 

from the Project Sessions branch and drop it on the template in the Project Reports branch. If there 

is only one file/session in the current project, you can also use the Generate report from template 

command available after right-clicking on the template. 

 

 
 

Figure 10-27. Generating reports from templates. 

 

Once a new report has been created, it is added to the Project Reports list. The corresponding MS 

Word document is opened automatically. All templated objects will be replaced with proper text, 

tables, pictures, etc. The report can also be generated in the PDF format by using the Generate PDF 

report from template command. 

 

The Regenerate report command causes the report to be generated again, replacing any templated 

objects that were not replaced during the previous generation of the report. No new report file is 

created; if there are no non-replaced templated objects, the Regenerate report command has no 

effect.  
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Note: If the report has been generated using the Keep templated objects when generating report 

from template option (available from the Projects Toolbar, described in Chapter 10.3), information 

about templated objects is retained in the report even if they have been replaced; in this case, the 

Regenerate report command replaces all the objects again, taking into account the latest changes 

made in the sessions. 

 
Selecting from multiple available data sources 

 

If there are multiple results matching the criteria specified for a templated object, the Report 

template multi sources dialogue box will appear, allowing you to select the source for the templated 

object replacement. 

 

All the objects that can be used to replace the templated object are displayed in the list. To select 

one of them, click on it and press the OK button. 

 

If you press the Skip button, the templated object will not be replaced (it will keep the form of the 

"SvanPC++" text with an associated comment). 

 

Pressing the Skip all button will skip the current templated object and prevent the Multi-sources 

dialogue box from being activating if subsequent templated objects can also be matched by multiple 

objects. 

 

 
Figure 10-28. Report template multi sources dialogue box. 

 

 

Note: To see which of the templated objects is currently being used, look in the MS Word document 

that contains the report template being used. The text, corresponding to the templated object for 

which multiple sources are found is automatically selected in MS Word. 
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• If you enable the Apply selected source to next multi source choices option, the source you 

select will be used every time in the future when there are many sources matching the 

templated objects and the selected source is one of them. 

• The Apply selected source parent... option works in a similar way, but it affects the source 

"higher" in the tree than the one selected, e.g. if you select a particular result, the session from 

which that result was taken will be considered in the future. 

 
Generating reports series 

 

A series of reports can be generated separately for several different datasets at the same time using 

the Generate reports series command. The Project Objects for which reports are to be generated can 

be selected from a dialogue box that appears when this command is activated. 

 

 
Figure 10-29. Dialogue box allowing for the selection of Project Objects used for generation of a project series. 

 

Objects can be selected by ticking the checkboxes next to their names in the list to the right of this 

dialogue box. This list is filtered by a Tag value selected in the Select tag category list. Reports in the 

series can be generated in PDF format by selecting the Convert reports to PDF option. 

 
Additional options 

 

You can enable/disable the Keep templated objects when generating report from template option 

using the  button available in the Projects Toolbar. If this option is enabled, the MS Word 

comments used to store templated objects will not be removed during report generation. Therefore, 

the generated reports remain valid report templates, although the templated objects are replaced 

with proper data and figures. 

 

The Automatically create missing sessions option (the  button) can be used to specify the 

behaviour of the program if none of the sessions contained in the current project matches the 

parameters of a templated object of the View type: 

• If this option is disabled, the templated object will be skipped. 

• If this option is enabled, SvanPC++ will try to create a new session that fits the parameters of 

the templated object. 
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Note: Automatic session creation is based on tag queries defined in the Tags query and View 

parameters >> Visible results query fields in the Template object editor. Results matching these 

queries are searched and used to create a new session. 

 

 

10.4.4 PRE-DEFINED REPORT TEMPLATES 
 

In addition to the report templates that you can create by yourself using the methods described in 

the previous sections, SvanPC++ also provides several predefined templates. To access them, open 

the Report Templates Browser using the  button on the Projects Toolbar or using the Report 

templates browser command from the menu opened by right-clicking on Project Reports in the 

Project Browser (see figure below). 

 

 
 

Figure 10-30. Opening the Report templates browser. 

 

To use a predefined report template, locate it in the list and right-click on its name. The menu that 

appears offers the following options: 

• Copy template to project - adds the selected report template to the Project Reports list of the 

current project so that you can work with it in the same way as with any other report template. 

• Generate report from template / Generate PDF report from template / Generate report series - 

creates a report in .doc format / a report in .pdf format / a series of reports using the selected 

predefined template, in the same way as with ordinary report templates, as described in 

Chapter 10.4.3. 

 

The Preview panel on the right hand side of the Report templates browser window, displays the 

selected report template. 

 

Note: You can also add your own report templates by dragging them from the Project Browser to the 

Report templates browser's list. 
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Figure 10-31. Report templates browser. 

 

The predefined report templates can also be easily used to generate reports using the Generate 

report wizard. You can open it using the  button on the Projects Toolbar. 

 

 
Figure 10-32. Generate report wizard.  

 

To create a report, simply select a folder from the list of available report templates and click Next; 

the Wizard will automatically find data that matches the templates in the selected folder. 

 

Note: A report can only be generated using the Wizard if a template matches the data 100%, i.e. all 

templated objects can be replaced. Otherwise, the template will be considered as not matching the 

results in the current project and the report will not be generated. 
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10.5  DATA SEARCH 
 

It allows you to find data in the current project that meets specified conditions, such as a certain start 

time of measurement or type of results,. 

 

Files are searched using of tags, which can be assigned automatically or manually. 

 

 

10.5.1 TAGS 
 

Each tag consists of two objects: a category and a value. The category specifies the type of 

information contained in the tag, while the value contains the specified data for the tagged object. 

 

There are three types of tags that define the type of data provided: 

• Text, 

• Number and 

• Date. 

 

Tags are divided into two groups: 

• Automatically assigned tags - these tags are created automatically and contain information 

about the measurement and the file. This group of tags cannot be changed. 

• User tags - these tags are manually assigned to the object and can contain any category or 

value defined by the user. 

Note: Tags are only used by the Data Search tool. 

 

Tags can be added to objects in the Project Objects list (files, folders, channels) and to Project 

Sessions. To view or edit tags for a selected object, right-click on its name in the Project Browser list 

and select the Tags… command from the pull-down menu. 

 

 
 

Figure 10-33. Opening the Tags dialogue box. 

 

The Tags dialogue box appears when the Tags command is activated. 
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Figure 10-34. Tags dialogue box. 

 

The Automatically assigned tags and User tags lists are automatically filled with the tags assigned to 

the object currently selected in the Project Browser list. 

 

Use the buttons at the bottom of the window to assign a new tag to the selected object, edit a User 

tag already assigned to it or remove an already assigned User tag. You can also remove a selected 

User tag from all the sub-items contained in the selected Project Object. 

 

To create a new User tag, use the User tags definition dialogue box. It can be opened by pressing the 

Edit user tags definition… button, located at the lower-left corner of the Tags dialogue box. 

 

 
Figure 10-35. User tags definition dialogue box. 
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This dialogue box can also be opened using the User tags definition command from the Tools menu. 

 

The list on the left (Category) contains all the tag categories already defined by the user. The list on 

the right (Values) contains all the values available for the selected category. The Values list and the 

corresponding buttons are only available when a category is selected in the Categories list. 

 

You can use the Add, Edit and Delete buttons located below both lists to change their contents. 

 

 

10.5.2 PERFORMING DATA SEARCH 
 

To perform the search, use the Data search dialogue box. It can be opened in two ways: 

• using the Data search command from the Tools menu, 

• using the  button on the Projects Toolbar or on a customised Main toolbar. 

 

 
 

Figure 10-36. Data search dialogue box. 

 

 

To use the Data search tool, you should do the following: 

1. Specify a search query. 

2. Perform the search using the Find now button. 

3. Browse the search results displayed at the bottom of the window. 

 

 

 

Press to perform 
search 

Search criteria 
configuration 

Current search 
query 

Results 
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Building a search query 

 

A search query is consists of several search criteria, each of which describes a category. An example 

of search criteria might be: 

“Results class” = “Logger 1/3 Octave”. 

An example of a search query might be: 

“Results class” = “Logger 1/3 Octave” OR “Results class” = “Logger FFT”. 

 

To add search criteria to the current query, follow these steps: 

1. Specify a tag Category. You can select a category, such as Measurement time start or File type, 

from the list of all the available tag categories, both automatically created and user defined. 

2. Specify the Condition type. You must select the type of condition that the tag value must satisfy. 

For tags with text values, you can choose whether the value should be exact or contain a given 

string. For tags with number/date values, you can select a numerical comparison operator. 

3. Specify the tag value. There are three ways to specify the value of the search criteria: 

a. Value - allows you to select a value from the list of all available values. 

b. User value - allows you to type in any value; this is particularly useful in the case of the contain 

conditions. 

c. Value between - allows you to specify the range of the tag value if the between condition has 

been selected in step 2. 

4. Select the Logical operator. If search criteria already exist in the current query, you must choose 

the logical relationship between the new criteria and the existing criteria. 

Note: The new criterion will only be added at the end of the query with AND or OR; to create a 

more complex logical structure, you will need to edit the text form of the query in the Search 

query field. 

5. Press the Add search criteria button. 

 

The query is also displayed in text form in the Search query field. However, you can only manually 

edit the query in its encoded form, regardless of the application language version that can be 

generated using the Generate language independent query checkbox. Manual editing of the query 

text allows: 

• add search criteria in the form: 

"<Tag category name>" <condition> "<Tag value>" 

• add logical operators: OR / AND 

• add brackets. 

Note: Manually adding parentheses to the search query text is the only way to build a more 

logically complex query. 

 

 

Using the search results 

 

You can use the search results in two ways: 

• Double-click on a position in the Search results list to select it in the Project Browser and close 

the Data search dialogue box. You can then work with the file using the Project Browser. 

• Right-clicking on a position in the Search results list to open a pull-down menu containing 

different options depending on the type of the result (object / session). The menus work in the 

same way as described in Chapter 10.2. 
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Figure 10-37. Using the search results. 

 

If you open a session using the search results, the Data search dialogue box is automatically closed. 

 

 

10.6 OTHER FEATURES OF SVAN PROJECTS 
 

10.6.1 MULTI-SOURCE SESSIONS 
 

When working with the Svan Project, you can view data from several files simultaneously. To create 

a multi-source session, select all the desired data files in the Project objects list, right-click and select 

the data you wish to view. 

 

  
 

Figure 10-38. Creating a multi-source session. 

 

It is also possible to manually add data to a session from any file using drag and drop: 

1. Select the data in the Project Objects list from the Channel or Profile folder attached to a results 

file. 

2. Without releasing the mouse button, drag the data to the name of the desired view in the Project 

Sessions list. 

3. The data will appear in the Data folder attached to the particular session. 
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Figure 10-39. Manually adding data from a Project Object file to a Project View. 

 

 

 
Merging modes 

 

The multi-source data can be merged in three different modes: 

• Multifile, 

• Absolute, 

• Relative. 

You can select the merge mode in the dialogue box that appears when you create a multi-source 

session. 

 

 
 

Figure 10-40. Choosing merging mode for multi-source data. 

 

1 

2 

3 
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In Multifile mode, files are merged in the same way as for multi-files (see Chapter 3.2.4), so that the 

results of measurements taken at different times and stored in separate files can be displayed on the 

same graph. 

 

Absolute and Relative modes allow the results of different measurements stored in separate files, e.g. 

logger type results from different instruments, to be displayed and compared in the same session. 

 

In Absolute mode, the actual time of measurement is taken into account. This makes it possible to 

compare the differences between different measurements taken at the same time. 

 

In Relative mode, the starting point of all measurements is equalised. It allows you to compare 

multiple measurements in one session when the actual measurement time is not significant. The 

scale of the time axis is relative and the same for all the results displayed. 

 

 
Viewing multi-source data  

 

When multi-source data is displayed on a plot, the source file of the currently displayed results can 

be seen in the table below the plot. It is visible in the Source row after expanding the Info, as shown 

below. 

 

 
 

Figure 10-41. List of viewed functions in case of multi-source sessions. 

 

In the Configurator list, an additional branch containing information about the source of the data has 

been added at the top of the hierarchy for each file displayed, as shown in the figure below. 

 

 
 

Figure 10-42. View configurator for multi-source data. 

 

The table above the plot also shows the name of the source file (of the currently active result 

function). 
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Figure 10-43. Data source specified in the Active function table. 

 

 
 

Calculations on multi-source data 

 

When performing calculations using a multi-source session, the Channels and profiles settings of the 

SvanPC++ Calculator allows you to select which files should be used for the calculations. To select 

data for calculations, tick the boxes next to the desired filenames. 

For details on the Calculator tool, see Chapter 9. 

 
Figure 10-44. Source files selection in the Calculator’s 

Channels and Profiles settings for multi-source data. 

 
 

Mixed-settings multi-source sessions 

 

It is also possible to create a session with multiple files in which the measurement settings are not 

identical. In this case, the Header Information view will show the values of the parameters that differ 

for each file, as shown below. 
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Figure 10-45. A Header information view created for a mixed-settings multi-source session. 

 

Such data can be viewed using a Mixed settings results view (see Chapter 3.2.4). 

 

 

 

10.6.2 SAVING CALCULATOR SETTINGS 
 

The Projects tool allows you to save the settings configured in the Calculator tool, such as the result 

functions selected for calculations, their parameters, calculation periods, etc., for later use. This can 

be done using the Settings panel at the top of the Calculator dialogue box. 

 

For details on the Calculator tool, see Chapter 5.2. 

 

 
 

Figure 10-46. Settings panel of the Calculator dialogue box. 

 

To save the currently configured settings, press the Save button. The Save settings dialogue box 

appears, allowing you to specify a name for the saved settings. 

 

  
Figure 10-47. Save settings… dialogue box. 
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Once the settings have been saved, they can be loaded using the <select saved settings> pull-down 

menu, which contains a list of settings with the names specified when they were saved. The settings 

can also be loaded any time for calculations in another Svan project. 

 

Pressing the Delete button clears the currently selected settings. Pressing the Clear settings button 

deselects all functions and resets all options to default. 

 

The Calculator Settings Toolbar provides quick access to the saved calculator settings. You can show 

or hide it using the Calculator Settings Toolbar command on the View menu. 

 

 
 

Figure 10-48. The Calculator Settings Toolbar. 

 

Different settings can be assigned to each of the four buttons. 

• If no settings have been assigned to a button, only a number is displayed in the centre of the 

button (3 and 4 in the figure above). Press the button to assign settings. 

• For buttons that already have settings, the name of the settings is displayed instead of the 

number (1 and 2 in the figure above). Click these buttons to perform calculations according to 

the saved settings or right-click to assign different settings. 

 

When you assign (or reassign) settings to a button, the Calculator settings dialogue box appears. 

Select the desired settings and press the OK button or select <not defined> to leave the button with 

no settings assigned. 

 

 
 

Figure 10-49. Assigning settings to a button of the Calculator Settings Toolbar. 
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10.6.3 USER FUNCTION WIZARD 
 

The User function wizard is used to create user-defined result functions with values entered manually 

(or copied from other applications such as MS Excel). These result functions can then be used as a 

data source for sessions in the same way as measurement results downloaded from Svantek 

instruments. 

To open the User function wizard, use either the command in the Tools menu or the  button on 

the Projects Toolbar. 

 

The procedure for creating user-defined result functions is divided into four steps: 

1. Specify the type of function. 

2. Specify the function parameters. 

3. Enter the function values. 

4. Save the function to the selected location under a user-defined name. 

 

Once you have defined all the characteristics of the function in a particular step, you can move on to 

the next step by pressing the Next button at the bottom of the User function wizard window. You can 

also go back at any time to correct some of the settings by pressing the Back button. 

 
 

Step 1 

 

In Step 1, you can select the type of measurement data (Sound / Vibration or Meteo) and a specific 

parameter to be represented by the values of the new function, e.g Leq for sound level data, Marker 

if you want to specify the time range for a new marker, or a meteorological data such as Temperature. 

Also select the function’s domain (Logger, 1/1 Octave, 1/3 Octave or FFT). 

 

 
 

Figure 10-50. Step 1 of the User function wizard.  
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Step 2 

 

In Step 2, you can specify the parameters of the new function, i.e. the units in which its values will be 

entered and several parameters describing the function’s domain and target set, as well as simulating 
the configuration of a measuring instrument. 

 

 
 

 Figure 10-51. Step 2 of the User function wizard.  

 

 
Step 3 

 

In Step 3, you can enter the values of the function. There are two ways to do this: 

• Type the numbers manually; once you have entered a value, you can move to the next cell by 

pressing ENTER or the Add new value button. 

• Copy values from another application, such as MS Excel, to the clipboard, then go back to the 

User function wizard, select a cell and press CTRL+V. 
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Figure 10-52. Step 3 of the User function wizard.   

 

The copied series of numbers should be in the form of a table column or numbers separated by the 

carriage return character. You can also copy a fragment of the function from the User function wizard 

itself. 

Note: Before copying, the table cell where the copied series will begin must be selected, i.e. it must 

be highlighted in blue, but it must not be in text edit mode (indicated by the presence of a blinking 

text cursor in its centre). 

 

Do not leave any fields blank or enter text strings that are not numbers, otherwise you will not be 

able to proceed to the next step. 

 

When you create a marker, you can also import time ranges from a CSV file. To do this, use the Import 

button in the bottom right corner. 

 

 

 
 

Figure 10-53. Importing a marker time range from CSV in the User Function Wizard. 

 

 

Import time range 

from a CSV file 

(only for markers) 
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In the imported CSV file, each line should correspond to a single time range. Such a line must have 

the following format: 
[date and hour "from"] ; [date and hour "to"] 

 

The date and hour format should match to the system format, although the import method can 

handle many different formats. 

 

The CSV import tool can be particularly useful if, for example, you need to create a marker from an 

existing timetable of aeroplane flights. 

 

 
Step 4 

 

In Step 4, you can enter a name for the new function and select where to stored it (the Project Objects 

catalogue or one of its sub catalogues). 
 

 
 

Figure 10-54. Step 4 of the User function wizard. 

 

When the Finish button is pressed, the new function is created ready for use in a session. User-

defined functions appear in the Project Objects list in the Project Browser in the same way as imported 

files. They are saved as .svu files. 

 

Note: If you create a marker using the User function wizard, its name will be identical to the name of 

the .svu file created. 
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10.7 SIMPLE PROJECTS 
 

Simple project is a tool that allows you to creating sessions, views and reports in a simple way. In the 

simple project mode, instead of the Svan Project tree structure in the Project Browser, the simple 

project view offers session tabs with a Navigator that allows managing results presentation and 

report structure using four tools – navigator panes. 

 

 

10.7.1 CREATING SIMPLE PROJECTS 
 

To create a simple project, select File » New Project and select Simple project in the 

New project  dialogue box. 

 
Figure 10-55. Creating a simple project. 

 

For Simple projects, you can use links to files instead of embedding them in the project. This option 

allows you to reduce the size of your project. 

 

After creating a Simple project, four buttons specific to this mode appear on the toolbar. 

 
Table 10-3. Buttons available for displaying on the view Toolbars. 

 

Icon Name Function 

 
Switch layout mode − Toggles between single and double column layout  

 
Generate report − Creates report from panels 
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Generate report preview − Creates report preview from panels 

 
Report options − Opens the report options dialogue box 

 

 

 

10.7.2 ADDING DATA FILES 
 

You can add data to the project in the same way as in standard projects – using the File menu or by 

dragging the Svan file to the SvanPC++ window.  

 

 
Figure 10-56. Simple project view. 

 

 

By default, Simple projects do not copy files into the project, they only remember links to them. The 

reason for this is to make projects run faster and to reduce the size of projects.  

Note: To open a project, there should be linked files on the PC disk.  

 

For example, if you create a project and save it, but some files have been deleted or moved in the 

meantime, when you open the project, the icons for the deleted or moved files will change to an 

exclamation mark. In this case, you should relink these files by right-clicking on a file with an 

exclamation mark. 

Session tab 
with panes 

Panels section 
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Figure 10-57. Relinking missed links. 

 

Note: If the file is missing, the results logged in this file will be cut from the merged logger results.  

 

 

10.7.3 CREATING SESSIONS 
 

When you open another file, SvanPC++ will always ask you what kind of merge should be used, as in 

the case of the Standard project (see Chapter 10.6.1).   

 

To create a new session, click the “+” on the right of the last session tab. To rename or delete session, 

right-click on the session header and select the required command from the drop-down menu. 

 

  
 

Figure 10-58. Session menu. 
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10.7.4 WORKING WITH NAVIGATOR 
 

The Navigator allows you to manage the results presentation and report structure using four tools – 

Navigator panes. 

The Measurement files (links) pane displays a tree of files involved in the project session. 

 

 
Figure 10-59. Measurement files (links) tree structure. 

 

If you right-click on the selected file(s), a drop-down menu will appear allowing you to manage the 

file links.  

 

The Add available panel pane displays a list of available views associated with the project file(s). When 

you double-click on a view, the new panel with that view is placed below all panels in the panels 

section. 

 
Figure 10-60. Opening next view panel. 
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The Selected panels pane displays the list of views (panels) placed in the panels section. In this pane, 

you can change the order of the views by dragging them up or down. The same effect can be achieved 

in the panels section clicking on the view header and dragging up or down. 

 
Figure 10-61. Changing the order of the panels. 

 

The order of the views (panels) defines the layout of the report, which contains all the views placed 

in the panels section. The report is created as an MS Word document and a link is added to the 

Reports pane after pressing the Generate report button on the Toolbar. 

 
Figure 10-62. Example of the report. 
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The report link is added to the list of reports in the Report pane of the Navigator. 

 
Figure 10-63. Report pane with the link to the MS Word document with the report. 

 

You can add the Text panel and fill it with measurement description or whatever by double-clicking 

on the   field in the Add available panel pane. You can then place it in the desired order 

by dragging it up. 

 

 

10.7.5 OTHER OPTIONS 
 

You can toggle the layout of the panels from one column to two columns by pressing the Switch 

layout mode button.  

Note: The report layout will still be single column. 

 
Figure 10-64. Example of the two-columns layout. 
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You can generate the report preview by clicking on the Generate report preview button. Unlike report 

generation, report preview does not add a link to the created MS Word document. 

 

You can save the project with all the linked files. To do this, select File » Export with links … A project 

batch file with the .svp extension is created, containing all the files to which the project has been 

linked. 

 

You can set report options by pressing the Report options button. The Report options dialogue box 

allows you to do the following: 

• Select the format of the report document: DOC, PDF or RTF, 

• Edit the start page, 

• Import the start page, 

• Export the start page, 

• Select the style of the tables: Default, Simple, Extended, Professional (an example of the 

selected style is shown below), 

• Insert a page break after each table. 

 

 
Figure 10-65. Report options dialogue box. 
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10.8 NOISE PROJECTS 
 

Noise projects are dedicated to traffic, industrial and railway noise measurements. 

Noise projects have the same user interface as simple projects, i.e. all the functions of simple projects 

also work in the noise projects. At the same time, noise projects have an additional setup item that 

allows you to select a Standard according to Polish or Italian regulations. 

  
Figure 10-66. Creating a Traffic noise project. 

 

Note: To activate the noise project, you should have unlocked the Environmental Monitoring module 

for the Polish standard or the Italian traffic/industrial/railway noise module for the Italian standard. 

 

Usually, the noise file consists of LAeq measured with 1-second step (although the standards do not 

specify the step) for day and night (all day) and may contain the results of weather measurements.  

After loading a file with such data, SvanPC++ will display the Logger result view. 

 

 

 

10.8.1 POLISH NOISE STANDARDS  

 

Traffic noise standard “Rozporządzenie ministra Środowiska od 16.06.2011” 

 

The Polish Traffic noise standard provides for two methods: 

• Continuous method which is used for passing more than 300 cars per hour or 

• Exposure levels (LAE/SEL) method which is used for passing less than or equal to 300 cars per 

hour. 
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Figure 10-67. Traffic noise project with Logger result view. 

 

The above mentioned standard, which is displayed in the standard selector, defines some weather 

conditions in which noise measurements are acceptable: 

• Temperature:  -10 ÷ +50 oC,  

• Humidity:  25 ÷ 98%,  

• Wind speed:  <5m/s,  

• Pressure:   900 – 1100 hPa,  

• Precipitation: lack. 

 

If the weather conditions are not met, these time intervals should be excluded from further 

calculations. 

To find time intervals that do not meet the weather conditions, press the cloud button . This will 

display the Exclusion summary dialogue box with information about the exclusions and create the 

"Exclusions" marker.  

 
Figure 10-68. Dialogue box with exclusions. 

Traffic noise 
tools 
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If the marker is activated in the Configurator, the periods with the “Exclusions” marker are not 

included in the calculation. 

 
Figure 10-69. Exclusions marker. 

 

 

You can manually add a fragment to the marker which will also be excluded. You need to select a 

block, Right-click on it and select Add block(s) to marker »» Exclusions. 

  
Figure 10-70. Adding new block to the Exclusions marker. 
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If you are using the Continuous method, press the Lday, L95 or Lnight, L95 button to calculate total 

Lday and L95 values for the day period (between 6 am and 10 pm) or total Lnight and L95 values for 

the night period (between 10 pm and 6 am). These results are displayed in the new Total results 

panel. 

 
Figure 10-71. Calculated Traffic noise results view with the use of Continuous method. 

 

 

To create a report, click the Generate report icon. 

 
Figure 10-72. Traffic noise measurement report with the use of Continuous method. 
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If you are using the Exposure levels (LAE/SEL) method, after excluding of periods that do not meet the 

weather conditions, press the Calculation statistics icon  to calculate nine statistical levels from 

L10 to L90 in hourly intervals. Then select a statistical level in the Configurator that reflects the actual 

noise level. 

 
Figure 10-73. Traffic noise measurement report. 

 

Click on the  icon to open the Blocks/markers generator dialogue box, where you can set the 

parameters for searching for noise associated with the passed vechicles.  

For example, select the night Time period (from 22:00:00 to 06:00:00) and Date if necessary and go 

to the next step. In the second step, select Trigger condition: LAeq measured in the first channel level 

should be 15 dB higher than the noise level selected in the Configurator. The duration of the signal 

at this level should be at least 5 seconds and at most 20 seconds. Then press Finish. 
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Figure 10-74. Block/markers generator settings. 

 

SvanPC++ will generate blocks for events related to passing vehicles. The number of events for each 

hour is displayed in the Events summary dialogue box that opens after the calculation. 

 
Figure 10-75. Generated events summary list. 

 

You can manually add or remove blocks as described above for the Continuous method and then 

display the Events summary dialogue box by clicking the  icon. 

 

When all the events are selected, press the  icon to calculate the LAE(SEL) for each 

block/event. These results are displayed in the new Total results panel. Three results are also 

calculated for all cumulated blocks (average LAE, standard Leq deviation SD) and Lnight. 

 

For SEL calculations, the "exclusions" marker indicates which blocks do not meet the criteria of some 

regulations. In this situation, the calculation of the average SEL does not take into account the blocks 

corresponding to the "exclusions" marker. Excluded blocks that are highlighted in yellow in the table 

in the "Total results" view. 
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Figure 10-76. Calculated Traffic noise results view with the use of Exposure levels (LAE/SEL) method. 

 

To create a report, click the Generate report icon. 

 
Figure 10-77. Traffic noise measurement report with the use of Exposure levels (LAE/SEL) method. 

 

 

 

 

 

10.8.2 “ITALIAN REGULATIONS” STANDARDS 
 

With the Italian regulations noise projects, you can use the New session wizard that appears when 

you select one of them in the New project dialogue box. 
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Figure 10-78. New session wizard - customer information. 

 

 
Figure 10-79. New session wizard - selecting files. 
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Figure 10-80. New session wizard - selecting layouts. 

 

 
Figure 10-81. Project screen after New session wizard. 

 

The Italian regulations noise projects use additional panels.  

All Italian regulations noise projects use the Customer panel, which displays customer information. 
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• The Italian Industrial noise projects have three additional panels – Daily summary, Impulsivity 

and Tonality. 

 

Figure 10-82. Daily summary panel for the Industrial noise projects. 

 

 

Figure 10-83. Impulsivity panel for the Industrial noise projects. 

 

 

Figure 10-84. Tonality panel for the Industrial noise projects. 
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• The Italian Traffic noise projects have one additional panel – Daily report. 

 

 

Figure 10-85. Daily report panel for the Traffic noise projects. 

 

• The Italian Railway noise projects have two additional panels – Events report and Events 

graph. 

 
Figure 10-86. Events report panel for the Railway noise projects. 
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Figure 10-87. Events graph panel for the Railway noise projects. 

 

The Italian noise projects have additional buttons on the toolbar. 

 

Table 10-4. Railway noise projects toolbar buttons. 

 

Button 

 

Function 

 

 

− Show new session wizard 

 
− Find invalid regions according to meteo data 

 
− Add block selection to ‘exclusions’ marker 

Traffic noise 

 
− Show daily report panel 

Industrial noise 

 

− Perform impulse analysis for active impulsivity 

panel 

 
− Perform tonality analysis for active tonality panel 

 
− Tonality standard selection (ISO 226:2003 or 

ISO 226:1987) 

 
− Mode selection (currently only Day/night) 

Railway noise 

 
− Calculate statistics in 1h intervals 

 
− Find events according to selected statistical level 

 

− 10dB drop range function (according to LAeq or to 

active function) 
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− Find range according to 10dB drop from maximum 

value 

 

− Events mode (Block selection mode or Marker 

mode) 

 
− Set current event as valid 

 
− Set current event as invalid 

 
− Show events report panel 

 
− Show events graph panel 

 
− Switch on/off events recalculation mode 

 
− Show/hide notes column 

 
− Show events graph panel 

 

 

 

 

10.9 DATA SERVER PROJECTS  
 

The Data server devices (SD 700G, SD 310) create a set of files that are saved in special directories on 

a memory stick or other USB storage device. You can open these files with SvanPC++ and work with 

them in a project. 

Note: To activate the Data server project, you must have the EM module unlocked. 

To open the Data server project in SvanPC++, you should double-click the special start.spr file located 

in the root directory of the storage device. Double-clicking on this file starts SvanPC++ and opens a 

dialogue box where you can select the project you want to work with. 

  
Figure 10-88. Selecting projects.  
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You can open the specific project directly by clicking on the project file projXXX.spr located in the 

project directory. Once the project has been opened, a dialogue box will appear allowing you to select 

the measurement(s) you wish like to work with. 

  
Figure 10-89. Selecting measurements.  

 

The measXXX.spr file only opens files with the data related to this measurement, synchronising data 

from the sound level meter, weather station, video and radar. 

  
Figure 10-90. Presentation of measurement data and video 

 

If the measurement system is equipped with a radar, the "car" icon will appear in the project toolbar. 

Clicking on this icon opens the table of hourly radar results. 
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Figure 10-91. Summary of results from the radar 
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11 BUILDING ACOUSTICS MODULE 

 

SvanPC++ Building Acoustics module (BA) extends the basic functionality of SvanPC++, providing an 

easy-to-use environment and tools for reverberation time and sound insulation calculation and 

reporting. It also provides tools for implementing calculations made using Building Acoustics or 

Building Acoustics Pro applications for mobile devices, including STIPA calculations.  
 

The Building Acoustics module includes tools to: 

• Calculate reverberation time (RT60), 

o based on decay or impulse octave band time history logger, 

o in 1/1 octave or 1/3 octave bands, 

o with EDT, RT20, RT30 and manual methods. 

• Calculate the insulation index by: 

o defining rooms and partitions, 

o organising numerous measurement files, 

o using of imported data, 

o using results of Airborne R, Dn, DnT, R45, D2m,n, D2m,nT, impact Ln, LnT and ratings 

o reporting with pre-installed and manually created report templates, 

o in accordance with ISO 140 and ISO 16283 standards. 

Note: MS Word and Excel are required to use the report templates functionality. 

 

 

11.1 BUILDING ACOUSTICS TOOLBAR 
 

The Building Acoustics Toolbar provides easy access to several features of the Building Acoustics 

module. Its contents are described in the table below. 

 
Table 11-1 Contents of the Building Acoustics Toolbar. 

 

Control Description 

 
Sound Insulation Wizard – allows you to open the Sound 

Insulation Wizard (see Chapter 11.5). 

 
RT60 analysis methods buttons – after clicking one of these 

buttons the corresponding set of markers and levels will become 

available. (user – enables adjustable 't2' and 't3' markers.)  

 
Decay / Impulse switch – allows you to select the RT60 

measurement method. 

 
Response time field – it is recommended that the Response time 

parameter to be set to a value two times longer than the 

expected reverberation time (see Chapter 11.2.2). 

 
Smoothing Samples field – allows you to select the number of 

samples for smoothing the logger curve. 

Note: You can show / hide the Building Acoustics Toolbar using the Building Acoustics Toolbar 

command from the View menu.  
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11.2 CALCULATION OF REVERBERATION TIME 
 

The basic edition of SvanPC++ is able to display RT60 results made with the use of dedicated Svantek 

instruments in a special RT60 view. SvanPC++ Building Acoustics also provides tools to calculate 

reverberation time (RT60) based on a SVAN measurement file containing a short step Leq spectrum. 

The calculation can be performed over decay or impulse octave band time history loggers, in 1/1 

octave or 1/3 octave bands, with EDT, RT20, RT30 and manual methods. The calculation can be 

started from any Logger type view, but it is recommended to open a Logger Octave TSect (Time 

Intersection) view, as this view provides additional features in the Building Acoustics Toolbar (see 

Chapter 11.1). 

 

 

11.2.1 LOGGER OCTAVE TIME INTERSECTION VIEW 
 

After opening a file containing a short step Leq spectrum, use the Navigator toolbar to open the 

Logger 1/1 Octave TSect or Logger 1/3 Octave TSect view. 

 

 
Figure 11-1. Logger time intersection view. 

 

The view displays the time history of one frequency band at a time. Use the up and down arrows to 

scroll through the available frequency bands. 

 

It is useful to apply smoothing to the short step Leq function for better visual evaluation of the 

reverberation time. The Smoothing on/off switch allows smoothing to be switched on or off. 

Smoothing is performed by averaging linear sound pressure levels. 

 

The Smoothing samples parameter determines how many Leq samples are averaged when 

smoothing is on. It is always an odd number, as the sample from the point in time is taken into 

Frequency 

selection 
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account, as well as an even number of samples before and after, as far as possible. The Smoothing 

samples parameter can also be adjusted in the Main Options / Calculator / RT60 panel. 

 

Smoothing affects both plot and table values. 

 

 

11.2.2 CALCULATION METHODS AND PARAMETERS 
 

To calculate RT60 for all available frequency bands, open the Building Acoustics Calculator using the 

Calculator >> Building Acoustics command from the Tools menu. Select Reverberation Time from the 

list on the left of the window and go to the Parameters tab. 

 

  
Figure 11-2. Calculation of RT60 in the Building Acoustics Calculator. 

 

In the Parameters tab select the method to be used for the calculation: EDT, RT20 and/or RT30. If 

custom markers have been previously created using the RT User tool available on the Building 

Acoustics Toolbar, the RT User option is also enabled. The choice between Decay and Impulse 

methods is important and should be made according to the type of measurement being made. If an 

omnidirectional sound source is used, the Decay method should be the correct choice. 

 

The Smoothing option is set in the Building Acoustics Calculator according to the settings made in the 

Time Intersection view. The user can change it and run calculations with or without smoothing. 

 

The Response time parameter can be adjusted in Main options / Calculator / RT60 or in the Building 

Acoustics Toolbar. This parameter helps SvanPC++ to find the period in which the sound source is 
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switched off and the sound pressure level decreases to a stable background noise. It is recommended 

to set the Response time parameter two times longer than the expected reverberation time. 

 

  
 

Figure 11-3. Adjusting the response time using the Building Acoustics Toolbar. 

 

To start calculations, press the Calculate button. Once the reverberation time has been calculated, 

the RT60 view will automatically open. 

 

Note: If the RT60 calculator is used repeatedly, the previous calculation results will no longer be 

available. 

 

 

11.2.3 RT60 VIEW 
 

The RT60 view opens automatically when the reverberation time calculation is complete. It displays 

the results of the calculation in the form of a table. 

 

  
Figure 11-4. The RT60 table view. 

 

 

You can use the View Configurator (see Chapter 4.4) to show/hide selected columns in the table. 

The RTResult column gives the result at the given frequency, taking into account the following order 

of calculation quality: RTUser, RT30, RT20, EDT. 
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The values in the RTResult column can be corrected by experienced users. Double-click on a cell to 

edit. Once edited, the result is marked with a “*” (see Figure 11-7). 

Note: The RT60 results can also be plotted using the Logger 1/1 Octave or Logger 1/3 Octave view. 

Double-clicking on a cell in the EDT, RT20, RT30 or RTUser columns will open the Logger octave time 

intersection view at the selected frequency band and the corresponding method will be active. 

Additional RT60 parameters are also calculated and displayed to allow evaluation of the decay curves: 

Correlation coefficient, Non-linearity and Curvature. 

 

 

11.2.4 RT60 RESULTS DETAILED REVIEW AND MANUAL CALCULATION 
 

Double-clicking on a cell containing results in the RT60 view, or clicking on one of the EDT, RT20, RT30 

or user buttons on the Building Acoustics Toolbar, will make a corresponding set of markers and levels 

available in the Logger octave time intersection view. 

 

  
Figure 11-5. RT60 analysis in given frequency band. 

 

A number of functions and markers become available in the View configurator, including: 

• L1: ‘noise on’ level for the decay method and last value of the backward integrated curve for 

the impulse method 

• L2: L1-5dB level (RT20, RT30) or L1-10 dB (EDT) 

• L3: L2-20 dB (RT20) or L2-30 dB (RT30) level 

• L4: ‘background noise’ level 
• ‘Noise on’ marker, averaged level with omnidirectional sound source, decay method 

• ‘Decay start’ marker, detected time when sound source was switched off, decay method 

• ‘Top level’ marker, at the point where the impulse Leq value was highest and the last sample 

where the backward integrated curve was calculated, impulse method 

• ‘Background noise’/’t4’ marker (detected time of reaching stable background noise) 

RT60 analysis 

method selection 

RT60 

measurement 
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• ‘-10dB point’ marker for EDT method indicating 10 dB below L1 level (reaching L2 level) 
• ‘-5dB point’ marker for RT20 and RT30 methods indicating 5 dB below L1 level (reaching L2 

level) 

• ‘-25dB point’ and ‘-35dB point’ markers indicating respectively 20dB (for RT20) and 30 dB (for 
RT30) below L2 (reaching L3) 

• ‘t2’ and ‘t3’ markers for user mode, indicating the range of samples representing the decay or 

backward integrated curve 

• 1/n Octave Slope line: linear approximation of Leq (decay method) or backward integrated Leq 

(impulse method) samples between ‘t2’ and ‘t3’ (user mode) or between ‘-5dB point’ and ‘-
35dB point’ (RT30 method) or between ‘-5dB point’ and ‘-25dB point’ (RT20 method) or 
between ‘decay start’ and ‘-10dB point’ markers (EDT method) 

• 1/n Octave Schroeder curve: backward integrated Leq (impulse method) 

 

After switching to User mode in the Building Acoustics Toolbar, you can adjust the positions of the 

‘t2’ and ‘t3’ markers to select the most representative set of samples for the decay curve (decay 
method) or backward integrated curve (impulse method). 

 

To adjust the position of a marker, move the cursor to the bottom of the line representing the marker. 

A frame in the colour of the marker should appear and you can drag and drop the marker left or right 

from its original position. The value of the RTUser and RTResult functions will be recalculated as soon 

as the marker is dropped on a new position and the 1/n Octave Slope line. 

 

  
Figure 11-6. Calculation of RT60 in the User mode. 

 

After manual adjusting for a given frequency band, the results are displayed in the RT60 view in the 

RTUser column and the value in the RTResult column is updated accordingly. 
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Figure 11-7. An RT60 view containing RTUser results. 

 

 

 

11.3 BUILDING ACOUSTICS PROJECTS 
 

Activating the Building Acoustics module also gives access to Svan Projects, a useful data 

management tool that simplifies the use of SvanPC++’s reporting functions. 

 

General ways of working with projects are described in Chapter 10. In the case of Building Acoustics, 

the Project functionality allows you to manage a large number of measurement files recorded during 

reverberation time, sound insulation and STIPA measurements. The Sound insulation wizard allows 

you to calculate sound insulation indices and generate reports automatically. It offers the unique 

functionality of limiting the range of frequency bands to be displayed and analysed in the software, 

restricting it to the standards used in the sound insulation assessment. 

 

The Building Acoustics projects consist of Tasks:  

• Airborne insulation – airborne sound insulation between rooms, 

• Facade insulation – airborne sound insulation of façade elements and façades, 

• Impact insulation – impact sound insulation of floors,  

• Impact rubber ball insulation – impact sound insulation of floors using the rubber ball. 

• Reverberation time – RT60, 

• STIPA – speech transmission index, 

• STIPA Ambient noise – ambient noise impact for STIPA tasks. 
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11.3.1 STARTING BUILDING ACOUSTICS PROJECT 
 

After selecting the New project command from the File menu, the New project dialogue box appears. 

 

If Use new building acoustics wizard is checked, you can use the new Building acoustics wizard to 

start a Sound insulation, RT60 and STIPA project. Otherwise, you can use the old Sound insulation 

wizard.   

 
Figure 11-8. Selecting Building acoustics or Sound insulation wizard. 

 
 

For sound insulation projects, it is possible to specify the octave type (1/1 octave or 1/3 octave) and 

the minimum and maximum values of the frequency domain. It is necessary to specify the standard 

according to which the measurements are to be made (e.g., ISO 140, ISO 16283, GB/T 19889 or 

ASTM). 

 

 

 

11.4 BUILDING ACOUSTICS WIZARD 
 

Building acoustics wizard allows you to create a Task for building acoustics: 

• Define rooms and partitions to reflect the measurement situation. 

• Easily assign different types of measurement data to rooms and partitions. 

• Calculate different types of sound insulation indices. 

• Call the report generator to create a report for a given partition. 

 

The Building acoustics wizard will guide you through the several steps (sections) to obtain a report. 

 

Note: Before using the Building acoustics wizard, it is recommended that you group measurement 

files according to measurements made in the Source room, Receiving room, measurements of 

background noise and measurements of reverberation times. 
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11.4.1 DEFINING ROOMS AND PARTITIONS  
 

The General section allows you to describe:  

• Task: Name and Type, 

• Building and partition: Object and Partition; this description will be used in the report, 

• Insulation parameters:  

o Standard according to which the Sound insulation indices are calculated, 

o Insulation type: Airborne, Façade, Impact or Impact rubber ball 

o Insulation index,  

o Frequency range: 50Hz – 5000Hz, 

o Loudspeaker position – number of loudspeaker positions to be used during the 

measurement session,  

o Spectrum in report, 

• Source and Receiving room parameters: 

o Name, 

o Volume, 

o Temperature, 

o Description. 

 

The source and receiving rooms are side rooms for the partition. 

  
Figure 11-9. Building acoustics wizard – General step.  

 

In addition to the descriptions of the Building & partition, you can change the default names for 

Object and Partition. To do this, click on the default name and edit it. These names will be displayed 

on the Tasks tree of the project view. 
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The object and partition names as well as names of the Source and Receiving rooms are remembered 

so once defined, they can be selected from the drop list. 

 

  
Figure 11-10. Selecting the Object name. 

 

 

In the Standard item, you can select ISO 140, ISO 140 (UK), ISO 16283, GB/T 19889 or ASTM standard. 

 

 
 

Figure 11-11. Selection of the sound insulation standard. 

 

 

In the Insulation type item, you can select a Task type.  

 

  
Figure 11-12. Selection of the insulation type. 

 

 

The Insulation index in the selector depends on the selected Standard and Insulation type.  
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Figure 11-13. Selection of the insulation index. 

 

 

The possible options for different standards: 

• ISO 140, ISO 140 (UK), GB/T 19889 

o Airborne R: Apparent sound reduction index, airborne sound insulation between rooms 

o Airborne Dn: Normalized level difference, airborne sound insulation between rooms 

o Airborne DnT: Standardized level difference, airborne sound insulation between rooms 

o Facade R45: Apparent sound reduction index, airborne sound insulation of façade elements 

and façades 

o Facade D2m,nT: Standardized level difference, airborne sound insulation of façade elements 

and façades 

o Impact Ln: Normalized impact sound pressure levels, impact sound insulation of floors using 

tapping machine 

o Impact LnT: Standardized impact sound pressure levels, impact sound insulation of floors 

using tapping machine 

 

• ISO 16283: 

o Airborne R: Apparent sound reduction index, airborne sound insulation between rooms 

o Airborne DnT: Standardized level difference, airborne sound insulation between rooms 

o Facade R45: Apparent sound reduction index, airborne sound insulation of façade elements 

and façades 

o Facade D2m,nT: Standardized level difference, airborne sound insulation of façade elements 

and façades 

o Impact Ln: Normalized impact sound pressure levels, impact sound insulation of floors using 

tapping machine 

o Impact LnT: Standardized impact sound pressure levels, impact sound insulation of floors 

using tapping machine 

o Impact rubber ball LiFmaxVT: Standardized impact sound pressure levels, impact sound 

insulation of floors using rubber ball 

 

• ASTM: 

o Airborne NR: Noise reduction, airborne sound insulation between rooms 

o Airborne NNR: Normalized noise reduction, airborne sound insulation between rooms 

o Airborne ATL: Apparent transmission loss, airborne sound insulation between rooms 

o Facade OINR: Outdoor-indoor noise reduction, façade sound insulation 

o Facade AQITL: Apparent outdoor-indoor transmission loss, façade sound insulation 

o Impact ISPL: Impact sound pressure levels, impact sound insulation of floors using tapping 

machine 
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o Impact ANISPL: Absorption normalised impact sound pressure level, impact sound insulation 

of floors using tapping machine 

o Impact RTNISPL: Reverberation time normalised impact sound pressure level, impact sound 

insulation of floors using tapping machine 

 

 

The Frequency range is currently a constant value for all standards.  

 

For most standards, it is possible to use 1/1 octave spectra (except of ISO 16283). SvanPC++ can 

automatically distinguish the type of spectra recorded in the measurement files. Independently of 

this, you can choose (also for ISO 16283) which spectrum bands should be used in the report – 1/1 

Octave or 1/3 Octave.  If you have measured 1/3 octave spectra but want to show indices for 1/1 

octaves, the program will recalculate the indices for 1/3 octaves to 1/1 octaves. 

 

              
 

Figure 11-14. Indices for 1/3 octaves vs 1/1 octaves. 

 

 

 

 

11.4.2 ASSIGNING MEASUREMENT FILES  
 

In the next steps, you should assign the measurement files: files with the sound pressure levels 

measured in the source and receiving rooms (Source room and Receiving room sections), files with 

the background noise level (Background section) and reverberation time measurements 

(Reverberation time section). 
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Optionally, if more than one loudspeaker position has been defined, you can assign the appropriate 

files to different positions. 

 

Measurement results for 1/3 octaves contained in files assigned to sections are automatically 

averaged for each section during report generation. If more than one loudspeaker position is used, 

only the results for the same loudspeaker position are averaged. 

 

To assign files, click Add files and open the measurement file(s) associated with the current section. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 11-15. Assigning measurement files to rooms in the Building acoustics wizard. 

 

 

The graphs on the right allow you to preview the results.   
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The ISO 16283 standard requires measurement and averaging of the results in a receiving room for 

different source positions. Other standards do not have such requirements, but you can use more 

than one source position by changing the number of the Loudspeaker position parameter in the 

General section of the Building acoustics wizard .  

 

If you have more than one Loudspeaker positions, you should assign measurement files for the 

Source and Receiving rooms according to the Loudspeaker position. 

 

While assigning files to the Source or Receiving rooms, select the Loudspeaker position number and 

then transfer files with measurements made for this Source position. 

 

If you have already assigned files, for example, to the first position, you can simply reassign some of 

them making selection of these files, changing the Loudspeaker position number and clicking Apply 

to select files.  

 

 
 

 

 

 

 

 

 

 

 

 

 
Figure 11-16. Reassigning measurement files for another Loudspeaker position. 

 



                                                                                     SvanPC++ User Manual   

 

247 

If you have previously created projects, you can use data files from these projects. To do this, click 

the Import button and in the Import dialogue box, select Current project if you want to use data from 

previous tasks in the same project or Another project if you do not. 

 

In the case of Another project, select the project file with the svp extension and double-click it. As a 

result, the left pane of the Import dialogue box will display the project structure and the right pane 

will display the file contents of the project branches. You can select the files to be used in the new 

project and click OK to import them into your project catalogue. 

 

    
  

  

 
 

Figure 11-17. Importing files from another project. 
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11.4.3 BACKGROUND NOISE  
 

 

In the Background section, you can ignore the background noise measurements by ticking the Ignore 

background measurement(s) item.  

 

 
Figure 11-18. Background section. 

 

 

 
 

11.4.4 REVERBERATION TIME 
 

 

The Reverberation time section is used to assign files for reverberation time averaging. You can use 

files with RT60 results measured by the Svantek instruments using the RT60 function (this type of 

data is visible as "RT60 from instrument" in the file list), or files with 1/x octave spectra time-histories. 

In the latter case, SvanPC++ will try to calculate RT60 results based on these spectra time 

intersections. 
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Figure 11-19. Reverberation time section with RT60 files from the instrument. 

 

 

The Method, Response time and Smoothing parameters are only used when the program calculates 

reverberation times from files containing 1/3 octave spectra measured according to the relevant 

standards. This type of data is then visible in the file list as "Calculated RT60". 

 

Note: It is important to set the Method according to the real measurement conditions: Decay or 

Impulse.  

 

Note: If both RT60 results and logger data are present in the loaded file (which is possible with some 

Svantek instruments), only the RT60 results will be taken into account. 

 

 

 

You can create the separate Reverberation task by selecting Reverberation time as the Task type in 

the General section of the Building acoustics wizard. 
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Figure 11-20. Reverberation time task. 

 

If you press the Next button, you will be taken to the Reverberation time section. 

 

 

 

11.4.5 EVALUATION OF INSULATION INDICES AND REPORT GENERATION 
 

When the  Next button is pressed in the Reverberation time section, the evaluation of the insulation 

indices and generation of the report will begin.  

 

 
Figure 11-21. Assessment of insulation and generation of the report. 

 

 

Upon successful evaluation, the Building acoustics wizard presents the Report preview. 
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Figure 11-22. Report preview section. 

 

 

The report may contain warnings regarding the adequacy/reliability of the measurement data to the 

selected standard. Warnings are displayed in red text at the top of the report.  

 

Note: If the difference between the average sound level in the receiving room and in the background 

is less than 10dB for some frequencies, a warning message is displayed and a correction is added to 

the sound levels in the receiving room. 

 

Note: The Building acoustics wizard allows you to go back to the previous sections and change data 

files and some settings. Changing settings should not override all other settings. There is one 

exception. If you change the Insulation type in the General section, the following sections will be 

cleared. 

 

 

 

 

11.4.6 SOUND INSULATION PROJECTS 
 

Pressing the Finish button closes the Sound insulation wizard and activates the Sound insulation 

project panels. The Tasks navigator will show the Project tree, and the Insulation view will show the 

1/n octave sound insulation curve, the standard curve and the shifted standard curve by default.  
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Figure 11-23. Sound insulation project view. 

 

 

Right-click on any of the curve legends below the graph and select Show calculation parameters to 

open the Calculated Results dialogue box. It displays the calculation parameters and basic results. It 

is possible to select the text in order to copy it to the clipboard. 

   
Figure 11-24. Reviewing calculation parameters and resulting indexes. 

 

Tasks navigator 

• The tree on the left shows all defined tasks. Each task has sub-branches (Source, Receiving, 

Background, RT60, Calculated RT60, Insulation) where the user can access the data used for 

the calculations. 
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• Tasks can be edited by selecting the appropriate branch and using the toolbar icon or context 

menu. 

• Each task can contain multiple calculations & reports for different standards and insulation 

indices. 

• Reports can be accessed using by double clicking or using the context menu. 

 

 

When you click a task in the Tasks navigator, three icons become active, allowing you to:  

• Create new task, 

• Edit task, 

• Delete task. 

 

The same functions are available in a context menu by right-clicking on a task line. 

 

 
 Figure 11-25. Task icons and commands. 

 

 

Note: Task edition means that the Sound insulation wizard is enabled. In the General section, all 

parameters can be edited except of the Insulation type. 

 

If you double-click on the Source, Receiving, Background or RT60 position, in the Task navigator, the 

1/x octave spectrum view will appear. 

 

Note: It is only possible to generate such a Summary Sound Insulation view if appropriate files are 

available and assigned to rooms/partitions. 
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Figure 11-26. Opening 1/x octave spectrum view. 

 
 

 

 

11.5 SOUND INSULATION WIZARD 
 

Sound Insulation Wizard allows you to: 

• Define rooms and partitions to reflect the measurement situation. 

• Easy assign different types of measurement data to rooms and partitions. 

• Perform the calculation of different types of sound insulation indices. 

• Create a report for a given partition. 

To start the Sound Insulation Wizard, use the  button located on the Building Acoustics Toolbar or 

select the Sound Insulation Wizard command from the Tools menu. It is only available if you are 

working with a Building Acoustics Project. 

 

 

11.5.1 DEFINING ROOMS AND PARTITIONS 
 

The first thing you need to do when you start the Sound Insulation Wizard is to define rooms. The 

Add room button is located in the top left corner of the window. 

 

It is mandatory to set at least the Room (room identification) and Room volume parameters. Others 

are optional and acts as additional notes. 

Note: The Add facade button can also be used to define the area outside the building when analysing 

the sound insulation of the facade. 
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Figure 11-27. Defining a room in the Sound Insulation Wizard.  

Once at least two rooms have been defined, it is possible to select them as the source and receiving 

room from the measurement of a newly defined partition. A partition can be defined using the Add 

button in the Partition section in the upper middle section of the Sound Insulation Wizard window. 

 

 
Figure 11-28. Defining a partition in the Sound Insulation Wizard. 
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The rooms selected as source and receiving will be considered side rooms of the partition to be 

created. After setting at least the Partition name and Partition area parameters, it is possible to save 

the partition definition by pressing the OK button. 

 

 

11.5.2 SELECTION OF SOUND INSULATION TYPE 
 

The switch for selecting the type of sound insulation is located in the bottom left-hand corner of the 

Sound Insulation Wizard window. 

 

 
 

 

 

 

Figure 11-29. Selection of sound insulation type for rooms. 

 

 

The possible options are: 

• Airborne R: Apparent sound reduction index, airborne sound insulation between rooms 

• Airborne Dn: Normalized level difference, airborne sound insulation between rooms 

• Airborne DnT: Standardized level difference, airborne sound insulation between rooms 

• Impact Ln: Normalized impact sound pressure levels, impact sound insulation of floors 

• Impact LnT: Standardized impact sound pressure levels, impact sound insulation of floors 

If a façade is selected as the source, types of sound insulation of façades are available: 

• Airborne R45: Apparent sound reduction index according to ISO 140-4, Field measurements of 

airborne sound insulation of façade elements and façades 

• Airborne D2m,n: Normalized level difference, airborne sound insulation of façade elements and 

façades 

• Airborne D2m,nT: Standardized level difference, airborne sound insulation of façade elements and 

façades 

 

 
 

Figure 11-30. Selection of the sound insulation type for façades. 

 

 

11.5.3 ASSIGNING MEASUREMENT FILES 
 

Once a partition and Sound insulation type have been selected, it is possible to assign sound pressure 

level and reverberation time measurement files to a source or receiving room. 
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Note: Only summary results are used if available. Time history results are only used if a specific object 

corresponding to this type of data is dragged from a branch of the Project Objects list (not an entire 

file or channel), or if summary results are not available in the selected file. 

 

 
Figure 11-31. Assigning measurement files to rooms in the Sound Insulation Wizard. 

 

 

In the case of the Reverberation time section, these can be RT60 result files from the instrument (if 

there are few in a file, the average is taken), RT60 results files defined by User function wizard of 

SvanPC++, or results of RT60 analysis performed with SvanPC++, but also loggers containing short 

step Leq 1/1 or 1/3 octave spectrum time histories can be dropped. 

 

To assign a group of files, select them (or an entire folder) in the Project Browser, then drag and drop 

them into the appropriate section of the Sound Insulation Wizard. 
 

 

11.5.4 AUTOMATIC CALCULATION OF REVERBERATION TIME 
 

If a logger containing short step LEQ 1/1 or 1/3 octave spectrum time histories is being dropped on 

the Reverberation time section, SvanPC++ will automatically perform RT60 analysis according to its 

current setup (e.g. taking into account whether the decay or impulse method is selected in the 

Building Acoustics toolbar). This type of data is then visible in the lists as "Auto RT60". 

 

Note: If both RT60 results and logger data are present in the loaded file (e.g. for SV 97x instruments), 

only the RT60 results will be taken into account. 
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Figure 11-32. Automatic calculation of reverberation time upon assignment of logger files. 

 

Project sessions named according to the pattern ‘Auto RT60 – [room id] – [filename]’ will be created 

and the calculated RT60 results will be assigned. 

 
Figure 11-33. Selection of the Loudspeaker position in the Source section of the Sound Insulation Wizard. 
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Note: When calculating the insulation, all assigned spectra and reverberation time results are 

averaged. 

The ISO 16283 standard requires the measurement and averaging of results in a receiving room for 

different source positions. Therefore, selecting this standard in the New Project Wizard, different 

source points can be defined in the Source section of the Sound Insulation Wizard window. 

 

 

 

 

11.5.5 CALCULATION OF INSULATION 
 

After pressing the Run calculations button in the Sound Insulation Wizard, a new session named 

according to the pattern ‘SI – [type of insulation] – [partition id]’ is automatically created in the 

Project Browser and a dialogue box as shown in the figure below is displayed. 

 
Figure 11-34. Basic results of calculation of insulation. 

 

This dialogue box displays the basic results of the sound insulation calculation. After clicking the OK 

button, the 1/1 Octave or 1/3 Octave view of the newly created 'SI - …' session is displayed. 

Note: If the difference between the average sound level in the receiving room and in the background 

is less than 10dB for some frequencies, a warning message is displayed at the bottom of this window 

and a correction is added to the sound levels in the receiving room. 

 

By default, the view displays the 1/n octave sound insulation curve, the standard curve and the 

shifted standard curve. In addition, the view configurator allows a subset of the following supporting 

functions to be displayed: 

• 1/n octave averaged source room (result of averaging spectrums assigned to source room) 

• 1/n octave averaged receiving room 

• 1/n octave averaged background noise (from the receiving room) 

• 1/n octave delta Lsrc-Lrcv (the dB difference between sound pressure levels in the source room 

and the receiving room) 

• 1/n octave delta Lrcv-Lbkgnd (the dB difference between sound pressure level in receiving 

room when the omnidirectional sound source or tapping machine was operating in the source 

room and the background noise in this room) 

• Aver RT60 (averaged RT60 results from the receiving room) 
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Figure 11-35. The Sound Insulation view – plot of sound insulation curve, norm curve, shifted norm curve. 

 

Right-click one of the functions in the table below and select the Show calculation parameters to 

open the Calculated Results dialogue box. It displays calculation parameters and basic results. It is 

possible to select the text for copying to the clipboard. 

 

 
Figure 11-36. Reviewing calculation parameters and resulting indexes. 
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The Run calculations button in the Sound Insulation Wizard can be used multiple times for a single 

partition. The Show results button opens the last generated view with calculation results. 

 

 
Multiple Sound Insulation types view 

 

The Run calculations button runs calculations for a single Sound insulation type, displayed in on the 

corresponding SI – Airborne view, see Figure 11-35. 

The commands available in the pull-down menu, accessible via the Run calculations button, allow you 

to create a single SI – Airborne with multiple calculation results for all types of airborne or impact 

insulation. 

 

 
Figure 11-37. The Sound Insulation view with multiple types of insulation. 

 

Note: It is only possible to generate such a Summary Sound Insulation view if appropriate files are 

available and assigned to rooms/partitions. 
 

 

 

 

 

11.5.6 REPORTING ON INSULATION CALCULATION RESULTS 
 

The most convenient way to generate a report is to use the Report button in the Sound Insulation 

Wizard. 
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Figure 11-38. Generating report from Sound Insulation Wizard. 

 

 

A report named according to the pattern ‘SI – [partition id]’ is added to the Project Reports section 

and the file is opened using MS Word. 

 

 

 

11.5.7 BUILDING ACOUSTICS REPORT TEMPLATES 
 

The Report templates are part of the Svan Projects module. 

 

Specifically, for the Building Acoustics module, Report templates for sound insulation according to 

ISO 140 and ISO 16283 standards have been prepared by Svantek and are installed together with 

SvanPC++. After opening the Report templates browser using the  button in the Projects Toolbar, 

a system file path to the folder containing the template files is available. The Building Acoustics 

templates are located in the Building Acoustics subfolder. 

 

A report may be conveniently generated by dragging and dropping a view of sound insulation results 

onto a desired template file. 

 

Users can modify the Svantek templates and add their own templates, as described in Chapter 10.4. 
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Figure 11-39. Accessing the list of Building Acoustics report templates. 

 

 

 

 

11.6 BUILDING ACOUSTICS APPLICATION PROJECTS 
 

SVANTEK offers a special application for smartphones and tablets – Building Acoustics – which 

enables quick and easy measurements and evaluation of sound insulation indices according to 

ISO 140 and ISO 16283 (see Building Acoustics User Manual on the Svantek website). 

 

The application allows the user to: 

• create the project by defining its type (airborne, impact), standard, rooms and partitions, and, 

in the case of the ISO 16283 standard also the sound source positions, 

• perform measurements with one or two measuring instruments simultaneously, 

• create a report according to the selected standard and insulation index, 

• export the created project to a PC as a batch file with the .svz or .spr extension. 

 

Building Acoustics generates projects as a file with the .svz extension. You can open these batch files 

in SvanPC++ as a complete project with sessions and reports. After opening such a project, the Sound 

Insulation view is displayed with sound insulation curve, standard curve and shifted standard curve. 
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Figure 11-40. Opening project from Building Acoustics application. 

 

The instrument icons indicate the origin of files that are not physically attached to the project. These 

files are saved in the instrument with the corresponding names. 

If the instrument is connected to a PC, the program automatically downloads files from it when the 

project is opened. 

If the instrument is connected to a PC later, the files can be downloaded using the Download 

command from the context menu. 

 
Figure 11-41. Downloading files from the connected instrument. 
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Photos or links to them can be attached to the project by the Building Acoustics application so that 

you can open them. In the case of links, you must have a smartphone connected to the PC to open 

a photo. 

 

All rooms and room partitions are already defined by Building Acoustics and measurements are 

assigned to rooms by category (Sound pressure level, Reverberation time and Background noise). You 

can view these by opening the Sound Insulation Wizard. 

 

 
Figure 11-42. Sound Insulation Wizard with defined rooms/partitions and assigned measurements. 

 

 

If you want to generate the report in MS Word, double-click on the corresponding file in the Project 

Reports tree (in the example above - 16283-1 DnT). 
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Figure 11-43. Report of Sound Insulation measurements performed by Building Acoustics application. 

 

 

 

 

 

11.7 STIPA PROJECTS 
 

STIPA (Speech Transmission Index for Public Address Systems) projects are created by some Svantek 

instruments or by the Building Acoustics application for mobile devices and can be processed by 

SvanPC++. 

 

You can create the STIPA project using the Building acoustics wizard. To do this, use the New project 

command from the File menu or the  button on the Main Toolbar. In the opened New project 

dialogue box, fill the Title and Comment fields and select the Building acoustics project. In the Sound 

insulation wizard, select STIPA in the Task field. 
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Figure 11-44. STIPA project creation with the Building acoustics wizard. 

 

 

 

11.7.1 PROJECTS FROM THE BUILDING ACOUSTICS APPLICATION 
 

The Building Acoustics application generates projects as a file with the .svz extension, which can be 

opened by SvanPC++. When you double-click on the file, SvanPC++ recognises it as a STIPA project 

and displays the measurement data in the special STI view. 

 

The STIPA results are grouped in a window with the division into areas, sources and points for the 

selected project. 

 

Each point in the view is a button which, when pressed, displays the measurement results for that 

point. 

 

Each measurement also has a "check box" which can be used to enable / disable a particular 

measurement - in this situation the STIPA results for the point and higher groups are automatically 

recalculated after the measurement is enabled/disabled. 
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Figure 11-45. Presentation of STIPA data in the STI view. 

 

The columns to the right of “Source calibration [dB]” show data measured for 7 octave bands: noise 

level (LZeq) and modulation factors for two modulation frequencies (m(1) and m(2)). 

 

 
Figure 11-46. Right part of the STI view with data for 7 octave bands. 

 

Each point after the extension has background noise results at the end of the list of measurement 

points. 
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The cells containing the background noise results are editable, i.e., you can manually enter values for 

individual octaves (simply double-click on the selected value for the background noise). Such a change 

will automatically convert the results for one point and above. 

 

You can also import background values using the paste option (CTRL+V or menu "Edit-> Paste") after 

selecting the value from which you wish to paste the results. Data in the clipboard will be pasted for 

the next octaves starting from the selected cell. You can copy data to the clipboard from MS Excel, 

from another program or from another view of SvanPC++ (thanks to which you can import results 

from another .svl file). If the clipboard contains numerical values separated by a white space (space, 

tab, enter), the program will accept them correctly. 

 

 

11.7.2 PROJECTS FROM SVANTEK INSTRUMENTS 
 

 

If you didn’t use Building Acoustics and performed STIPA measurements directly by the Svantek 

instruments, then you may retrieve data from the STIPA catalogue of the instrument to the Svan 

Project destination or Folder destination with the use of SVAN Files dialogue box.  

 

In the first case, you need to create the Standard project first, otherwise the Svan Project destination 

button will be inactive.  

 

 
Figure 11-47. Retrieving STIPA data directly to the SvanPC++ project. 

 

After retrieving STIPA catalogue to the SvanPC++ project you should create a “STIPA session”. To do 

this, select all files for measurement points (excluding NOISE.SVL files), then click with the right mouse 

button and select the Speech transmission index position in the context menu. 
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Figure 11-48. Creating STIPA session in the Standard project. 

 

If you select Folder destination, then you should copy the STIPA catalogue to a PC and then drop the 

whole catalogue to Project Objects of the Project Browser.   

 

You may also use the Simple project option. In this case you should first create the Simple project and 

then drop the whole catalogue to the session panels section. 

 

  
Figure 11-49. Creating STIPA session in the Simple project. 
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12 REMOTE COMMUNICATION MODULE 

 

SvanPC++ Remote Communication (RC) is an additional module of the SvanPC++ software package 

that focuses on remote acquisition and presentation of data from Svantek measuring instruments in 

continuous operation mode. To use this module, it is necessary to purchase Remote Communication 

key for each instrument that is to be used with the module. 

 

The RC module adds the following features to the SvanPC++ software: 

• On-demand and automatic remote data download from Svantek instruments. 

• Measurement status monitoring and verification, system check, alarming. 

• Remote instrument configuration and control. 

• Data export and publishing tools. 

 

Most of the functions of the RC module can be accessed from the Remote Communication Center 

window. To open it, use the Remote Communication Center command from the Communication 

pull-down menu available on the Toolbar ( ), or the SVAN menu » Remote Communication... » 

Remote Communication Center… command. This window is described in more detail in 

Chapter 12.2.1. 

 

Several interactive guides to the RC module are available on the Svantek website. 

 

 

12.1 REMOTE CONNECTION 
 

The RC module supports the following connection methods: 

• Direct connection via RS232 (single device) or USB cable (multiple devices), 

• Internet (GPS), 

• Wi-Fi/LAN (MOXA), 

• Bluetooth, 

• ZigBee. 

 

Connection settings can be configured manually. You can also use the Remote Connection Wizard, a 

tool that allows you to configure both the instrument (or monitoring station) and the PC for 

communication via the Internet or Local Area Network / Wi-Fi. 

 

 

 

12.1.1 MANUAL CONFIGURATION OF CONNECTION SETTINGS 
 

The settings for all SvanPC++ remote communication modes can be configured using the Remote 

Settings dialogue box. It can be opened from the menu: SVAN » Remote communication... » Advanced 

Settings... » Remote Settings, or by using the  button in the Remote Communication Center. 

 

Note: Any changes made to the remote connection settings while an RC session is running will not 

take effect until the session is restarted. 

 

 

http://svantek.com/software/svanpc-remote-communication-module.html#anim
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Connection type 

 

Selecting a connection type affects all aspects of remote communication in SvanPC++. Selecting one 

of the five connection types enables a number of options that are available for that connection type. 

 

 
Figure 12-1. Remote Settings dialogue box. 

 

For the USB and RS232 connections, you can set:  

• Buffer size for block operations – relates to the situation when file downloading from the 

Svantek instrument is supported in block parts instead of downloading whole files at once. The 

parameter determines the size of the file parts downloaded at once. 

• Timeouts – determines the time limits for retrying a Reading or Writing operation if it cannot 

be completed successfully due to connection problems. 

 

For the Internet connection, you can set: 

• Buffer size for block operations and Timeouts (the same as for a direct connection, but in this 

case there is also an Automatic option). 

• Local IP – determines manually or automatically using the Check IP button. 

Note: If more than one network card is available, the automatic check will set the number of the 

first of available card. You can change the number manually after it has been set automatically. 

• Specific options for UDP and TCP protocols, such as port number, etc. 

Note: Different types of Internet connection are available and can be selected for each station 

independently. See Chapter 12.1.2 for details. 

 

For the ZigBee connection it is possible to add, remove and configure networks and set timeouts. 
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Figure 12-2. Remote Settings dialogue box for ZigBee connection. 

 
Simple mode 

 

If no instruments are connected via USB, the active connection type (Internet or local network) is set 

as selected in the Connection configuration wizard. This is indicated in the message at the bottom of 

the window. 

Simple mode uses the list of instruments defined by Remote Connection Wizard and doesn’t allow 

you to add or remove defined instruments outside of the wizard functionality – it only applies to the 

Internet connection. In addition, selecting the Simple mode disables the Internet settings. These 

settings are automatically configured. Therefore, the controls  are not 

displayed in Simple mode . 

 

Note: When you use the Remote Connection Wizard to connect instruments, the Internet settings 

are configured and Simple mode is automatically enabled. 

 
 

Common settings 

 

The Remote Settings dialogue box also allows you to set: 

• Retry Counter and Retry timeout – if the connection is lost, the service will only attempt to 

reconnect the number of times specified by the Retry counter and for no longer than the time 

specified by the Retry timeout. If the number of attempts or time to successful reconnection 

exceeds the specified limits, the program will stop trying to reconnect. 

• Station AS password (USB) – password used by the service to connect to the Svantek server 

when communication is enabled in the Address Server (AS) system. This tool can only be used 

when the instrument is connected to the PC via USB. 
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12.1.2 INTERNET CONNECTION TYPES 
 

The RC module supports communication with multiple stations using different types of Internet 

connection simultaneously. Available connection types include: 

• TCP/IP via SvanNET, 

• TCP/IP (Address Server or AS), 

• TCP Client, 

• TCP Manual, 

• TCP / UDP CRP, 

• UDP Manual, 

• FTP. 

 

The connection type is defined separately for each station at the moment it is added via the Remote 

Communication Center (described in Chapter 12.2.1) or the Svan Files dialogue box. 

 

 
Figure 12-3. Controls related to the connection type in the Remote Communication Center. 

  

 

The Type column shows the type of the Internet connection. You can add a new station by clicking 

on the  button. When you click on it, a new window appears where you can select the connection 

type of the station.  
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Figure 12-4. Selecting the internet connection type for a station. 

 

The station connection can be changed later by using the next two buttons. By clicking on the  

button, the Select connection type window will appear, and you will be able to select a new 

connection type for the existing station. By clicking the  button, you can change the details of the 

station in relation to the selected connection type. Note that changing the connection type alone 

does not change any settings and it is likely that the station details will also need to be edited 

afterwards. Connection types are described below. 

 
TCP/IP (SvanNET) 

SvanNET is an internet service that simplifies the remote connection between a PC and Svantek 

monitoring stations. To use it, you must obtain an account and configure the authentication details. 

For details, see the SvanNET user manual on the Svantek website. If the connection type is TCP/IP, 

only two parameters should be set: station type and serial number. 

 

  
 

Figure 12-5. Station settings related to the TCP/IP Internet connection via SvanNET. 

http://www.svantek.com/
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TCP/IP (Address Server) 

The station is configured as a TCP Server and must provide its address to the Svantek address server. 

In this case it is necessary to enter the AS password. The station will exchange data by first 

downloading the current IP address from the Svantek server and then connecting to it. The AS 

password can be read from the Svantek instrument using the AS station password dialogue box 

accessible from the Remote Settings window (see Chapter 12.1.1). 

Note: This type of connection is called “TCP AS” in the Remote Communication Center. 

 

  
Figure 12-6. Station settings related to the TCP/IP Internet connection via Address Server. 

 
TCP Client 

The station is configured to initiate a connection to the client PC. In this case a window will open 

where the program will listen for the incoming connection. Regardless of whether this is enabled in 

the remote settings or not, the device will listen for incoming TCP connections on the specified port 

and adjust the settings if the station successfully connects during the procedure. When this happens, 

the connected station is added as a TCP client t. 

 

 
Figure 12-7. Station settings related to the TCP Client Internet connection. 

 

 

 
TCP Manual 

The station is configured as a TCP Server. The user is prompted to enter an IP address (or domain 

name) and port number for a direct TCP connection. 

Note: This type of connection should be selected for stations registered in DynDNS (SV 200). 
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Figure 12-8. Station settings related to the TCP Manual Internet connection. 

 
 

TCP / UDP CRP 

The station is configured either as a TCP Server or as a UDP server and will provide its IP address and 

port via the Connection Request Packets. In this case, a window will open in which the program will 

listen for incoming UDP packets on the designated port, regardless of whether this option is enabled 

in the Remote settings or not. After receiving the CRP packet, the station is added as a TCP CRP or 

UDP CRP and the settings are changed accordingly. 

 

 
Figure 12-9. Station settings related to the TCP / UDP CRP Internet connection. 

 
 

 

UDP Manual 

The station is configured as a UDP. The user is prompted to enter an IP address (or domain name) 

and port number to exchange data packets with the station via the UDP protocol. 

 

 
Figure 12-10. Station settings related to the UDP manual Internet connection. 
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FTP 

The station is configured to use the FTP push / FTP pull protocol – a feature of some instruments 

(e.g., SV 200, SV 307, SV 803). The user is prompted to specify the station type and number, the name 

of the FTP server, the credentials to authorise access to the server, and the paths where the 

measurement data and configuration file will be stored. The station will use the FTP push functionality 

to periodically upload measurement data to a known FTP location and will use the FTP pull 

functionality to retrieve the configuration file from the FTP location. The FTP station in SvanPC++ 

means that the station will connect to a designated FTP server and download data (in Svan Files and 

RC sessions) or upload the station’s configuration (in Station Configuration session). 

 

 
Figure 12-11. Adding FTP station. 

 

 

12.1.3 REMOTE CONNECTION WIZARD 
 

The Remote Connection Wizard automatically detects the capabilities of the connected devices and 

selects the optimum method for exchanging data. It then adds the configured stations to a list of 

devices used as a reference for all remote communication functions. The only requirement is to know 

the APN – mounting point of the SIM card that is used with the station – and to select between 

Internet and Local Area Network connection types. 

 

To open the wizard, use the Connection configuration wizard command from the SVAN menu or from 

the pull-down menu opened by the  icon on the Toolbar. 
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Figure 12-12. Remote Connection Wizard window. 

 

The Remote Connection Wizard makes it easy to configure a connection to Svantek instruments using 

the following networks: 

• Internet 

When the wizard is used to configure the Internet connection, all Internet settings are 

automatically configured and the Simple mode is enabled; see also: Remote settings. 

• Ethernet (wired LAN) 

In this case the wizard allows you to specify the network address of the station. 

• Wi-Fi (in infrastructure and ad hoc modes) 

In this case the Wizard helps you to select a network or create a network (ad hoc only). 

To change the connection system, press the New connection system button (in the bottom-left corner 

of the window). The Select system type... dialogue box will appear. 

 

 
 

Figure 12-13. Select system type… dialogue box. 
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Figure 12-14. The Select system type... dialogue box of the Remote Connection Wizard. 

 

 

 

Press the More... button to access other available connection systems. To hide them, press the Simple 

button. 

 

Note: In the case of an Internet connection, the wizard uses the same algorithm to select the 

connection type for each connected station independently: first it configures the station for TCP AS 

communication and then it determines whether the station can act as a TCP Server or not (in the 

latter case, the configuration is changed to TCP Client). 

 

Further instructions on how to connect your device using this wizard are available on the Svantek 

website in the form of video tutorials. 
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12.2 INSTRUMENT MANAGEMENT AND CONFIGURATION 
 

12.2.1 REMOTE COMMUNICATION CENTER 
 

The Remote Communication Center dialogue box is the heart of remote communication in the 

SvanPC++ software. It allows you to: 

• manage the instrument configuration, 

• configure and start automatic data acquisition, 

• access the alarm configuration, 

• check the status of the instrument (measurement status or more detailed information, such as 

remaining logger space) and display its parameters, 

• start and stop measurements in a connected instrument. 

 

To open the Remote Communication Center, use the appropriate command from the SVAN menu or 

from the  pulldown menu. 

 

 
Figure 12-15. Remote Communication Center dialogue box. 

 

The Instruments panel contains a list of defined instruments/stations. To add units you want to 

communicate with to the list, initiate the connection using the Remote Connection Wizard (available 

from the SVAN menu). 

 

The AFD, CLD, LR and RS columns indicate whether a station is active in Automatic Files Download, 

Continuous Logger Download, Live Results and Remote Session respectively. These data acquisition 

tools are described in Chapter 12.3. 

 

In the case of an Internet connection, the Type column is also displayed in the Instruments table to 

indicate the type of connection for each station. See Chapter 12.1.2 for details. 
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Note: To connect a new instrument, you must ensure that there are no RC sessions in progress. If 

Simple mode is enabled via Station Settings, adding or removing instruments is not allowed outside 

the Remote Connection Wizard. If a direct cable connection is currently active, the list is automatically 

updated at the moment of connection/disconnection. 

 

The background colour of the Status field for the connected stations flashes in green when the 

measurement is in progress. When the measurement is stopped, the background colour of the Status 

field changes to red, as shown in the figure below. 

 

 
 

 
 

Figure 12-16. A row in the Instruments table in the Remote communication center. 

Flashing green background of the Status field means that measurement is currently 

in progress, while static red one – that the measurement is stopped. 

 

 

When you select a station from the list, the inactive buttons become active. 

 

 
Figure 12-17. Selection station in the Instruments list. 

 

 

The buttons on the right of the window allow you to: 

• Configure the instrument settings (Station configuration). 

• Download files from the instrument (SVAN Files). 

• Communicate with instruments using different types of RC sessions (Automatic files 

download, Live results preview, Remote session, Continuous logger download). 

• Configure online alarm settings (Alarms), 

• Terminate all current RC sessions (Terminate RC service). 
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To remotely start a measurement in the connected instrument(s), select the instrument(s) and use 

the Start measurements button. To update the current measurement status of the selected 

instrument(s), use the Check instrument(s) status button. For stations connected via USB, the status 

is updated automatically. 

The  button opens the SvanNET User Panel in an Internet browser; the  button synchronises 

list of instruments in the Remote Communication Center with the configured SvanNET account. See 

also SvanNET User Manual published on the Svantek website. 

 
Figure 12-18. Opening the SvanNET User Panel. 

 

Note: If SvanNET credentials have been entered, the title of the Remote Communication Center 

window contains the SvanNET account name. 

You can also display more detailed information about connected instruments by pressing the Toggle 

mode button. An additional part of the Remote Communication Center window will be opened 

containing the values of various parameters such as free space, battery status, etc. You can copy all 

the displayed data to the clipboard for later use pressing the Copy to clipboard button. 

 
 Figure 12-19. The instrument details displayed in the Toggle mode. 
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12.2.2 STATION CONFIGURATION 
 

Station(s) Configuration, accessible from the Remote Communication Center, is a comprehensive tool 

for configuring an instrument/monitoring station. The availability of certain sets of options depend 

on the type of configured Svantek instrument. 

Note:  The Station(s) configuration tool only allows general instrument settings to be configured. The 

Setup file editor, accessible from the SVAN Files window, allows the full range of settings (see 

Chapter 3.3). 

 

When you open this dialogue box, the station settings are automatically downloaded so that you can 

work with the current settings. 

 

All connected devices are listed on the left side of the window. The set of configuration options 

available depends on the device. 

 

  
Figure 12-20. Station(s) configuration dialogue box. 

 

You can use the following buttons to communicate with stations: 

 

 
 

− sends the settings made in the Station(s) configuration dialogue box to 

all connected devices of the same type (e.g. all SVAN 977 instruments). 

 

 
 

− downloads the current settings from the connected device and sets all 

the options to the read values. 
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− sends the settings made in the Station(s) configuration dialogue box to 

the selected device. 

 

 
 

− opens a dialogue box to communicate with the station manually sending 

commands in the SVAN protocol. 

 

 
 

− sends the settings made in the Station(s) configuration dialogue box to 

all the connected devices. 

 

The settings can be saved to a file in local catalogue and restored in the Station(s) configuration 

dialogue box using the Load Setup / Save Setup buttons (at the bottom of the window). 

 

To configure a connected station, select it from the list on the left side of the window and select the 

type of settings you wish to change. The settings available for configuration are grouped into several 

categories, described below. 

 

In the General settings, available after selecting the instrument/station name in the list, it is possible 

to (Figure 12-21): 

• Set a Name for each connected station, 

• Add a Comment for each connected station, 

• Set the Remote Control Mode, which disables all the automatic messages of the instrument 

and require manual control. 

 

The Measurement setup panel allows you to configure various measurement settings such as: 

measurement result, filter/detector for specific channels and profiles, logger settings of the 

connected instrument via your PC. The measurement settings are grouped into 5 sub-categories: 

General measurement setup, Channels, Logger, Advanced and External I/O settings. 

 

Audio Events settings are also available for some instruments as a subset of the Measurement setup 

/ Logger settings. This category of settings allows you to configure various parameters of Wave and 

Event recording, such as sampling, format, etc., reflecting the functionality of the instrument.  

 

The External I/O settings allows you to program the functionality of the instrument’s I/O socket to 

work as the Analog out, Digital out, Digital in or as an interface for the connected device (tacho probe, 

weather station, etc.) 

 

The Remote communication panel allows you to configure the connection settings related to Internet 

connection and registration options. To enable configuration of these settings, uncheck the Skip 

remote connection configuration checkbox. 

Note: Changing these settings over an active Internet connection may cause the instrument to stop 

responding if the settings are incorrectly entered. 

 

For SV 200 and SV 200A stations, equipped with LAN/Wi-Fi, Bluetooth and GPS modules, the Remote 

communication panel is more complex. It also allows the configuration of wired (LAN) or wireless (in 

Infrastructure or Access point mode) connections, as well as Bluetooth and GPS. 

 

Note: For some older instruments, remote communication settings are only available via USB; if they 

are connected remotely, the Remote communication tab will not appear at all. 
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Internet services allows you to configure the Web Interface (select between static/dynamic mode, 

configure authorisation settings, logins and passwords for Admin and Guest) and FTP (including 

server, login, PUSH and PULL frequency/path settings). 

 

The Alarm settings panel allows you to configure the alarms in the form of SMS or e-mails that are 

automatically sent when a specified event is occurs (for example, the level of the specified 

measurement function is exceeded). To enable SMS / e-mail sending, configure the SMS / e-mail and 

alarm settings and enable the Send SMS / Send e-mail check box. 

 

For some instruments (e.g. SV 200, SV 200A), the alarm functionality is more complex: to configure 

alarms, go to Alarm settings, uncheck Skip alarm configuration, check Use advanced alarm 

configuration and press the Advanced Alarm Configuration button. The Advanced Alarm 

Configuration dialogue box appears. 

 

 
 

 
 

 

 

 

 

 

 

 

 

 

Figure 12-21. Advanced alarm configuration for SV 200. 

 

 

Uncheck 

Check 

1 

2 
3 
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The Conditions tab allows you to specify the conditions that must be met for an alarm to be triggered. 

• Press the Add button at the bottom left of the window and select the condition type (1). 

• Configure the condition parameters in the panel located on the right of the window (2). 

• Remember to save the changes made to the created condition (3). 

• You can add more conditions, remove or duplicate the existing ones. 

 

 
 

Figure 12-22. Advanced alarm configuration for SV200: Events settings. 

 

The Events tab allows you to specify the events that occur when certain conditions are met. 

• Press the Add button in the bottom left of the window (1). A new event is created. 

• Add the conditions that must be met for the new event to be triggered in the Event trigger 

panel (2). 

• Add the actions that the event will trigger in the Event actions panel (3). 

• The event can be activated/deactivated using the Active checkbox above the Event trigger 

panel (4). 

• Save the new event using the Save button (5). 

• You can add more events, remove or duplicate the existing ones. 

 

Note: You can save the current alarm configuration to an external file on your PC and load it later 

using the Export and Import buttons in the top right of the window. 

 

If you leave the Station Configuration window without sending the settings to the instrument by 

pressing Cancel or ESC, the changes will not be applied for Automatic Files Download and/or 

2 

1 

3 

4 

5 
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Continuous Logger Download settings verification process. For this reason, a warning message is 

displayed, and confirmation is requested to prevent accidental cancellation of the station 

configuration. 

 

 
 

Figure 12-23. A warning message displayed when cancelling the Station(s) Configuration changes. 

 

 

12.3 DATA ACQUISITION METHODS 
 

The RC module allows you to use remote connection modes to acquire measurement data from 

Svantek instruments. 

For manual data acquisition, you can use the SVAN Files dialogue box, accessible from the Remote 

Communication Center or via the  icon on the Toolbar. This tool is described in Chapter 3.2.1. In 

the case of a remote connection, the instrument can be selected from the list by pressing the Change 

button. 

 

The RC module also provides several methods for automatic data collection: 

• Live Results – allows for remote viewing of current results: 

a) frequent reading of current results from instruments - default interval: 1 second 

b) display of profile & meteo results 

c) HTML / CSV export 

d) pros: 

− fast reading of results from instrument 

− display alone requires no disk space 

− little to no configuration required on the instrument side 

e) cons: 

− merged data export (history) is affected by connection loss (lost data) 

f) usage: preview of measurement results, display of current results 

 

• Automatic Files Download – allows files to be downloaded periodically: 

a) periodic download of measurement files (result, logger, csv, wave) files - default interval: 

1 hour, minimum: 1 minute 

b) instrument management – memory status, device validation 

c) allows HTML / CSV export 

d) pros: 

− downloads selected file types to a PC disk 

− configurable storage clearing (only when all files are downloaded) - hourly, daily, 

weekly, monthly 
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− system check (periodic or during clearing), clock check, settings validation - during 

clearing procedure 

− merging options 

− configurable file naming 

− HTML / CSV export, daily merge option available 

− FTP upload (instrument files, exported data) 

− in case of connection loss, older results are downloaded first, so no data is lost 

e) cons: 

− requires instrument to be properly configured  

− memory synchronisation takes time, no live data 

f) usage: file download when no live data is needed, export tools allow data publishing. 

 

• Continuous Logger Download – allows logger results to be downloaded during the 

measurement: 

a) frequent downloading of logger files - default interval: 1 second 

b) instrument management - clearing, instrument validation 

c) HTML / CSV export 

d) pros: 

− downloads loggers to PC disk 

− daily instrument validation - clearing, system check, clock check, settings check 

− configurable file naming 

− HTML / CSV export, daily merge option available 

− FTP upload (instrument files, exported data) 

− in case of connection loss, older results are downloaded first, so no data is lost  

− logger download is fast after synchronisation and allows live data display through 

SvanPC++ file browsing or HTML / CSV export 

e) cons: 

− requires instrument to be properly configured  

− only downloads loggers, not WAV (samples can be exported from logger events) 

− initial storage synchronisation takes time 

f) usage: logger download with possibility to view live data, export tools allow data 

publishing. 

 

• Remote Session – allows the execution of programmable measurement sessions: 

a) configurable measurement task: 

− instrument configuration (optional) 

− start measurement (optional) 

− results for defined period or infinite 

− stop measurement  

b) display of result (profile, octaves) 

c) logger download & clear 

d) HTML / CSV export 

e) pros: 

− logger download  

− live data display (based on current results) 

− spectrum display 

f) cons: 
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− affects instrument settings 

− no full support for fully automated solution 

− live data affected by loss of connection  

g) usage: short or medium user monitored measurement task solution with live data & logger 

download 

 

 

12.3.1 LIVE RESULTS 
 

The basic functions of the Live Results tool are: 

• Collect current results data from many devices periodically (every 1, 2, 5, 10, 20, 30 or 60 

seconds), 

• Collect meteo or dust results for monitoring stations (SV 200, SV 200A, SV 307, SV 279 and 

SV 277), 

• Visualisation of results in real time. 

 

To open the Live Results dialogue box, press the Live results preview button in the Remote 

Communication Center (see figure below). 

 

You can select the station from which the results will be read using the Station selector. 

 

 
 

Figure 12-24. Live Results dialogue box. 

 

 

To view the results in the table at the top of the window, you must select the results to be displayed. 

To do this, press the Configure results button. The WWW & Live Results / FTP Selection dialogue box 

appears. 
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Figure 12-25. WWW & Live Results / FTP Selection dialogue box. 

 
 

This dialogue box allows you to: 

• Select data to be displayed, 

• Select data to be included in HTML / CSV exported files, 

• Select file types to be used for automatic upload to an FTP server. 

 

When this dialogue box is opened, the current settings are downloaded from the device and the list 

is automatically filled with all the functions currently being measured. To display a function in the Live 

Results preview, tick the corresponding Show in Live Results option. 

 

The data is automatically refreshed with the step set in the Read step selector. 

• To start/stop a Live results preview session, use the  /  button at the 

bottom of the window. You can then use the  /  

button on the right of the window to start or stop the measurement in the current Svantek 

instrument. The results will be updated when the selected reading time is reached. 

• The  button can also be used to stop a session, but unlike the Stop button, it will 

stop the current action immediately, rather than waiting for it to finish. 

• The  /  button turns on/off the electrostatic 

actuator of the current Svantek instrument, which forces a 94 dB reference signal onto the 

microphone input. If the instrument's calibration factor is correct, the measurement results 

should equal approximately 94 dB after some time. 
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You can enlarge the results displayed by simply clicking on a cell in the results table. The Results focus 

window will appear containing the enlarged data and information about the function being displayed 

(instrument, measurement settings, units). You can have several Result focus windows open at the 

same time. 

 
Figure 12-26. An example of Live results enlarged view window. 

 

The HTML publishing and FTP upload functions are available after activating the corresponding check 

boxes in the lower part of the window. See Chapter 12.4. for details. 

 

 

12.3.2 AUTOMATIC FILES DOWNLOAD 
 

The basic functions of the Automatic Files Download tool are: 

• Periodic download of results and/or logger files with configurable period (hourly, daily, 

monthly or custom – with minimum step of 1 minute), 

• Download of files from pen drive, 

• System check functions for monitoring stations with built-in microphone actuator (e.g. SV 200, 

SV 307), 

• Periodic clearing of the instrument file memory – with different period setting than for 

download, 

• Logging of all commands sent to the meter. 

 
Figure 12-27. Automatic files download dialogue box. 
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To open the Automatic files download dialogue box, press the Automatic files download button in the 

Remote Communication Center. 

 

The list at the top left of the window contains information about the connected stations. Stations can 

be added to the list using the Remote Communication Center. The table at the top right of the window 

contains information about a selected instrument in the list. 

 
Downloading files 

 

To start / stop the Automatic files download session, use the Start AFD / Stop AFD button at the 

bottom of the window. The files will not be downloaded immediately, but only when the specified 

download time is reached. The Terminate button can also be used to stop a session, but unlike the 

Stop button, it will stop the current action immediately, rather than waiting for it to finish. It also 

terminates a single upload in progress at the time the Terminate button is pressed, rather than 

waiting for it to complete. 

 

You can also download the files without waiting by clicking the Download now button. This single 

download will not affect the automatic download process if it is started. 

 

To select the types of files to be downloaded (results / logger / CSV / stored on pendrive) and to set 

the downloading period (from 1 minute to 1 month), press the Options button right of the window. 

The Automatic files download options dialogue box will appear. 

 

  
Figure 12-28.  Automatic files download options dialogue box. 
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You can also configure: 

• The path where the downloaded files will be saved. 

• The file naming mode: 

o Use original file name – the downloaded files keep the same name as on the instrument, 

but an additional folder is created. The folder name is set using a specified prefix, the unit 

name and serial number, e.g.: 

C:\Program Files\Svantek\SvanPC++\AutoDownloadedFiles_SVAN_959_11295\01JAN0.svn 

o Append S/N to original file name – the downloaded file names are created using the original 

name and the instrument serial number, e.g.: 

C:\Program Files\Svantek\SvanPC++\01JAN0_SVAN_959_11295.svn 

• Folder prefix used in the Use original file name mode. 

• Save log – enable/disable saving of the command history for the automatic file download 

session in a .log file with a specified name. 

• Automatic export of audio events recorded by the instrument to WAVE files: after pressing 

the Configure automatic event export, you can enable this functionality and set the path, the 

filename prefix and the minimum and maximum length of the event to be downloaded, as 

shown in the figure below. 

 

  
 

Figure 12-29. Settings related to the automatic export of audio events to WAVE files. 

 

 

These settings apply to all connected stations. To change the file settings for a single station, return 

to the stations table of the Automatic files download window and click the  button in the “File Cnf.” 
column of the line corresponding to the desired station. The Instrument/station downloading options 

dialogue box will appear. 

 

To enable the configuration of individual settings for the selected station, check the Override session’s 
general downloading settings box. The file path, name and folder prefix settings are identical to those 

available in the File saving panel of the Automatic files download options (compare  Figure 12-28 and 

Figure 12-30). 

 

 

 

 

 

 

 



                                                                                     SvanPC++ User Manual   

 

295 

 

 

 

  
Figure 12-30. Modifying files downloading options for a single instrument 

or station in Automatic files download settings. 

 

The instrument’s individual options also allow you to group the downloaded files from the same day 

(Daily) or month (Monthly) in: 

• Separate folders named as year-month-day (e.g. 20140123) or as year-month (e.g. 201401), or 

• Multifiles – only results files are grouped (logger files cannot be grouped in this mode). 

 
 

Deleting files 

 

Once downloaded, the files can be deleted from the instrument’s memory. 

To enable automatic deletion, press the Options button and set the types of files to be deleted (result 

/ logger / CSV / WAVE) and the deletion period (from 1 minute to 1 month) in the Automatic files 

download options dialogue box (see Figure 12-28). The deleting period must be equal to or grerater 

than the download period. 

To manually download the files and delete them from the instrument’s memory, use the Download 

and clear now button. This single download/delete will not affect the automatic download process if 

it has been started. 
 

 
System check 

 

The system check can be performed to check the status of the instrument calibration. This diagnostic 

tool stops the measurements, changes the instrument settings to match a calibration measurement, 

performs the calibration measurement and then resets the instrument to the previous settings and 

restarts the measurements. 

Note: The system check is only available for the instruments with a built-in microphone actuator 

(SV 200, SV 200A and SV 307). 

Press to configure settings for particular instrument 

Files downloading 
settings 

Check to enable 
configuration 
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To enable the system check, press the Options button and select the Perform system checks (if 

configured) check box (see Figure 12-28). Once it is enabled, the Sys. Chk. column will appear in the 

table of the Automatic Files Download window, which contains buttons for configuring system check. 

 

 
 

 

Figure 12-31. System check configuration button and window in the Automatic Files Download session. 

 

In the System check configuration window, you can specify: 

• when the system check should be performed (when files are deleted or at a certain time of 

day), 

• the values of the system check parameters (background value for day and night, periods 

recognised as day and night, timeout value and maximum acceptable deviation of the 

calibration factor(Q)), 

• what to do after the system check (the calculated calibration factor (Q) can be sent to the 

station depending on the success/failure of the system check), 

• whether or not to generate an alarm if the calculated calibration factor is outside the 

acceptable range or if the system check is successful. 

 

You can also run a system check manually using the Perform system check button at the bottom of 

the Automatic files download window. The system check affects the measurements taken by the 

station, o you are prompted to confirm before starting a system test manually. 

 

The station details table at the top right of the Automatic files download window includes a field for 

system check results: Last sys. check status property. It can have the following values: 

• “N/A” – means that the system check has not yet been performed for this station. 
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• “Success (1.56 dB)” – means that the system check has been successfully performed and the 

calculated calibration factor is within the acceptable range; the number in brackets is the 

calculated value of the calibration factor. 

• “Failed (4.78 dB)” – means that the system check has been successfully performed , but the 

calculated calibration factor is outside of the acceptable range. 

• “Failed (N/A)” – means that the system check was performed but was not successful. The 

reason for the failure could be too high a level of background noise or other unpredictable 

factors (the procedure stops repeating system check attempts after the time specified by the 

Measurement timeout parameter in the System check configuration window). 

 

 
 

Figure 12-32. Field related to the results of system checks in the table describing station details 

in the Automatic files download window. 

 

In addition to the system check, it is possible to perform automatic system validation, which can 

consist of: 

• Synchronize time – updates the instrument clock to the PC time, 

• Verify settings – checks if the instrument settings are the same as those specified in the Stations 

configuration dialogue box; if not, updates the instrument settings. 

Note: The alarming feature allows you to send an e-mail alarm if the instrument settings do not 

match during the Verify Settings procedure. See Chapter 12.6.1 for details on alarming. 

 

System validation can be performed after each system check or after each automatic file deleting, as 

configured in the System validation panel of the Automatic files download options dialogue box. 

 
Data export 

 

You can enable saving of the downloaded files in HTML format each time files are downloaded from 

the instrument. The downloaded files can also be automatically uploaded to a specified directory on 

an FTP server. The HTML publishing and file uploading settings are available after pressing the Options 

button (see Figure 12-28 ). See Chapter 12.4 for details. 

 

Note: If the Publish HTML or the FTP upload option is enabled, two additional columns appear in the 

Stations table. 

• The WWW column contains  buttons to select the data from the station to be published in 

HTML and the files to be uploaded to an FTP server.  

• The WWW/FTP column contains information about the enabled data export options enabled 

for the selected station (None / WWW / FTP / WWW FTP). 
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Figure 12-33. Station table in the Automatic files download dialogue box 

with columns concerning online data publishing.  

 

 

 

12.3.3 CONTINUOUS LOGGER DOWNLOAD 
 

The Continuous Logger Download tool is used to remotely collect data from the current logger over 

short periods of time, and also allows daily logger merging, as well as checking settings and checking 

the system. 

 

To use the Continuous Logger Download data acquisition method, press the Continuous Logger 

download button in the Remote Communication Center (see Figure 12-15). The Continuous Logger 

Download  dialogue box opens. 

 
Downloading logger results 

 

When you start a logger download session, all the logger files found in the instrument’s memory are 

downloaded to the PC. When a measurement is being taken in logger mode, a file is created for the 

current logger containing all the results already saved, and then this file is continuously updated with 

the latest results during the measurement.  

 

 
Figure 12-34. Continuous Logger Download dialogue box. 

 

 

The Station list table in the centre of the window contains information about all connected 

instruments/stations and the current status of logger download activity. If a connection error occurs 

with a station, the background colour of the corresponding row in the table will change to red, as 

shown below. 
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Figure 12-35. Station list in the Logger download session dialogue box. 

Red color indicates that a connection error has occurred. 

 

To start/stop the logger download, use the Start/Stop button in the bottom left of the window. The 

Terminate button can also be used to stop a session, but unlike the Stop button it will stop the current 

action immediately rather than waiting for it to finish. 

 

To configure the logger download options, press the Options button. The Continuous logger 

download dialogue box will appear. 

Note: Options can only be configured when the download session is stopped. Otherwise the Options 

button is inactive. 

 

 
Figure 12-36. Continuous logger download options. 

 

The Logger downloading and saving panel allows you to: 

• Set the logger download period (1s ÷ 23h), 

• Select the directory for the downloaded logger files, 

• Select the file naming mode: 

o Use original file name – the downloaded files keep the same name as stored in the station 

memory. In this case, a special folder must be created for each station. You can select one 

of two modes for naming the folders: 

a. Folder prefix (user-specified) + unit name + serial number 

b. Folder prefix (user-specified) + index number 

o Append S/N to original file name – the filename is created from the original name and the 

station serial number. Folders are not created with this option. 
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• Enable - disable logging of commands to a .log file of specified name, 

• Enable / disable daily data saving to a specified directory – the following additional daily data 

saving options are available: 

o Auto daily merge - instead of saving each individual logger file, the files from the current day 

are automatically merged into one file. The file name is made up of the gauge name and 

serial number and the current date. 

o Delete files from download folder after copying - the files that have already been copied to 

the computer can be automatically deleted from the download folder when the daily data 

backup is performed. 

o Archive downloaded loggers - the downloaded files can be copied to an archive folder other 

than the one selected for the daily data saving. 

o Compress archive to monthly ZIP files - the archived files from each month can be 

compressed into a single ZIP file 

• Enable / disable the clearing of loggers in the area where their results are already downloaded. 

• Automatic export of audio events recorded by the instrument to WAV files: after pressing the 

Configure automatic audio event export, you can enable this functionality and set the path, the 

filename prefix and the minimum and maximum length of the event to be downloaded, as 

shown in the figure below. 

 

  
Figure 12-37. Settings related to the automatic export of audio events to WAVE files. 

 

Note: Some instruments support clearing logger files during the measurement process. If available, 

the logger download session will use this future for automatic logger clearing (if enabled). Otherwise 

clearing will be performed during station summary (in configured periods). 

 

The path and naming settings for downloaded files affect all connected instruments or stations. To 

change the file settings for an individual instrument/station, return to the Stations list table of the 

Logger download session window and press the  button, located in the “File Cnf.” column of the 

row corresponding to the desired instrument or station. The Instrument/station downloading options 

dialogue box will appear. 

 

To enable configuration of individual settings for the selected station, tick the Override session’s 
general downloading settings box. In addition to the settings identical to those available in the general 

options, you can specify a separate destination for saving and archiving data for the selected station. 

 

You can use the Show log button to open a Logger window showing all the commands that have been 

executed. 
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Figure 12-38. Instrument/station downloading options dialogue box 

for Continuous logger download. 

 
Station Summary 

 

You can enable automatic station summaries to be performed at selected times during the logger 

download session. The summaries can consist of the following actions (as configured): 

• Synchronize time – updates the unit's clock to the PC time. 

• Verify settings – compares the current station settings with the settings configured in the 

Stations configuration dialogue box (see Chapter 12.2.2). If the settings are different during the 

summary, enabling this option will cause the automatic modification of the station settings to 

be automatically changed to match the remotely configured settings . 

Note: The check only concerns the measurement settings. 

 

• System check – the system check can be performed to check the instrument calibration. When 

activated, this diagnostic tool performs the following actions: 

o Stops the measurements, 

o Changes the instrument settings to suit a calibration measurement, 

o Performs a calibration measurement, 

o Resets the instrument to previous settings, 

o Restarts the measurement. 

Note: The system check is only available for instruments with built-in microphone actuator 

(SV 200, SV 200A and SV 307). 

 

Once the system checks have been enabled, the System Check column will appear in the table in the 

Continuous Logger Download window, with buttons to configure the system checks. 
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Figure 12-39. The System check configuration button and window in the Continuous Logger Download session. 

 

 

The System check configuration window allows you to specify: 

• whether or not system checks should be performed at each station summary (if not, they will 

only be performed is manually requested), 

• the values of the system check parameters (background value for day and night, periods 

recognised as day and night, timeout and maximum acceptable deviation of the calibration 

factor), 

• what to do after the system check (the calculated calibration factor can be sent to the station 

depending on the success/failure of the system check), 

• whether or not an alarm should be generated if the calculated calibration factor is outside the 

acceptable range. 

 

You can also set a time limit for waiting for the daily download to complete. If the daily download is 

not completed within the specified time, this action will be cancelled and the summary actions will 

be performed (unless the Wait until daily download is complete option is set to No timeout). 

 
Publish WWW / SVN upload 

 

You can enable automatically export of downloaded logger results in HTML format. The downloaded 

files can also be automatically uploaded to a specified directory on an FTP server. The HTML 

publishing and file uploading settings are available after pressing the Options button. See Chapter 

12.4 for details. 
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Note: If the Publish HTML or the FTP upload option is enabled, two additional columns will appear in 

the Stations list table. 

• The WWW column contains  buttons to select the data to be published in HTML from the 

selected station and the files to be uploaded to an FTP server.  

• The WWW/FTP column contains information about the export options enabled for the selected 

station (None / WWW / FTP / WWW FTP). 

 

 
 

Figure 12-40. Stations list table in the Logger download session dialogue box 

with columns concerning online data publishing. 

 

Note: Loggers that are not currently written by the instrument can also be exported in HTML/CSV 

format. 

 

 

12.3.4 REMOTE SESSION 
 

The Remote Session is a tool that allows to program and monitor a measurement for a specified 

period of time and:   

• Display and download results, 

• Download and delete logger results, 

• Perform system checks and verify station settings. 

 

To activate a Remote session, press the Remote session button in the Remote Communication Center 

(see Figure 12-15). The Remote Session Settings dialogue box appears. 

 

 
Figure 12-41. Remote Session Settings dialogue box. 
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The list on the left side of this window is consists of two parts: 

1. Common settings that allow you to configure the general settings for all sessions. 

2. The list of all connected instruments or stations below the Common settings. It allows yo to 

configure the measurement settings. 

  

All the settings can be saved in .txt format and loaded later using the Save Setup and Load Setup 

buttons at the bottom of the window. 

 
Common settings 

 

In the Common settings tab, you can select the Session Mode: 

• The Transmit commands and receive replies mode means that after the instrument/station is 

configured and the measurement is started, the RC module will acquire data by sending 

commands and collecting replies. 

• The Configure, start and receive replies only mode means that after the instrument/station is 

configured and the measurement is started, the RC module will passively wait for data to be 

sent by the instrument (in this case the RC module does not control the data to be received). 

 

Note: The Configure, start and receive replies only mode can be useful in a situation where results 

need to be acquired from one or more instruments at short time intervals (e.g. 0,5 s). Sending 

commands and waiting for the RC module to respond would be ineffective, unlike the mode in which 

the instrument automatically sends results, allowing greater accuracy. 

 

The Common settings also allow you to specify the directory where the results obtained during 

remote sessions will be saved. In addition to setting the path, you can also choose to create 

subdirectories for the downloaded files. 

• You can select a folder for all sessions (with a given name, with or without date and time 

appended). 

• You can also choose to create a separate folder for each session. Its name is created from a 

given prefix and the remote address of the session. 

It is also possible to automatically remove the subdirectories where no files are saved during remote 

sessions (Remove empty directories). 

 

The Commands logger allows you to save the commands exchanged during a remote session in a .log 

file with a name of your choice. 

 

The Result Web Publishing panel provides options for exporting results to HTML format and uploading 

the files to an FTP server. If logger files are selected for publishing, the Logger Web Publishing panel 

also allows you to select the time period from which the data should be uploaded. The HTML 

publishing and FTP uploading tools are described in more detail in Chapter 12.4. 

 
Individual settings 

 

To set the start and stop time of the measurement session for a single instrument/station, select it 

from the list and go to Measurement settings. You can also start a session without specifying a time 

period: the session will start immediately after pressing the Start button and will only stop when 

requested. 



                                                                                     SvanPC++ User Manual   

 

305 

 

  
Figure 12-42. Setting the start and stop time of a programmable remote measurement session. 

 

In addition to the common file download options set in the Common settings tab, you can configure 

an individual download path and naming convention for each of the stations, which will be used 

instead of the common settings. To do this, click on the instrument name in the list and press the 

Configure individual file downloading options button in the General settings panel. 

 

The Instrument/station downloading options dialogue box allows you to set individual preferences 

for a selected station after enabling the Override session’s general downloading settings option. The 

settings are identical to those available in the Common settings. 

 

Note: The preferences set in the Common settings will still apply to all instruments/stations where 

the Override session’s general downloading settings option has not been enabled. 

 

The configuration of the individual download settings is illustrated in the figure below. 

 

1 

2 

Check to start session immediately instead of programmed date 
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Figure 12-43. Configuring individual files downloading settings 

for a single instrument in the Remote session. 

 

All the other individual station settings available in the Remote sessions are identical to the features 

of the Station configuration tool described in Chapter 12.2.2. 

 
Results preview 

 

In the case of the Remote Sessions, it is possible to view the selected results of current measurements 

performed by a selected connected instrument within a specified time interval. To do this, go to the 

General settings of a selected instrument or station (by selecting its name from the list in the Remote 

Session Settings dialogue box) and press the Results preview button. The Results preview window 

appears. 

 

Select 
a station 

on the list 

Press to open 
the options window 

Check to enable 
the configuration of 
individual settings  Set the preferred 

path and naming  
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Figure 12-44. Results preview window. 

 

The results downloaded from the instrument/station are displayed in the upper part of the window. 

The Interval selector allows you to set the time period in which the results are read. The 

Channel/profile selector allows you to select the results to be displayed. The lower part of the window 

lists the exchanged commands. The Terminate button is used to cancel the current action without 

waiting for it to finish. 

 

Managing Remote Sessions 

 

Once you have configured your preferences in the Common settings as well as the measurement 

settings and the duration of the remote sessions for all devices you wish to use, you can activate the 

measurements using the Start button in the bpttom of the window. The Remote Session dialogue box 

opens. 

 

 
Figure 12-45. Remote session (Transmit-Receive) dialogue box. 
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The lower part of the window contains a list of all currently connected devices. After selecting a 

position in the list, detailed information about the remote session is displayed in the upper part of 

the window. To start, stop or terminate the remote session for one of the instruments or stations, 

right-click on it and select the appropriate command from the pull-down menu. 

 

 
 

Figure 12-46. Commands for starting, terminating and stopping a remote session. 

 

You can start, stop or terminate all sessions at once using the Sessions control buttons in the top right 

of the window. There are also other useful buttons at the right of the window: 

• Start / Stop logging all - switches the logger and WAV files logging on/off in all connected 

instruments. This functionality allows partial manual control of the measurement session. 

While the session is running, the logger results can only be downloaded when you wish. 

• Download logger(s) - stops the normal operation of the Remote Session and downloads the 

logger files created by the instrument. 

 

The Remote Session can be configured to download running logger measurements or to capture the 

current results and save a results history in a special file (both can be opened later in SvanPC++ and 

viewed as a set of results). By setting the certain options in the Options panel on the right of the 

Remote Session window, the application will automatically open these files and update them 

automatically during successive download steps. 

 

 
12.4 ONLINE DATA EXPORT 
 

12.4.1 HTML PUBLISHING 
 

Results downloaded using the automatic data acquisition tools available in the Remote 

Communication module can be saved as .html files with selected names and directories. To create 

HTML files it is necessary to activate the Publish HTML option, available in the options of certain data 

acquisition methods, as described in Chapter 12.3. 

 

Once the HTML publishing option has been activated, it is necessary to select the data to be included 

in the HTML files created. This can be done using the WWW & Live Results / FTP Selection dialogue 

box, which is opened in different ways for different collection methods: 

• In the case of Live results preview, the data for HTML publishing are selected together with the 

displayed results after pressing the Configure Results button (see  Figure 12-28Figure 12-24. 

Live Results dialogue box.). 

• In the case of Automatic files download and Continuous logger download, the data can be 

selected separately for each instrument using the  buttons. 

• In the case of Remote session, only the source for publishing files can be selected (Current 

results / RAMfile). 
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If no data is selected, files will not be published even if the publishing is enabled. 

 

The Results selection list allows you to select measurement results data to be included in the 

generated HTML files. When this window is opened, the current settings are downloaded from the 

device and the list is automatically filled with all the functions currently being measured. To select a 

function to publish, tick the box next to its name. 

 

The Export to CSV option allows the data published in HTML format to be exported to CSV format. 

The .csv files created have the same name and directory as the .html files. 

 

If you choose to upload HTML files via FTP (File Transport Protocol), you can select the types of files 

you want to download: 

• data files, 

• map files – additional HTML files created when the Create additional files containing last results 

option is enabled, 

• structural index files – files that support the functioning of the website, such as additional 

indexes, java script files for charts, etc, 

• merged results files – all files with the prefix “merged”. 

Similarly, when uploading CSV files, you can select the following types of files: 

• data files, 

• merged results files – all files with the prefix “merged”. 

 

 
Figure 12-47. WWW & Live Results / FTP Selection dialogue box. 
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Note: If you want to enable export to HTML or CSV format, you will need to tick the appropriate box 

at the top of the window. 

 

It is also possible to specify an individual folder for the each station by selecting the Upload data files 

to individual folder option (at the bottom of the window) and specifying the folder name.  

 

Note: In the Live results preview sessions, this window is also used to select the data to be displayed 

in the Live results preview window. In this case each function name acts as a toggle instead of a check 

box, allowing the data to be added to both the preview window and the published HTML files. To 

select data for HTML publishing, select Add to WWW. You can select either or both option. 

 

 
 

Figure 12-48. Selecting data for HTML publishing in case of Live Results Preview. 

 

The files can be published in the following modes (available for configuration in the options panels of 

particular data acquisition methods): 

• Current results in one file for all stations - merges the the current results files from all 

instruments into one HTML file. 

• Current results in individual file for each station - creates an HTML file for each station 

containing the current results (the name of the file created includes the unit name and serial 

number). 

• Current results and archive individually for each station - creates a new HTML file for each 

current result and an index HTML file with links to all the archived results for each station (files 

are stored in folders with names containing instrument name and serial number, created for 

each instrument). 

 

You can also choose to create additional files containing only the most recent results from the Main 

results or Logger downloaded files (these files are significantly smaller than the files containing all the 

latest results). The names of these files start with "map_". 

 

 

12.4.2 FTP UPLOAD 
 

The files downloaded from an instrument or station, as well as the HTML or CSV files created, can be 

automatically sent to an FTP server. To upload files, it is necessary to activate the FTP upload option, 

which is available in the options of certain data acquisition methods, as described in Chapter 12.3. 

 

To configure the FTP server settings you should use the Configure FTP dialogue box which can be 

opened by pressing the  button: 

• For Live results preview, the Configure FTP button is located in the bottom right corner of the 

Live Results window (see Figure 12-24. Live Results dialogue box.). 

• For Automatic files download and Continuous logger download, the Configure FTP button is 

located in the Options window, available after pressing the Options button (see Figure 12-28 

and Figure 12-36). 

• For Remote Session, the Configure FTP button is available in the Common settings window. 
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Figure 12-49. Configure FTP dialogue box. 

 

This dialogue box allows you to: 

• Specify the FTP server to be used for automatic uploading of files by setting the address and 

port, 

• Set the data required to access the server (Username, Password), 

• Select a directory for storing files on the server (Remote directory), 

• Select a separate directory for storing .svn files (Separate .svn directory), 

Note: The specified directories must exist on the server. 

• Enable Passive transfer mode, 

• Enable automatic deletion of .html files before uploading. 

Note: This option is useful for FTP servers that do not allow files to be overwritten. It is 

automatically activated/deactivated when you activate the Test FTP tool. 

 

The Test FTP button is used to perform an FTP server test using the configured settings. A warning 

appears if the connection is not possible or if directories with the specified names cannot be found 

on the server. It also checks the need for automatic deletion of .html files. 

 

Once the FTP Upload option has been enabled, you must select the files to be uploaded. This can be 

done in the WWW & Live Results / FTP Selection dialogue box (see Chapter 12.4.1). 

 

The types of files you can upload are: 

• HTML files, 

• Result files, 

• Logger files, 

• Binary files, 

• CSV files. 

You can select more than one file type by ticking the appropriate boxes at the bottom of the WWW 

& Live Results / FTP Selection dialogue box. 

Note: The FTP configuration is only available if the FTP upload option is enabled. 
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12.4.3 VIEWING ONLINE DATA 
 

When HTML files are created in the Remote Communication Session, data acquired from Svantek 

instruments can be viewed using a standard Internet browser. When the HTML index page is opened, 

you will see a list of instruments from which data is currently published online. Select one of them to 

view its measurement results. 

 

 
 

Figure 12-50. The index page generated by the Publish HTML functionality. 

 

Once the instrument has been selected, its latest measurement results are displayed. You can select 

the type of data displayed and enable/disable its automatic updating as shown in the figure below. 

 

 
 

Figure 12-51. Viewing last measurement results online. 

Click on the 
instrument’s 
name to access 
measurement 
results 

Select type 
of results 
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updating 
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Last 
published 

results 

View time history of measurement results 
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For some types of results, such as time histories or frequency domain results, it is possible to visualise 

the data in the form of a graph or table. The graphical user interface associated with these 

functionalities is described below. 

 

 
 

Figure 12-52. An example of online chart created with the use of the Publish HTML option. 

 

(1) You can select the Window with the plotted measurement results. 

(2) You can manually select the number of the last result displayed using the number field or the 

slider located next to it. 

(3) You can select the way the results are displayed – as a Chart or as a Table.  

(4) The list of available results can be used to select which result is displayed in the chart. 

 

1 

3 

2 

4 
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Figure 12-53. An example of online table created with the use of the Publish HTML option. 

 

It is also possible to visualise a number of recently downloaded results, as well as data downloaded 

using the Live Results Preview session (→ Section 12.3.1), in the form of a single chart or table. Todo 

this, press the Merged Results button in the top right of the window. Use the Enable refresh button 

to automatically update the data as new measurement results are published. If the refresh option is 

disabled, the chart/table will be frozen with the current data. 

 

 
 

Figure 12-54. Visualizing the time history of the last downloaded data, or the Live 

Results, in the form of a chart / table. 

 

 

 

12.5 SVAN RC SERVICE 
 

The data acquisition methods available in the Remote Communication module are realised by the 

SvanRC Service, a separate application that can run either as a background application or as a 

Windows Service. It runs in the background, which means that as soon as a remote communication 

session (as described in Chapter 12.3) is applied, SvanPC++ can be closed and the session itself 

continues with all defined parameters. At any time, by accessing the session window via SvanPC++, 

the state of the session can be browsed and changed (stopped, terminated, etc.). 

 

To decide whether it should run as a Windows Service or as a background application, go to  Main 

Options » Data Exchange » Remote Communication ( ) and set the Run RC Service as Windows 

Service option. 

select which functions should be displayed 
in the table 
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Figure 12-55. Setting the mode in which SvanRC Service is run (Windows Service / background application). 

 

RC Service can also be used to run many sessions of different types running at the same time. For 

example, it can run Automatic Files Download and Live Results Preview at the same time. In suthisch 

case, the following priority list applies: 

1. Automatic Files Download / Continuous Logger Download (same priority) 

2. Remote Session 

3. Live Results Preview 

4. Other commands sent to the instrument. 

The list above describes the priority order for an individual instrument, where the lowest number has 

the highest priority. Actions with a lower priority must wait until all actions with a higher priority have 

finished before they are resolved. For example, if the Automatic Files Download session starts 

downloading files from an instrument, Live Results Preview will not be able to access that instrument 

until AFD has completed the download cycle. 

The service is activated by SvanPC++ when needed and runa until disabled (manually or by 

uninstalling SvanPC++). When running as a Windows service, it runs under a low-privileged local user 

account that is automatically logged in at Windows startup - it's possible for the service to run even 

if no standard user is logged in. It is automatically shut down when the SvanPC++ application is closed 

if it doesn't have any sessions configured to run. 

As long as the service is activated and a remote communication session is running, all SvanPC++ 

communication through the connection type defined for the service (e.g. USB, Internet) is routed 

through the service application. In this situation it is subject to the priority list mentioned above, so 

that commands can only be sent if no session is currently exchanging data with the device the user 

wants to communicate with. 

Note: If the Service is currently running a Remote Communication session using a USB or RS232 

connection, the automatic device detection in the main window is disabled. 
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12.6 OTHER FEATURES OF THE RC MODULE 
 

12.6.1 ALERTING 
 

The RC module allows you to activate alarms to inform the user about events such as high or low 

noise level, loss of connection, low disk space, etc. To configure the alarms, go to the Remote 

Communication Center and press the Alarms button (see Figure 12-3). The Alarm config dialogue box 

appears. 

 

There are 3 types of alarm-triggering events: 

• System events – warnings sent by a station relating to events such as high/low temperature, 

loss of AC/DC external power, etc.  

• Measurement threshold alarms – activated when a measurement exceeds a specified 

threshold. 

• Measurement performance alarms – related to hardware problems. 

• Data transfer alarms – related to connection problems. 

 

The time for checking the system and measurement alarm conditions is the data download time 

period in the current remote data acquisition session. If the data download time step is longer than 

the set maximum query delay time, the service will check the alarm conditions more frequently at 

the intervals specified in the Query period field. 

 

 
Figure 12-56. Alarm config dialogue box. 

 

To set a Measurement alarm, use the Alarm configuration tab in the Stations configuration dialogue 

box (see Chapter 12.2.2). 
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Figure 12-57. Configuring measurement alarm settings in the Station configuration dialogue box. 

 

To enable the configuration of the measurement alarm, the Skip alarm configuration option must be 

disabled. The following settings are available: 

• Active level (Low / High) – determines whether the alarm will be activated when the function 

being evaluated goes below or above the selected threshold. 

• Source – determines which function is included in the alarm condition check. 

• Source type – determines whether current or periodic values of the selected function are 

compared with the set alarm level. 

• Alarm Level – the value of the measured function below/above which the alarm will be 

activated. 

 

The Data transfer alarm is activated when the communication absence time exceeds the limit 

specified in the No response time field.  

Note: In the case of Continuous logger download sessions (see Chapter 12.3.3), a Data transfer alarm 

is also activated if no logger data is receiving from the unit for a period longer than the No response 

time. 

 

Activation of an alarm can be followed by the automatic sending of an e-mail notification from a set 

account to a set address. The e-mail sending configuration is only enabled if you tick at least one of 

the E-mail notification for options.  

 

If you select the Use SvanMail option, all mails will be sent via the SvanNET mail service and you don’t 
need to configure any e-mail settings. 

 

After you have configured the e-mail sending options, you can check the performance of the 

automatic e-mail sending by pressing the Test e-mail settings button. A test e-mail will then be sent 

with the configured settings. 
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Multiple alarms from a single query can be sent as a single e-mail or as multiple separate e-mails; you 

can select the preferred option using the Send multiple alarms from the same instrument as single e-

mail checkbox (at the bottom of the window). Messages can also be shortened for easier forwarding 

as SMS; to enable this feature, tick the Create short event(s) details checkbox. 

 

You can also enable the automatic sending of daily/weekly/monthly summaries of the RC service 

activity. These reports contain information such as: 

• a list of active RC services together with the Svantek devices used, 

• a list of disks where the data is stored and the amount of space available on these disks. 

The summaries are sent by e-mail at 0:00 with the configured settings. To enable the sending of 

summary reports, enable the RC service summary report option and select the sending period. 

 

The measurement performance errors for which alarms can be configured are related to possible 

hardware problems. If this option is enabled, the remote AFD and CLD sessions download the Meteo 

results and the LEQ values measured in all the profiles at each Query period to analyse whether their 

value averaged over the last hour is reasonable (i.e. whether it is within an acceptable range). If an 

unacceptable value is obtained, an alarm is activated. This type of alarm is particularly useful in the 

event of, for example, microphone damage or loss of connection between individual components of 

a meteorological station, when erroneous data is sent from the station . 

 

It is also possible to configure an automatic e-mail notification when the available disk space falls 

below a specified level. To do this, select the Low free disk space check box and enter the desired 

level in MB. The e-mail notification can also be automatically repeated at specified intervals once the 

alarm has been activated. To enable this feature, select the Remind every option and set a time period 

for the notifications to be repeated. 

 

After configuring the alarming options, the changes will not take effect until a RC session is started. 

However, if the RC Service is already running and you want to apply the alerting options immediately, 

you can do so by confirming in the dialogue box that appears when you close the Alarm config 

dialogue box. 

 

 
Figure 12-58. Dialogue box allowing for applying alerting changes to a running RC Service. 
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12.6.2 SVANPC++ TRAY ICON 
 

By default, the SvanPC++ tray icon is created each time the SvanRC Service session is started. It can 

be used to work with SvanRC Service sessions when SvanPC++ is not running. 

 

 
 

Figure 12-59. SvanPC++ tray icon and its menu. 

 

The automatic creation of this tray icon can be enabled/disabled in the Main Options / Remote 

communication settings. To access the Main Options, you can use the Main options command from 

the Tools menu or the  button on the Main Toolbar. 

 

  
Figure 12-60. Configuring the SvanPC++ tray icon settings in the Main Options dialogue box. 

 

A double-clicking on the SvanPC++ tray icon opens the SvanPC++ application (if it is not already 

running). 

 

Right-clicking on the SvanPC++ tray icon opens a menu with the following commands: 

• SvanRC Service state – shows if a SvanRC Service is running or not. 

1 

2 
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• Edit session settings with SvanPC++ – starts SvanPC++ and automatically opens the Remote 

Communication Center dialogue box. 

• Stop / Start Svan RC service - stops / starts the SvanRC Service. 

• Terminate Svan RC service - stops the SvanRC Service immediately (without waiting for the 

current action to finish). 

Note: When SvanPC++ is running, these options are not available. 

• Exit - hides the SvanPC++ tray icon. 

 

If you stop a session using the SvanPC++ tray icon, you can start it later it in the same way. 

As long as SvanRC Service is running, the SvanPC++ tray icon will be added to the automatically started 

programs of each user of the computer. If this is not possible for administrative reasons, the icon will 

only be added to the autostart programs of the current user. 

 

 

12.6.3 RC TROUBLESHOOTING TOOL 
 

The Remote Communication Troubleshooting tool available in the RC module is used to report 

problems with data exchange with Svantek instruments. The idea of using the Troubleshooting tool 

is to easily create and send e-mails to Svantek that contain automatically collected information that 

will help in solving the problem. 

 

To use the Troubleshooting tool, open the Remote communication center, press the Toggle mode 

button to enable additional options and press the Troubleshooting button at the bottom of the 

window. The Remote Communication Troubleshooting Tool dialogue box appears. 

 

 
Figure 12-61. Remote Communication Troubleshooting Tool dialogue box. 

 

E-mails containing reports are sent using your default e-mail configurations.  

The recipient address and the subject are filled automatically. However, you can add additional 

recipients in the CC(s) field. 



                                                                                     SvanPC++ User Manual   

 

321 

 

Attached to the report is automatically generated information about the SvanRC Service activity as 

well as zipped files, such as: 

• current SvanPC++ settings, 

• Remote Communication Center log, 

• remote communication sessions log. 

You can also write a description of the problem in the User information field or attach any additional 

files you consider necessary using the Add File button. Any details you can add to the report may be 

helpful to Svantek in solving the problem. 

 

To send the report, use the Send button. 

 

 

12.6.4 DYNAMIC DATA APPENDING 
 

Some additional functions of the Remote Communication module are also available via the File » 

Dynamic Appending (RC) menu. This option is available when a file containing logger data is opened. 

 

  
 

Figure 12-62. Dynamic Appending (RC) options in the File menu. 

 

The  marks indicate options that are currently enabled. To enable/disable an option, simply click 

on its name. 

If the Auto Refresh function is enabled, SvanPC++ will automatically check every 1 second if new data 

is available in the currently opened files (e.g. if an RC session is currently active, new logger results 

can be automatically downloaded). If new results are available, the currently open views will be 

updated automatically. 

If the Synchronize function is enabled and if the Auto refresh function is enabled, then each time the 

views are updated with newly downloaded results, the visible cursor will automatically be placed on 

the position of the most recently downloaded sample (in both the Table and Plot views). 
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12.6.5 RC SETTINGS IN MAIN OPTIONS 
 

You can configure some settings related to the Remote Communication module using the Main 

Options. To do this, press the  button or select the Main Options... command from the Tools 

menu and select Remote communication from the list of available categories of settings (on the left 

of the Main Options window). 

 
Figure 12-63. Remote Communication Settings in Main Options. 

 

The following settings are available: 

1. Controller Settings - use these buttons to select whether you want to have full manual access to 

all the settings in the Controller Settings dialogue box, or whether you want to be able to configure 

these settings using a Wizard. 

2. Remote Session: 

o Enable live results view at start - if this option is enabled, the Remote Session will by default 

display downloaded results (logger or summary) on startup and synchronise them during 

download (this feature can be disabled on a per Remote Session basis). 

3. Automatic updates - if this option is enabled, SvanPC++ will automatically search for firmware 

updates on the Internet each time it is started. The program will only search for updates for the 

instruments that are currently used with SvanRC Service. You can use the Check for updates now 

button to manually search for updates for connected instruments. 

4. RC Service settings: 

o Place Svan PC++ icon in tray at RC service start - if this option is enabled, a Svan PC++ tray icon 

will be created each time SvanRC Service is started. 

o Automatically append new catalogue data instead of redownloading it - if this option is enabled, 

SvanRC Service will download only the files that are missing on your PC, instead of downloading 

the whole catalogue every time. This feature is particularly useful when downloading large 
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catalogues or when there are problems with the transfer, which can cause frequent restarts of 

the download. 

o Data exchange between Svan RC Service and SvanPC++ requires confirmations - this checkbox 

allows you to choose between two different modes of transfer between SvanRC Service and 

SvanPC++: 

− When enabled, a confirmation is expected for each command sent, and if the confirmation 

is not received, the command is sent again. This makes transfer more reliable, but slower. 

− When disabled, the confirmations are neither sent nor expected, so the transfer is faster but 

less reliable. 

Note: Transmission with confirmations is used by default and it is advisable to enable this in 

most cases. The other mode of transfer may be useful when using multiple stations and 

downloading a lot of data frequently - if results are not updated at a sufficient rate, try disabling 

confirmations. 

o Service address and port - allows you to manually set the IP address and port where the SvanRC 

Service can be accessed. 

o Clear SvanNET username and password - press this button if you want to connect to SvanNET 

with a different account than the one currently remembered by SvanPC++. If you do this, you 

will be asked for the login information the next time you connect to SvanNET via SvanPC++.  

 

Note: It is recommended that you restart the SvanRC Service after changing the settings in the RC 

Service settings category so that they can take effect (except for the tray icon settings). 

 

You can also define some settings related to the Remote Communication module in the 

Data Exchange Settings section. These include:  

 

5. Files downloading - allows you to automatically adjust the timestamp of downloaded files to 

account for daylight saving time differences in local time.  

 
Figure 12-64. Data Exchange Settings in Main Options. 
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